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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG
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Postfach 48 48
90026 NÜRNBERG
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Security information 1
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, solutions, machines, equipment and/or networks. They are 
important components in a holistic industrial security concept. With this in mind, Siemens’ 
products and solutions undergo continuous development. Siemens recommends strongly that 
you regularly check for product updates.

For the secure operation of Siemens products and solutions, it is necessary to take suitable 
preventive action (e.g. cell protection concept) and integrate each component into a holistic, 
state-of-the-art industrial security concept. Third-party products that may be in use should also 
be considered. For more information about industrial security, visit http://www.siemens.com/
industrialsecurity

To stay informed about product updates as they occur, sign up for a product-specific 
newsletter. For more information, visit http://support.automation.siemens.com.
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Preface 2
Purpose of this documentation           

This documentation informs you about the software components, areas of application, 
configuration options and commissioning of Maintenance Station for SIMATIC PCS 7.

It answers the following key questions:

● What is the Maintenance Station?

● What software components belong to the Maintenance Station?

● What hardware and software requirements apply and which licenses are required for 
installation?

● What are the intended areas of application for the Maintenance Station?

● How is diagnostics performed with the Maintenance Station?

Maintenance Station
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Options for accessing PCS 7 documentation
The documentation required for PCS 7 includes the following types:

● PCS 7 Readme
The readme file is available in two versions:

– PCS 7 Readme (offline)
This version is installed by PCS 7 Setup. The file only contains general information and 
links to documents on the Internet.

– PCS 7 Readme (online)
This is the version which contains all information on the installation and use of PCS 7 
in the format you are already familiar with. The file is only available on the Internet so 
that we can keep it up to date. 

Note

The information provided in the PCS 7 Readme (online) on the Internet takes 
precedence over all other PCS 7 documentation. 

Please read this PCS 7 Readme carefully; it contains important information and 
amendments on PCS 7.

● PCS 7 System Documentation
System documentation includes documents that cover several products, such as 
configuration manuals and Getting Started manuals. This documentation serves as a 
guideline for the overall system and explains the interaction between the individual 
hardware and software components.
Read the information on "PCS 7 Documentation Portal Setup" in the product overview 
Process Control System PCS 7; PCS 7 Documentation; section "Options for accessing the 
documentation".

● PCS 7 Product Documentation
Product documentation contains information about specific hardware and software 
components. The individual documents provide detailed information on the specific 
component.

Full versions of the documentation are available from the "Technical Documentation SIMATIC 
PCS 7" website:
www.siemens.de/pcs7-dokumentation (http://www.siemens.com/pcs7-documentation)

You can find additional information in the product overview Process Control System PCS 7; 
PCS 7 Documentation; section "Options for accessing the documentation".

Required basic knowledge
This documentation is aimed at anyone who is involved in configuring, commissioning and 
operating automated systems based on SIMATIC PCS 7.

A certain amount of basic knowledge is assumed and readers are expected to know how to 
use a PC/PG and the Windows operating system in general. You should be familiar with the 
SIMATIC PCS 7 functions and configurations.

Preface
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This manual assumes that users are familiar with the following knowledge from the specified 
manuals:

● Process Control System PCS 7; Engineering System
● Process Control System PCS 7; Operator Station
● Process Control System PCS 7; OS Process Control

Conventions
In this documentation, the names of elements in the software interface are specified in the 
language of this documentation. If you have installed a multi-language package for the 
operating system, some of the designations will be displayed in the base language of the 
operating system after a language switch and will, therefore, differ from the designations used 
in the documentation.

Preface
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Using the Maintenance Station 3
3.1 Application, version and configuration

Application   
Maintenance station focuses on "Plant Asset Management" and enables preventive and 
predictive diagnostics and maintenance of the plant. 

In parallel with process control, the maintenance station makes available consistent 
maintenance information and functions for the system components (assets).

While the plant operator receives all process-relevant information and can intervene selectively 
in the process via the operator system (OS), the maintenance engineer inspects the 
automation system hardware and processes the associated diagnostic messages and 
maintenance demands via the maintenance station.

The basis for a maintenance station is always an OS that provides this maintenance 
functionality. 

The OS that has maintenance functionality and the mode in which the maintenance station 
that is operated is determined in the plant hierarchy of the SIMATIC Manager.

You can find basic information on engineering, configuration and process control in the 
following documentation:

● Process Control System PCS 7; Engineering System
● Process Control System PCS 7; Operator Station
● Online help for WinCC

Versions         
The maintenance station can be used in the following versions:

● Maintenance Station Basic (integrated in the PCS 7 project)

– Is referred to as MS Basic in the document    

● Maintenance Station Standard (integrated in the PCS 7 project)

– Is referred to as MS Standard in the document    

● SIMATIC PDM Maintenance Station (stand-alone project)

– Referred to as SIMATIC PDM MS in the document    

Note

If you are running a maintenance station in the plant, the sign-of-life monitoring with "Lifebeat 
Monitoring" must be disabled.

Maintenance Station
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Differences between the versions
The following table shows differences.

 MS Basic MS Standard SIMATIC PDM MS
Information dis‐
played

● Overview screen
● Area overview screen

– AS/system
– Network objects
– PC stations

● Status information of the 
individual components

● Overview screen
● Area overview screen

– AS/system
– Field devices
– Network objects
– PC stations
– User objects

● Status information of the 
individual components

● Detailed information on 
individual components

● Hierarchical picture structure
● Global functions
● Component-specific functions

● Overview screen
● Area overview screen

– Field devices
– Network objects (optional)
– PC stations (optional)

● Status information of the 
individual components

● Detailed information on 
individual components

● Hierarchical picture structure
● Global functions
● Component-specific functions

Generation of 
the diagnostics
structure

Automatic generation from the SIMATIC PCS 7 hardware project Automatic generation
from the SIMATIC PDM stand-
alone project (network view)

Setup of the di‐
agnostics
structure

● Area overview screen
– AS/system
– Network objects
– PC stations

● Symbolic representation of 
the components with 
diagnostic status

● No hierarchical picture 
structure

● No calling of faceplates

● Area overview screen
– User objects
– AS/system
– Field devices
– Network objects
– PC stations

● Symbolic representation of the 
components with diagnostic 
status

● Hierarchical screen structure for 
AS/system components

● Hierarchical screen structure for 
field components

● Hierarchical picture structure for 
user components

● Calling of faceplates

● Area overview screen
– Field devices
– Network objects (optional)
– PC stations (optional)

● Symbolic representation of the 
components with diagnostic 
status

● Hierarchical picture structure 
for field bus components with 
connected field components

● Calling of faceplates

Message
 assignment

Area by area Component by component

Diagnostics
 update

● Cyclically by the system
● Event-driven

● Cyclically by the system
● Event-driven
● Manual
● Cyclic polling

● Manual
● Cyclic polling

Using the Maintenance Station
3.1 Application, version and configuration
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 MS Basic MS Standard SIMATIC PDM MS
Detailed 
information (1)

Not available ● Electronic rating plate 
(identification data)

● Component-related messages
● Detailed information in 

accordance with SNMP profile
● Component status in 

accordance with EDD 
information (3)

● Detailed information in 
accordance with EDD 
information

● User notes
● Redundancy status
● CPU utilization/

cycle utilization
● Calling device-specific 

condition monitoring functions 
(e.g. Diagnostics Monitor)

● Electronic rating plate 
(identification data)

● Component-related messages
● Detailed information in 

accordance with SNMP profile 
(optional)

● Component status in 
accordance with EDD 
information

● Detailed information in 
accordance with EDD 
information

● User notes
● Calling device-specific 

condition monitoring functions 
e.g. Diagnostics Monitor 
(optional)

Components 
with diagnostics 
capability

You can find additional information about this in the section "Components with diagnostics capability 
(Page 16)".

Global functions Not available ● Complete export of electronic rating plate including maintenance 
status of all components

● Filter functions in relation to the component state
● Filter functions in relation to contents of the electronic rating plate
● Exporting data of individual components
● Manual change of the maintenance status of a component
● Use of standard functions of the PCS 7 Operator Station, e.g. report 

generation in process control
Component
-specific func‐
tions (2)

Not available Calling HW Config online Not available
Call
● Component-specific Web portals
● Web portals configured in Engineering
● SIMATIC PDM for EDD-based components
● Diagnostics Monitor for IPC objects

Licenses Not required Quantity and function-dependent

(1) Dependent on component used

(2) Dependent on component type used and use of an MS Client in the multiple-station system.

(3) Electronic Device Description

In the rest of the documentation, any differences are pointed out. 
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Configuration   
The MS Basic and MS Standard versions of the maintenance station can be configured as MS 
single-station system or as MS multiple-station system.

You can find more information on this in the sections "MS single station system (Page 21)" 
and "MS multiple station system (Page 22)".

SIMATIC PDM MS can only be configured as an MS single-station system.

You can find additional information about this in the section "SIMATIC PDM MS (Page 25)".

Operating and monitoring on a PCS 7 Web client     
You can use a PCS 7 Web client to operate and monitor an MS single-station system and MS 
multiple-station system. Any existing limitations are described in the respective sections of the 
manual.

Note

This function is not available for SIMATIC PDM MS.

3.2 Components with diagnostics capability

Which components can be monitored? 
The components with diagnostics capability are displayed in the process control in the areas 
subordinate to the diagnostics area.   

The table shows an example of which components can be monitored and in which areas the 
components are displayed.

Diagnostics for ... Area MS Ba‐
sic

MS Standard SIMATIC
PDM MS

● Siemens industrial PC, for example
– Operator stations
– BATCH stations
– Route Control stations
– Process Historian
– SIMATIC PCS 7 BOX

● Premium Server for SIMATIC PCS 7/PCs 
from third party

PC stations X - 

● Switches, e.g. SCALANCE
● OSM
● ESM
● Other components that support SNMP 

services
– e.g. printers, bridges, routers

Network ob‐
jects

Using the Maintenance Station
3.2 Components with diagnostics capability
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Diagnostics for ... Area MS Ba‐
sic

MS Standard SIMATIC
PDM MS

● CPU
● CP
● SIMATIC PCS 7 BOX
● Interface module (IM) of the ET 200 

families
(ET 200M, ET 200S, ET 200SP, 
ET 200iSP, 
ET 200pro)

● Link modules 
(DP/PA-Link, Y-Link, FF Link, 
Compact FF Link)

AS/system X -

● Interface module (IM) of the ET 200 
families

● Input and output modules of the ET 200 
families

● Failsafe modules
● Link modules
● PROFIBUS devices
● PROFINET devices
● Field devices (HART, PROFIBUS PA, ...)
● Non-transparent couplers with 

diagnostics capability
● Diagnostic repeaters

Field devices -
 

X -

● EDD objects can be detected by SIMATIC 
PDM

● Field devices (HART, PROFIBUS PA, ...)
● Interface modules (IM) of the ET 200 

families
● Input and output modules of the ET 200 

families
● Link modules
● Non-transparent couplers with 

diagnostics capability
● Station objects (gateways)

Field devices - X

● User objects for which a diagnostics can 
be generated by an application

User objects - X - 

Using the Maintenance Station
3.2 Components with diagnostics capability
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What is monitored in the PC stations area?

Monitored components Constraints and displayed information
Siemens Industrial PC (IPC) 
with Diagnostics Monitor diag‐
nostics program configured for 
the IPC (ES, server, client, oth‐
er computers) and available 
via SNMP

● Monitoring for failure
● Fan speed with limit values
● Hard disk utilization with CCPerfmon limit values
● Redundant power supply
● Temperature, CPU, Board, etc.
● Failure of a hard disk using RAID1
● Failure of a connection
● OS deactivated
● Terminal adapter failure
● Watchdog
● Revision alarm

Third-party PC via SNMP
Premium Server for SIMAT‐
IC PCS 7 via SNMP

● Identification data according to the SNMP profile MIB-II
● Monitoring for failure

Third-party PC without SNMP ● Identification data via WMI monitoring for failure

What is monitored in the network objects area?

Monitored components Constraints and displayed information
SCALANCE X200, X300, X400, 
X500, W700;
OSM/ESM

● Group fault for monitoring the power supply error (red. infeed)
● Port error
● Ring redundancy error
The monitoring functions must be enabled in the components.

Third-party switch ● Monitoring for failure, with support of the SNMP profile MIB-II
Printer ● Monitoring for failure, with support of the SNMP profile MIB-II

Using the Maintenance Station
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What is monitored in the AS/system area?

Monitored components Constraints and displayed information 
SIMATIC S7-4xx series CPU ● Diagnostics information on CPU utilization

● Utilization OB3x, OB8x and OB1
● Reduction ratio of the OB3x in cases of overload
● Display of the electronic rating plate based on the PNO 

specification
If data cannot be read from the components, the data (if existing) 
from the project is displayed.

● Detailed error messages
● Detailed maintenance status
The information is dependent on the firmware version of the CPU.

SIMATIC PCS 7 CPUs, 
Interface modules (IM) of the ET 
200 families and link modules

● Display of the electronic rating plate based on the PNO 
specification
If data cannot be read from the components, the data (if existing) 
from the project is displayed.

● Detailed error messages
● Detailed maintenance status

What is monitored in the field objects area?

Monitored components Constraints and displayed information 
SIMATIC PCS 7 standard I/O ● Display of the electronic rating plate based on the PNO 

specification
If data cannot be read from the components, the data (if existing) 
from the project is displayed.

● Detailed error messages
● Detailed maintenance status

PROFIBUS DP/PA field devices 
(integrated via EDD)

● Detailed device-specific/EDD-based diagnostics
● Display of the electronic rating plate based on the PNO 

specification
If data cannot be read from the components, the data (if existing) 
from the project is displayed.

● Detailed error messages
● Detailed maintenance status

FF field devices (integrated via 
EDD)

● Process access via APL channel blocks
● Detailed device-specific/EDD-based diagnostics
● Display of the electronic rating plate (I&M data)
● Detailed error messages
● Detailed maintenance status

Using the Maintenance Station
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Monitored components Constraints and displayed information 
PROFIBUS DP/PA standard 
slaves (field devices integrated 
via GSD)

● Failure monitoring
● Display of the electronic rating plate based on the PNO 

specification
If data cannot be read from the components, the data (if existing) 
from the project is displayed.

● Maintenance status "Good" and "Maintenance alarm"
PROFINET standard slaves 
(field devices integrated using 
GSDML)

● Failure monitoring
● Display of the electronic rating plate based on the PNO 

specification
If data cannot be read from the components, the data (if existing) 
from the project is displayed.

● Maintenance status "Good" and "Maintenance alarm"
HART field devices (integrated 
via EDD into SIMATIC PCS 7 
standard I/Os)

● Detailed device-specific/EDD-based diagnostics
● Display of electronic rating plate (based on specification of 

HART Communication Fundation - HCF)
● Detailed error messages
● Detailed maintenance status

SIMATIC TIA objects ● Failure monitoring
● Display of the electronic rating plate based on the PNO 

specification
If data cannot be read from the components, the data (if existing) 
from the project is displayed.

● Maintenance status "Good" and "Maintenance alarm"
SIMATIC PCS 7 add-on objects 
(field devices integrated via 
EDD)

● Detailed device-specific/EDD-based diagnostics
● Display of the electronic rating plate based on the PNO 

specification
If data cannot be read from the components, the data (if existing) 
from the project is displayed.

● Detailed error messages
● Detailed maintenance status

What is monitored in the field devices area for SIMATIC PDM MS?

Monitored components Constraints and displayed information
Field devices ● PROFIBUS DP/PA field devices (integrated via EDD)

● PROFIBUS DP/PA Remote I/Os (integrated via EDD)
● Ethernet field devices (integrated via EDD)
● HART field devices (integrated via EDD)
● Wireless HART field devices (integrated via EDD)
● Modbus field devices (integrated via EDD)
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What is monitored in the user objects area for MS Standard?

Monitored components Constraints and displayed information
User objects ● Not communicative accessible components

● Indirect diagnosed objects
● Results of state monitoring functions
● Components from the process device network view that are not 

configured in HW Config, e.g., wireless HART field devices

Where is the information displayed?
You can find information on the states of individual PCS 7 components with diagnostic 
capability on the maintenance station diagnostics screens.

The diagnostics screens only display data made available by the component or the project.

You can find information on the diagnostics screens in the section "Operator control and 
monitoring (Page 89)".

3.3 MS single station system

MS single-station system in the OS single-station system
The maintenance station is operated on the engineering station.

Plant configuration       
The MS single-station system has the following functionalities:

● Operator station (OS)

● Engineering station (ES)

● Maintenance Station (MS)

● SIMATIC PDM

The complete operator control and monitoring functionality for a PCS 7 project (plant/unit) is 
located in one station. The OS areas and the "Diagnostics" area of the MS are displayed in 
the overview area of the process control. 

The "Diagnostics" area visualizes the diagnostics state via diagnostics screens, providing the 
required operator control and monitoring functions.

The MS single-station system on the plant bus can be used in parallel with additional single-
station or multiple-station systems. 

Using the Maintenance Station
3.3 MS single station system

Maintenance Station
Function Manual, 03/2016, A5E36187641-AA 21



Plant configuration
The figure below shows an example plant configuration.

Rule
The maintenance station is disabled during configuration.

Software and licensing
If monitoring of intelligent field devices is required, install the SIMATIC Process Device 
Manager (SIMATIC PDM Server) add-on package on the engineering station.

You can find more information on software in the manual Process Control System PCS 7; PCS 
7 PC Configuration.

For information on the current graduated licenses available for the various components of the 
process control system and the correspondingly plant sizes that can be realized, refer to the 
installation manual Process Control System PCS 7; Licenses and Quantity Structures.

3.4 MS multiple station system

MS multiple-station system in the OS multiple-station system
In distributed systems, the maintenance station is integrated into a client/server architecture.

Using the Maintenance Station
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Plant configuration         
The MS server 

● Either configured on a separate PC station or on a PC station together with the OS server

● Can be configured redundantly

● Processes the process control messages which are visualized on the OS/MS client and/or 
MS client

● Can monitor network components via the OPC server at the plant bus if there is a connection 
to the plant bus

The MS client can be configured as follows:

● MS client on a PC station
The MS client visualizes the diagnostic status in the diagnostic area using diagnostic 
screens and provides the required operator control and monitoring functions.

● MS client and OS client on a PC station (OS/MS client)
The OS/MS client has the same functionality as an MS client on a PC station and the same 
functionality as an OS client.
In addition to the diagnostic area, the overview visualizes the technological areas for 
process control.

● MS client on the engineering station
The MS client on the engineering station has the same functionality as an MS client on a 
PC station.
In addition, the online view of the hardware configuration editor can be opened.
The MS client that is operated on the engineering station is disabled during configuration.
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Plant configuration
The figure below shows an example plant configuration.

Required server data   
● On the MS or OS/MS client

You can find information on this in the section "Server data and downloading of a client 
(Page 83)".

● On the MS server
The server data of all OS servers in the multiproject/project are automatically downloaded 
to the MS server when the diagnostics structure is generated.

Software and licensing
If intelligent field devices have to be monitored, install the SIMATIC Process Device Manager 
(SIMATIC PDM) on the engineering station.

You can find more information on the software in the manual Process Control System PCS 7; 
PCS 7 PC Configuration.

For information on the current graduated licenses available for the various components of the 
process control system and the correspondingly plant sizes that can be realized, refer to the 
installation manual Process Control System PCS 7; Licenses and Quantity Structures.
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3.5 SIMATIC PDM MS

Plant configuration
SIMATIC PDM MS is a single-station system pre-configured as an IPC Microbox 427D. It is 
designed for stand-alone use and is independent of the automation solution used. It is based 
on a PCS 7 Maintenance Station. All operating and monitoring functions are executed on this 
PC station.       

SIMATIC PDM MS processes diagnostic information that is determined via SIMATIC PDM. 

SIMATIC PDM MS uses diagnostic screens to visualize the diagnostic status in the diagnostic 
area and provide the required operator control and monitoring functions.

The automation system is mapped in the software with one integrated AS RTX (WinLC RTX). 

The diagnostic messages are produced in the integrated AS RTX and visualized on SIMATIC 
PDM MS.
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Plant configuration
The figure below shows an example plant configuration.

SIMATIC 

S7-15xx

SIMATIC 

S7-3xx

SIMATIC 

S7-4xx

SIMATIC 

S7-4xxH

PROFIBUS DP

PROFIBUS PAPROFIBUS PA

PROFIBUS DP PROFIBUS DP

Rule
SIMATIC PDM MS is disabled during configuration.
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Software and licensing
● Enclosed Restore software

● Current devices DVD of SIMATIC PDM

You have the option of expanding the quantity structure and functions of SIMATIC PDM MS.

The following licenses can be used for expansion:

● The various levels of PDM TAG

● Asset Tag for the PCS 7 Maintenance Station

Information on the individual products is available in the documents accompanying the product 
release on the Internet under Technical Support http://www.siemens.com/automation/service 
(http://www.siemens.com/automation/service).

For information on the current graduated licenses available for the various components of the 
process control system and the correspondingly plant sizes that can be realized, refer to the 
installation manual Process Control System PCS 7; Licenses and Quantity Structures.
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Additional documentation 4
Additional documentation   

The following table lists documentation in which you can find additional information. All content 
of the electronic manuals (PDF) can also be found in the online help (CHM).

Documentation Purpose
Online help:
Help on PCS 7,
Configuration - Engineering System
Manual:
Process Control System PCS 7
Engineering System

The documentation supports you during configuration 
with the SIMATIC Process Control System PCS 7 on 
an engineering station.

Online help:
Help on PCS 7, Configuration - Operator Sta‐
tion
Manual:
Process Control System PCS 7
Operator Station

The documentation supports you during configuration 
with the SIMATIC PCS 7 Process Control System on 
an operator station.

Manual:
SIMATIC Logon,
SIMATIC Electronic Signature

This documentation supports you when setting up cen‐
tral access authorization administration with SIMATIC 
Logon.

Online help and manual:
Process Control System PCS 7
PCS 7 Basic Library 

This documentation describes the functions and block 
I/Os of diagnostic blocks.

Online help and manual:
Process Control System PCS 7
PCS 7 Advanced Process Library

This documentation describes the functions, block I/Os, 
and input/output fields of the associated faceplates.

Online help:
WinCC Information System

The documentation supports you in configuring the op‐
erator stations and in operating the operator stations in 
the process control.

Manual:
Process Control System PCS 7
SIMATIC PDM

This documentation offers support during installation, 
commissioning of the software, configuration of net‐
works and field devices, commissioning and using run‐
time functions.

Manual:
SIMATIC NET
S7 CPs for Industrial Ethernet (part BL1)

This documentation describes the configuration, instal‐
lation and commissioning of an IE/PB Link PN IO.

Manual
Process Control System PCS 7
Licenses and Quantity Structures

The document offers information on the latest grading 
of licenses for the different components of the process 
control system and the plant size you can achieve with 
them. 
Section "Calculating the asset tags (hardware compo‐
nents) for the maintenance station" of the document of‐
fers information on which diagnostics-capable compo‐
nents within a PCS 7 project are counted as asset tags.
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Documentation Purpose
Manual
Process Control System PCS 7 
PC Configuration

The document provides information about hardware 
and software requirements and about the configuration 
options of a PC station.

Manual
Process Control System PCS 7
Software update with utilization of new func‐
tions

The "Maintenance Station" section of the documents 
provides information on migrating a Maintenance Sta‐
tion.

Manual
Process Control System PCS 7
Software update without utilization of new 
functions 

Additional documentation
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Configuring the maintenance stations 5
5.1 MS single station system overview

The following table lists the topics that include information and configuration instructions. The 
sequence in the table corresponds to the recommended configuration sequence.   

What? MS
Basic

MS
Standard

General settings in the multiproject/project (Page 34) X X
Configuring the PC station for MS single station system (Page 35) 
Configuring the monitoring of industrial PCs and network objects (Page 44) 
Creation of the diagnostics structure (Page 49) 
Advanced diagnostics settings (Page 54) -
Configuring the user diagnostics (Page 69) 
Setting up SIMATIC PDM (Page 76) X
Overview of complete export (Page 76) 
Overview of individual export (Page 77) 
Engineering for maintenance (Page 78) -
Creating/updating the diagnostic screens (Page 80) X
Compilation and downloading of the Maintenance Station (Page 82) 
Changes in the project (Page 84) 
Integration by the Alarm Control Center (Page 195) -
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5.2 MS multiple station system overview

5.2.1 MS Server overview
The following table lists the topics that include information and configuration instructions. The 
sequence in the table corresponds to the recommended configuration sequence.   

What? MS
Basic

MS
Standard

General settings in the multiproject/project (Page 34) X X
How to configure a PC station for an engineering station (Page 36) 
How to configure a PC station for an MS server (Page 37) 
Configuring the monitoring of industrial PCs and network objects (Page 44) 
Creation of the diagnostics structure (Page 49) 
Advanced diagnostics settings (Page 54) -
Configuring the user diagnostics (Page 69) 
Setting up SIMATIC PDM (Page 76) X
Overview of complete export (Page 76) 
Overview of individual export (Page 77) 
Engineering for maintenance (Page 78) -
Creating/updating the diagnostic screens (Page 80) X
Compilation and downloading of the Maintenance Station (Page 82) 
Changes in the project (Page 84) 
Integration by the Alarm Control Center (Page 195) -

5.2.2 Redundant MS server overview
The following table lists the topics that include information and configuration instructions. The 
sequence in the table corresponds to the recommended configuration sequence.     

Configuring the maintenance stations
5.2 MS multiple station system overview

Maintenance Station
32 Function Manual, 03/2016, A5E36187641-AA



What? MS
Basic

MS
Standard

General settings in the multiproject/project (Page 34) X X
How to configure a PC station for an engineering station (Page 36) 
How to configure a PC station for an MS server (Page 37) 
How to configure a PC station for the redundant partner (Page 38) 
Configuring the monitoring of industrial PCs and network objects (Page 44) 
Creation of the diagnostics structure (Page 49) 
Advanced diagnostics settings (Page 54) -
Configuring the user diagnostics (Page 69) 
Setting up SIMATIC PDM (Page 76) X

 Overview of complete export (Page 76) 
Overview of individual export (Page 77) X
Engineering for maintenance (Page 78) -
Creating/updating the diagnostic screens (Page 80) X
Compilation and downloading of the Maintenance Station (Page 82) 
Changes in the project (Page 84) 
Integration by the Alarm Control Center (Page 195) -

5.2.3 MS client or OS/MS client overview
The following table lists the topics that include information and configuration instructions. The 
order in the table corresponds to the recommended configuration sequence.     

What? MS
Basic

MS
Standard

How to configure a PC station for an MS or OS/MS Client (Page 39) X X
Server data and downloading of a client (Page 83) 
Changes in the project (Page 84) 

5.3 Overview of SIMATIC PDM MS
The following table lists the topics that include information and configuration instructions. The 
order in the table corresponds to the recommended configuration sequence.   

What? Configuration
SIMATIC PDM MS

General settings in the multiproject/project (Page 34) X
Configuring the PC station for SIMATIC PDM MS (Page 40)
Configuring an IE/PB Link PN IO (Page 42) Optional
Creation of the diagnostics structure (Page 49) X
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What? Configuration
SIMATIC PDM MS

Setting up SIMATIC PDM (Page 76) X
Overview of complete export (Page 76) 
Overview of individual export (Page 77) 
Creating/updating the diagnostic screens (Page 80) 
Compiling and downloading SIMATIC PDM MS (Page 82)
Changes in the project (Page 84) 
Integration by the Alarm Control Center (Page 195) Optional

5.4 General settings in the multiproject/project

MS single-station/multiple-station system overview     
To monitor components with the maintenance station, check the settings specified in the 
following table and adapt if necessary.

Setting Location Comment
Regional language and
language for display devices

SIMATIC Manager Set a language in which the WinCC project is to be operated in 
process control.

AS station name (1) SIMATIC Manager ● <=14 characters
● No spacesDesignation of components (1) HW Config

S7 program (1) SIMATIC Manager ● Message number range must be the same for all S7 programs 
in the multiproject/project

● The name of an S7 program may not be assigned twice
Diagnostic blocks (1) The diagnostic blocks must be at least version V6.1.

Use a corresponding library, if necessary.
OS compilation mode Area-oriented
Plant hierarchy setting (1) The settings of the plant hierarchy must be the same in all projects 

of the multiproject/project.
WinCC project type single-sta‐
tion project (2)

WinCC Explorer The single-station project type must be selected in project prop‐
erties. 

Group display hierarchy (1) When user diagnostics is used, the group display hierarchy must 
be automatically created.

(1) Only applies to MS Basic and MS Standard

(2) Only applies to SIMATIC PDM MS

Note

There is only one MS server within a multiproject/project.
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Additional information
For more information about this, refer to the Process Control 
System PCS 7 Engineering System  manual and the Process Control System PCS 7; Operator 
Station manual.

5.5 Configuring the PC station for MS single station system

Introduction
If you are already using an existing ES/OS single station system in the multiproject/project you 
do not need to execute the following steps.

Requirement     
The multiproject/project has been created.

Procedure
1. In the component view of the SIMATIC Manager, select the project into which you want to 

insert the MS single station system.

2. Select the menu command Insert > Station > SIMATIC PC station.
A new SIMATIC PC station is inserted in the selected project.

3. Select the SIMATIC PC station, and then select Edit > Object Properties.

4. In the "Name:" input field, enter the name for the PC station.

5. Enter the Windows computer name in the "Computer name" input box.

6. Click "OK".

7. Select the SIMATIC PC station in the component view of the SIMATIC Manager.

8. In the detailed view, open HW Config by double-clicking the "Configuration" object.
The hardware configuration of the SIMATIC PC station opens.

9. If the hardware catalog is not visible, select the menu command View > Catalog.
The hardware catalog opens.

10.Under "SIMATIC PC Station > HMI" in the hardware catalog, select the WinCC application 
and drag it into the configuration table.

11.If you want to monitor PC stations and/or network objects, under "SIMATIC PC Station > 
User application > OPC server" in the hardware catalog select the OPC server and drag it 
into the configuration table.

12.If you want to use SIMATIC PDM, under "SIMATIC PC Station > PDM" in the hardware 
catalog, select the PDM application and drag it into the configuration table.

13.Insert any additional components, for example, network cards.
For Ethernet connections, it is recommended to use the IE General interface.
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14.If you want to monitor the CP 1623 / CP 1613 communications processor as a network 
object, use the "Properties..." button to activate "IP protocol is used" in the object properties 
of the CP in the "Interface" area of the "General" tab. 

15.Select the menu command Save and Compile Station and close HW Config.

16.In the component view of the SIMATIC Manager, select the "[OS(*)]" object below the 
SIMATIC PC station in the "WinCC Appl." hierarchy folder.
* is a number assigned by the system.

17.Select the menu command Edit > Object Properties.
The "Properties – OS: [Name of the OS]" dialog box opens.

18.In the "Name:" input field, enter a name for the WinCC project of the MS single station 
system.

19.Select the "Target OS and Standby OS" tab.

– Enter the path to the target OS computer in the "Path to target OS computer" input box.

– Enter a symbolic computer name in the "Symbolic computer name" input box.

– Select ">none>" from the drop-down list box in the "Standby OS" area.

20.Click "OK".

5.6 Configuring of PC stations for MS multiple station system

5.6.1 How to configure a PC station for an engineering station

Introduction
If you have already configured an Engineering Station (ES) in the multiproject/project and are 
using SIMATIC PDM, you only have to execute the steps as of step 12.

Requirement     
The multiproject/project has been created.

Procedure
1. In the component view of the SIMATIC Manager, select the multiproject/project into which 

you want to insert the ES.

2. Select the menu command Insert > Station > SIMATIC PC station.
A new SIMATIC PC station is inserted in the selected multiproject/project.

3. Select the SIMATIC PC station, and then select Edit > Object Properties.

4. In the "Name:" input field, enter the name for the PC station.

5. Enter the Windows name of the ES in the "Computer Name" input box.
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6. Click "OK".

7. Select the SIMATIC PC station in the component view of the SIMATIC Manager.

8. In the detailed view, open HW Config by double-clicking the "Configuration" object.
The hardware configuration of the SIMATIC PC station opens.

9. If the hardware catalog is not visible, select the menu command View > Catalog.
The hardware catalog opens.

10.Under "SIMATIC PC Station > HMI" in the hardware catalog, select the WinCC application 
and drag it into the configuration table.

11.Insert any additional components, for example, network cards.
For Ethernet connections, it is recommended to use the IE General interface.

12.If you want to monitor the CP 1623 / CP 1613 communications processor as a network 
object, use the "Properties..." button to activate "IP protocol is used" in the object properties 
of the CP in the "Interface" area of the "General" tab.

13.If you are using SIMATIC PDM, under "SIMATIC PC Station > PDM" in the hardware 
catalog, select the PDM application and drag it into the configuration table.

14.Select the menu command Save and Compile Station and close HW Config.

15.Download the component configurator.

5.6.2 How to configure a PC station for an MS server

Introduction
If you are already using an existing OS server as MS server in the multiproject/project, you do 
not need to execute the following steps.

Requirement     
The multiproject/project has been created.

Procedure
1. In the component view of the SIMATIC Manager, select the multiproject/project into which 

you want to insert the MS server.

2. Select the menu command Insert > Station > SIMATIC PC station.
A new SIMATIC PC station is inserted in the selected multiproject/project.

3. Select the SIMATIC PC station, and then select Edit > Object Properties.

4. In the "Name:" input field, enter the name for the PC station.

5. Enter the Windows name of the computer in the "Computer Name" input box.

6. Click "OK".

7. Select the SIMATIC PC station in the component view of the SIMATIC Manager.
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8. In the detailed view, open HW Config by double-clicking the "Configuration" object.
The hardware configuration of the SIMATIC PC station opens.

9. If the hardware catalog is not visible, select the menu command View > Catalog.
The hardware catalog opens.

10.Under "SIMATIC PC Station > HMI" in the hardware catalog, select the WinCC application 
and drag it into the configuration table.

11.If you want to monitor PC stations and/or network objects, under "SIMATIC PC Station > 
User application > OPC server" in the hardware catalog select the OPC server and drag it 
into the configuration table.

12.Insert any additional components, for example, network cards.
For Ethernet connections, it is recommended to use the IE General interface.

13.If you want to monitor the CP 1623 / CP 1613 communications processor as a network 
object, use the "Properties..." button to activate "IP protocol is used" in the object properties 
of the CP in the "Interface" area of the "General" tab.

14.Select the menu command Save and Compile Station and close HW Config.

15.In the component view of the SIMATIC Manager, select the "[OS(*)]" object below the 
SIMATIC PC station in the "WinCC Appl." hierarchy folder of the MS server.
* is a number assigned by the system.

16.Select the menu command Edit > Object Properties.
The "Properties – OS [name of OS]" dialog box opens.

17.In the "Name:" input field, enter a name for the WinCC project of the MS server.

18.Select the "Target OS and Standby OS" tab.

– Enter the path to the target OS computer in the "Path to target OS computer" input box.

– Enter a symbolic computer name in the "Symbolic computer name" input box.

– Select the following from the drop-down list box in the "Standby OS" area:
If you not configure the MS server redundantly, select ">none>".
If you configure the MS server redundantly, select the redundant partner. You can only 
select the partner if it has been configured.

19.Click "OK".

5.6.3 How to configure a PC station for the redundant partner

Introduction
If you are already using the redundant partner of an OS server in the multiproject/project, you 
do not need to execute the following steps.

Requirement     
The multiproject/project has been created.
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Procedure
1. In the component view of the SIMATIC Manager, select the multiproject/project into which 

you want to insert the redundant partner.

2. Select the menu command Insert > Station > SIMATIC PC station.
A new SIMATIC PC station is inserted in the selected multiproject/project.

3. Select the SIMATIC PC station, and then select Edit > Object Properties.

4. In the "Name:" input field, enter the name for the PC station.

5. Enter the Windows name of the computer in the "Computer Name" input box.

6. Click "OK".

7. Select the SIMATIC PC station in the component view of the SIMATIC Manager.

8. In the detailed view, open HW Config by double-clicking the "Configuration" object.
The hardware configuration of the SIMATIC PC station opens.

9. If the hardware catalog is not visible, select the menu command View > Catalog.
The hardware catalog opens.

10.Under "SIMATIC PC Station > HMI" in the hardware catalog, select the WinCC application 
(stby) and drag it into the configuration table:

11.Insert any additional components, for example, network cards.
For Ethernet connections, it is recommended to use the IE General interface.

12.If you want to monitor the CP 1623 / CP 1613 communications processor as a network 
object, use the "Properties..." button to activate "IP protocol is used" in the object properties 
of the CP in the "Interface" area of the "General" tab.

13.Select the menu command Save and Compile Station and close HW Config.

14.In the component view of the SIMATIC Manager, select the "[OS(*)_StBy]" object below 
the SIMATIC PC station in the "WinCC Appl." hierarchy folder (Stby.).
* is a number assigned by the system.

15.Select the menu command Edit > Object Properties.
The "Properties – Standby OS: [Name of the OS]" dialog box opens.

16.Select the "Target OS and Master OS" tab and enter the path to the target OS computer.

17.Click "OK".

5.6.4 How to configure a PC station for an MS or OS/MS Client

Introduction     
You can operate the MS Client or OS/MS Client on the Engineering Station or a separate PC.

Requirement
The multiproject/project has been created.
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Procedure
1. In the component view of the SIMATIC Manager, select the multiproject/project into which 

you want to insert the MS client.

2. Select the menu command Insert > Station > SIMATIC PC station.
A new SIMATIC PC station is inserted in the selected multiproject/project.

3. Select the SIMATIC PC station, and then select Edit > Object Properties.

4. In the "Name:" input field, enter the name for the PC station.

5. Enter the name in the "Computer name" input field.

– If you are running the MS client on a separate PC station, enter the Windows computer 
name of the target computer.

– If you are operating the MS client as MS client on the engineering station, enter the 
Windows computer name of the engineering station.

6. Click "OK".

7. Select the SIMATIC PC station in the component view of the SIMATIC Manager.

8. In the detailed view, open HW Config by double-clicking the "Configuration" object.
The hardware configuration of the SIMATIC PC station opens.

9. If the hardware catalog is not visible, select the menu command View > Catalog.
The hardware catalog opens.

10.Under "SIMATIC PC Station > HMI" in the hardware catalog, select the WinCC application 
client and drag it into the configuration table.

11.Insert other components.

12.Select the menu command Save and Compile Station and close HW Config.

13.In the component view of the SIMATIC Manager, select the "[OSC]" object underneath the 
MS client's SIMATIC PC station.

14.Select the menu command Edit > Object Properties.
The "Properties – Client OS: [Name of the OS]" dialog box opens.

15.In the "Name:" input field, enter a name for the WinCC project of the MS client.

16.Click "OK".

5.7 Configuring the PC station for SIMATIC PDM MS

Requirement       
The project has been created.
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Procedure
1. In the component view of the SIMATIC Manager, select the project into which you want to 

add SIMATIC PDM MS.

2. Select the menu command Insert > Station > SIMATIC PC station.
A new SIMATIC PC station is inserted in the selected multiproject/project.

3. Select the SIMATIC PC station, and then select Edit > Object Properties.

4. In the "Name:" input field, enter the name for the PC station.

5. Enter the Windows name of the computer in the "Computer Name" input box.

6. Click "OK".

7. Select the SIMATIC PC station in the component view of the SIMATIC Manager.

8. In the detailed view, open HW Config by double-clicking the "Configuration" object.
The hardware configuration of the SIMATIC PC station opens.

9. If the hardware catalog is not visible, select the menu command View > Catalog.
The hardware catalog opens.

10.Under "SIMATIC PC Station > Controller > WinLC RTX" in the hardware catalog, select the 
required "WinLC-RTX" application and drag it into the configuration table.

Note

Note that only one WinLC RTX can be added.

11.Under "SIMATIC PC Station > HMI" in the hardware catalog, select the WinCC application 
and drag it into the configuration table.

12.Select the PDM application under "SIMATIC PC Station > PDM" in the hardware catalog 
and drag it to the configuration table.

13.Insert any additional components, for example, network cards.
For Ethernet connections, it is recommended to use the IE General interface.

14.Select the menu command Save and Compile Station and close HW Config.

15.In the component view of the SIMATIC Manager, select the "[OS(*)]" object below the 
SIMATIC PC station in the "WinCC Appl." hierarchy folder.
* is a number assigned by the system.

16.Select the menu command Edit > Object Properties.
The "Properties – OS: [Name of the OS]" dialog box opens.

17.In the "Name:" input field, enter a name for the WinCC project of SIMATIC PDM MS.

18.Select the "Target OS and Standby OS" tab.

– Enter the path to the target OS computer in the "Path to target OS computer" input box.

– Enter a symbolic computer name in the "Symbolic computer name" input box.

– Select ">none>" from the drop-down list box in the "Standby OS" area.

19.Click "OK".
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5.8 Configuring an IE/PB Link PN IO

Introduction
The IE/PB Link PN IO link module is used as a gateway to ensure that SIMATIC PDM MS has 
access to all PROFIBUS DP slaves connected to the lower-level PROFIBUS.

The IE/PB Link PN IO link module connects the two network types, Industrial Ethernet and 
PROFIBUS.

Requirement
The project has been created.

Step 1 - Create a SIMATIC 300 station
1. Select the project into which you want to insert the SIMATIC 300 station in the component 

view of the SIMATIC Manager.

2. Select the menu command Insert > Station > SIMATIC 300 station.
A new SIMATIC 300 station is inserted into the selected project.

3. Select the SIMATIC PC station, and then select Edit > Object Properties.

4. In the "Name:" input field, enter the name for the SIMATIC 300 station.

5. Click "OK".

Step 2 - Configure IE/PB Link PN IO link module in the SIMATIC 300 station
1. Select the SIMATIC 300 station in the component view of the SIMATIC Manager.

2. In the detailed view, open HW Config by double-clicking the "Hardware" object.
The hardware configuration of the SIMATIC 300 station opens.

3. If the hardware catalog is not visible, select the menu command View > Catalog.

4. Select the device type Gateway – IE/PB Link PN IO in the hardware catalog under "SIMATIC 
300".

Note

Note that the IE/PB Link PN IO link module is a special configuration component.

No other components, such as profile rails or modules, can be placed in the S7-300 station 
apart from this component.

5. Create an Ethernet network.

6. Assign parameters for the Ethernet network using the following data:

– IP address

– S7 subnet ID

7. Create a PROFIBUS network.
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8. Assign parameters for the PROFIBUS network using the following data:

– Address

– "No DP" mode

9. Select the "Activate data record gateway" check box for the IE/PB Link PN IO link module.

10.Transfer the parameters to the IE/PB Link PN IO link module.

11.Note down the following information:

– The S7 subnet ID and the IP address of the Ethernet network

– The DP master address for the PROFIBUS network

12.Repeat the procedure for any other IE/PB Link PN IO link modules.

Note

Use the same S7 subnet ID for the Ethernet network for any further IE/PB Link PN IO link 
modules.

Step 3 - Configure IE/PB Link PN IO link module in the process device network view
1. Configure an Ethernet network in the process device network view.

2. Assign parameters for the Ethernet network with the S7 subnet ID.

3. Configure the IE/PB Link PN IO link module in this Ethernet network.

4. Assign parameters for the IE/PB Link PN IO link module using the following data:

– With the S7 subnet ID

– With the corresponding IP address

– With the corresponding DP master address

5. Repeat the procedure for any other IE/PB Link PN IO link modules.

Additional information
For additional information on this topic, refer to the SIMATIC NET; S7-CPs for Industrial 
Ethernet and PCS 7 Process Control System; SIMATIC PDM manuals.

Configuring the maintenance stations
5.8 Configuring an IE/PB Link PN IO

Maintenance Station
Function Manual, 03/2016, A5E36187641-AA 43



5.9 Configuring the monitoring of industrial PCs and network objects

5.9.1 Requirements

Introduction           

Note

You can monitor the industrial PCs and network objects for the following maintenance station 
versions:
● MS Basic
● MS Standard

The programs or services listed in the following table must be available and configured to 
monitor industrial PCs and network objects.

Application/service MS single-station sys‐
tem

MS multiple station sys‐
tem

SIMATIC PDM MS

OPC Server MS single-station sys‐
tem

● MS server
● Redundant partner 

of the MS server

Not supported
NDIS adapter

SNMP service On each industrial PC 
to be monitoredDiagnostics Monitor

Programs and services
● OPC Server

– OPC (OLE for Process Control) is an interface for data exchange in automation 
engineering.

– It is set up in HW Config.
You can find information about this in the following sections.

● NDIS adapter

– For monitoring of components on the plant bus, if access to the plant bus is provided 
via a communication processor (CP 1623 / CP 1613).

– The NDIS adapter must be configured.
You can find more information about this in the manual Process Control System PCS 7; 
PCS 7 PC Configuration.
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● SNMP service

– SNMP is the Simple Network Management Protocol that is used to manage networks.

– The SNMP service must be configured.
You can find more information about this in the manual Process Control System PCS 7; 
PCS 7 PC Configuration.

A network connection must be available to the components with SNMP functionality to be 
included in the diagnostics.

● Diagnostics Monitor

– Diagnostics Monitor is a diagnostics tool that provides the diagnostic data required from 
SIEMENS industrial PCs.

– Diagnostics Monitor is called in the header of the faceplate in process control.

– Diagnostics Monitor must be installed and configured.
You can find more information about this in the manual Process Control System PCS 7; 
PCS 7 PC Configuration.

– Additional settings
Start the Web server
Start the Management Explorer.
Select Options > Web server.
Authorize Diagnostics Monitor Web server in the Windows firewall
Open the firewall.
Create a new exception/rule for the "MiniWebService.exe" program.
This file is accessed via the Windows Start menu, submenu ...\Siemens\Automation
\DiagnosticManagement\WebServer_DM\Bin.

5.9.2 Device profiles and community

Introduction
If an SNMP-compatible component is configured in the OPC server, a device profile and a 
community must be assigned to this SNMP-compatible component.

Overview
The following table shows the assignment of the community to the device profile.     

Components Device profile Community
SCALANCE series X200 Profile_SCALANCE_X200_Vxy.txt public
SCALANCE series X200 RNA Profile_SCALANCE_X200RNA_Vxy.txt
SCALANCE series X300
SCALANCE series X400

Profil_SCALANCE_X300X400_Vxy.txt

SCALANCE series XM400 Profil_SCALANCE_XM400_Vxy.txt
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Components Device profile Community
SCALANCE series X500 Profil_SCALANCE_X500_Vxy.txt public
SCALANCE series W700 Profil_SCALANCE_W700_Vxy.txt
ESM/OSM Profil_OSM_Vxy.txt
Siemens IPC (Industrial PC) Profil_IPC_Vxy.txt SOL
Other devices,
for example third-party PCs, premium 
servers for SIMATIC PCS 7, network 
adapters, switches

MIB-II_V10.txt Determine the community configured 
in the device.

All devices that were integrated by 
means of import, but are not to be dis‐
played

No SNMP -

Note

"No SNMP" as device profile has the following effects on the diagnostic screens:
● No asset object is created for the network component.
● The asset object of a PC station is created for an industrial PC.

5.9.3 How to assign components with SNMP functionality to the OPC server

Naming rules
Aspects to be taken into account when naming components with SNMP functionality:

● Do not use spaces or special characters in module names.

● For IPCs, assign module names that correspond to the computer name of the IPC in the 
SIMATIC Manager.

● For all other modules, assign module names that are different from the existing computer 
names of PC stations in the project.

● If you use two separate Ethernet networks in your configuration, make sure that both the 
names and the IP addresses of the modules are unique across the network.

Requirements   
● The HW configuration for the PC objects and network objects is completed.

● The OPC server has been inserted.
You will find more information on this subject in the following sections:

– Configuring the PC station for MS single station system (Page 35)

– How to configure a PC station for an MS server (Page 37)

– Configuring the PC station for SIMATIC PDM MS (Page 40)
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Procedure
1. Select the OPC server in HW Config, and then select the menu command Edit > Object 

Properties....
The "Properties – OPC server" dialog box opens.

2. Open the "SNMP" tab.

3. Enter at least 1000 ms in the "Cycle time" input box.
You can obtain additional information with the "Help" button.

4. Click "Edit plant configuration".
The "Edit plant configuration" dialog box opens.

5. Click "Import".
All objects configured in your project with an IP address are imported.

Note

When you import a CP 1623 / CP 1613, the IP address of the HW Config is imported. If 
necessary, replace this TCP/IP address with an NDIS IP address.

6. Double-click the node.
The "Edit node" dialog box opens.

7. Enter the following data for the imported devices.

– Name:
Enter a name.

– IP address:
If necessary, change the IP address.

– Device profile and community:
You can find additional information about this in the section "Device profiles and 
community (Page 45)".

Note

Note that these community name entries are case sensitive. 

The community name in the "Edit Node" and "Add Node" dialog boxes must match the 
community name stored in the respective device.

– Timeout:
Enter a value of 9000  ms or higher, depending on the number of components to be 
monitored.
You can obtain additional information with the "Help" button.

– SNMP optimization
Activate the check box.

– Comment:
You can enter a comment in this field. This comment is visualized in the faceplate of the 
process control system.

8. Click "OK".
The "Edit nodes" dialog box closes and you return to the "Edit plant configuration" dialog 
box.
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9. Click the "Add" button if you want to insert IPCs or other components with SNMP 
functionality.
The "Add node" dialog box opens.

10.Enter all required data.
Proceed as described in item 7.

11.Click "OK".
The "Add node" dialog box closes and you return to the "Edit plant configuration" dialog 
box.

12.Insert additional nodes as required.

13.Click "OK".
The configuration is complete.

14.Compile and download the hardware configuration.
Additional information on this is available in the Process Control System PCS 7; 
Engineering System manual.

5.9.4 How to insert the OPC server into the redundant partner

Requirement   
The OPC server is configured in the MS server.

You can find additional information on this topic in the section "How to assign components with 
SNMP functionality to the OPC server (Page 46)".

Procedure
1. In SIMATIC Manager, open the component view.

2. Select the SIMATIC PC station of the MS server.

3. In the detailed view, open HW Config by double-clicking the "Configuration" object.
The hardware configuration of the SIMATIC PC station opens.

4. Select the OPC server.

5. Select Edit > Copy from the menu.

6. Select the SIMATIC PC station of the redundant partner.

7. In the detailed view, open HW Config by double-clicking the "Configuration" object.
The hardware configuration of the SIMATIC PC station opens.

8. Select the position for the OPC server.

9. Select the Edit  > Paste command.

10.Select the Station > Save and Compile command.
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5.9.5 How to transfer the OPC configuration to the WinCC project

Introduction
Data tags, alarm tags and alarm texts for all components with SNMP functionality are 
generated in the WinCC project with tag export.

Requirements
● The diagnostic structure has been created.

● The maintenance station has been compiled.

Procedure
1. Select the OPC server in HW Config, and then select Edit > Object Properties... .

The "Properties – OPC server" dialog box opens.

2. Open the "SNMP" tab.

3. In the "Tag export" group, select the check box

– "Export complete plant configuration" upon initial tag export

– "Export changes only" upon all subsequent tag exports

4. Click "Export Tags for WinCC".

5. Click "OK".
The dialog box closes.

5.10 Creation of the diagnostics structure

5.10.1 Information on diagnostics structure and plant hierarchy

Diagnostics structure in the plant hierarchy       
The diagnostics structure is a folder structure in the plant hierarchy and is automatically created 
by the system. The number of hierarchy levels is limited to 8.

The diagnostics hierarchy folder is the top hierarchy folder; it maps the area-forming level for 
the OS (area selection button in overview of process control). Depending on the set level OS 
area in the plant hierarchy, a maximum of three folders is created with the name "Diagnostics".

The hierarchy folders with the names AS objects, field devices, network objects, and PC 
stations are created on the same hierarchy level below the diagnostics hierarchy folder that 
maps the OS area. The version of the maintenance station and the existing objects determine 
which hierarchy folders are created.

The names of the automatically generated hierarchy folders cannot be changed.

Configuring the maintenance stations
5.10 Creation of the diagnostics structure

Maintenance Station
Function Manual, 03/2016, A5E36187641-AA 49



Settings in the plant hierarchy
The following settings are made for the maintenance station in the "Plant hierarchy - Settings" 
dialog box:

● Number of hierarchy levels (1)

● Area-forming level for the OS (1)

● Creation of the diagnostics structure

● Version of the Maintenance Station

● Setting for deriving names in the PH

● Selection of the maintenance station 

(1) Note: Applies to all multiprojects/projects

Information on configuration of settings in the plant hierarchy is available in the following 
section.

Additional information
You can find additional information on this topic in the section "Relationship between the 
diagnostic structure and version (Page 52)".

5.10.2 How to make the settings in the plant hierarchy

Requirements for MS single-station system and MS multiple-station system         
● The multiproject/project has been created.

● The hardware configuration is completed.

● The network configuration is completed.

● The basic parameter assignment for all components is available offline.

Requirements for SIMATIC PDM MS
● The project was not created as multiproject.

● The hardware configuration is completed

● The plant configuration is completed.

● The configuration of PC stations and network components (optional) is completed.

● The naming of components regarding LID and TAG is completed.

● All components in the process device network view are configured.

● The used IE/PB Links PN IO are configured.
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Procedure
1. Open the plant view in the SIMATIC Manager.

2. Select the object in the tree view:

– If you are using a multiproject, select the object "[name of the project] MP".

– If you are using a single project, select the object "[name of the project]".

3. Select the menu command Options > Plant Hierarchy > Settings... .

4. If you have selected a multiproject, the "Plant Hierarchy - Settings" dialog box opens.
Select the project whose settings you wish to use as a template for the plant hierarchy.

– Click "OK".
The "Customize Plant Hierarchy" dialog box opens.

– Proceed to step 6.

5. If you have selected an individual project or a project within a multiproject, the "Plant 
Hierarchy - Settings" dialog box opens.

6. Define the settings for the relevant levels.
Remember that the settings of the plant hierarchy within the multiproject/project are to be 
uniform.

7. Activate the "Derive picture hierarchy from the plant hierarchy" check box.
If you do not wish to derive the diagnostic screens from the plant hierarchy for your plant 
areas, deactivate the "Picture Tree" check box in the dialog for compiling the OS. 
Configure the plant hierarchy for the diagnostic screens in the WinCC project in the Picture 
Tree editor.

8. Enable the "Derive diagnostic screens from the plant hierarchy" check box.

9. Specify the version.
Enable the appropriate option button:

– "Maintenance Station Standard (license required)" option button

– "Maintenance Station Basic (overview screens only)" option button

– "Maintenance Station PDM (no AS diagnostics)" option button

10.When creating/updating the diagnostic screens, specify whether the names of the created 
hierarchy folders should be derived from the name or the commentary for the hardware 
components. Enable the appropriate option button:

– "Derive PH names from the names of the hardware components" option button

– "Derive PH names from the comments of the hardware components" option button
Since there are no restrictions on the characters that can be used for the comment texts, 
you can use any type of name.

11.Click "OK".
The "Define Maintenance Station" dialog box opens and all OSs available in the multiproject/
project are shown.

12.Select the OS you want to define as Maintenance Station.

13.Click "OK".
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Result
In a multiproject, the "Diagnostics" hierarchy folder is inserted in all the projects within the 
multiproject. 

● The standard diagnostic structure with the hierarchy folders "AS Objects", "Field Devices", 
"Network Objects", and "PC Stations" is automatically created in the project with the MS 
server. The structure for the user diagnostics must be created manually. 

● In the other projects of the multiproject, only the "AS Objects" and "Field Devices" hierarchy 
folders are created automatically within the diagnostics structure.

Note that the diagnostics structure depends on the selected type.

If the second or third level is activated for the OS area, a structure of two or three "Diagnostics" 
folders is created in the plant hierarchy.

5.10.3 Relationship between the diagnostic structure and version

Introduction
The diagnostic structure is created differently depending on the version of the maintenance 
station.

Diagnostic structure MS Basic version       
The table shows an example of the diagnostic structure.

Areas and levels
1 2 3 4 5 6 7 8
Diagnos‐
tics
 
 

AS/system -
Network 
objects
PC sta‐
tions
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Diagnostic structure – MS Standard version
The table shows an example of the diagnostic structure.

Areas and levels
1 2 3 4 5 6 7 8
Diagnostics AS/system AS objects AS detail 

view
-

DP master 
system

DP nodes -

PROFINET 
IO system

PN nodes -

Field devices AS objects 
without their 
own group 
display

DP master 
system

DP nodes Modules HART field 
devices

-

PA field devi‐
ces

-

PROFINET 
IO system

PN nodes Modules HART field 
devices

-

PA field devi‐
ces

-

DP nodes
Network ob‐
jects

-

PC stations
User objects Depending on the configuration in the plant hierarchy

Diagnostic structure – SIMATIC MS PDM version
The table shows an example of the diagnostic structure.

Areas and levels
1 2 3 4 5 6 7 8
Diagnos‐
tics

Field devi‐
ces

Depending on the configuration in SIMATIC PDM 

Network ob‐
jects

-

PC stations
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5.11 Advanced diagnostics settings

5.11.1 "Maintenance functions" tab

5.11.1.1 Configuring maintenance links

Introduction     
In process control, links to freely configurable web pages can be called in the overview screen 
and the header area of the faceplates; these web pages are used to support the diagnostic 
measures.

10 link objects are automatically created by the system.

Automatically created link objects are:

Maintenance link1 to Maintenance link10.

The properties are managed in one language.

A link object has the properties "Name:" and "URL:".

The name of the target address is entered in the "Name:" entry field.

The target address is entered in the "URL:" entry field.

You can change the properties of link objects.

You can restore the diagnostic settings for all lists in the tab using the "Set Default Settings" 
button.

Note

This function is available if you configured the Maintenance Station in the MS Standard version.

Rule
● Maintenance links are always valid for the entire multiproject/project.

● The number of link objects is limited to 10.
Display of the link objects, if this is configured:

– In the overview screen, link object 1 to 10

– In the header of the faceplate link, object 1 to 3

● The automatically generated link objects can be renamed.

● The name of the link object contains a maximum of 24 characters.

Configuring the maintenance stations
5.11 Advanced diagnostics settings

Maintenance Station
54 Function Manual, 03/2016, A5E36187641-AA



● The web address consists of up to 256 characters.

● The name and the web address to the web page are configured in the object properties of 
the link object.

Note

Ensure that the target address is accessible during process control.

Requirement
The Maintenance Station has been created.

Procedure
1. Open the plant view in the SIMATIC Manager.

2. Select the object in the tree view:

– If you are using a multiproject, select the object "[name of the project] MP".

– If you are using a single project, select the object "[name of the project]".

3. Select the menu command Options > Plant Hierarchy > Advanced Diagnostics Settings... .
The "Advanced Diagnostics Settings" dialog box opens.

4. Select the "Functions for maintenance" tab

5. In the "Maintenance links" area, select the maintenance link whose existing properties you 
want to change.

6. Click "Properties...".
The "Properties maintenance link" dialog box opens.

7. Enter the desired name for the link object in the "Name:" entry field.

8. Enter the target address in the "URL:" entry field.

9. Click "OK".
The "Properties maintenance link" dialog box closes.

10.Click "OK".
The "Advanced Diagnostics Settings" dialog box closes.

Result
After OS compilation and subsequent download, the modified text is displayed in the process 
control.

Additional information
You can find additional information on the overview screen in the section "Calling web pages 
via maintenance links (Page 97).

You can find additional information on the faceplate in the section "Screen window title and 
header (Page 132).
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5.11.1.2 Configuring maintenance targets for individual export

Introduction     
Maintenance targets can be selected for storage of individual export files in the process control. 
The selection is made in the "Maintenance" view of the faceplate.

A target object is created automatically by the system.

Automatically created target object:

The name is Default target. The path is project directory ...\wincproj\<os-name>.

A target object has the properties "Name:" and "Path:".

The name of the target path is entered in the "Name:" entry field.

The target path for the individual export file is entered in the "Path:" entry field.

You can add, change and/or delete target objects.

You can restore the diagnostic settings for all lists in the tab using the "Set Default Settings" 
button.

Note

This function is available if you configured the Maintenance Station in the MS Standard version.

Target directory
The target directory can be configured as a local or network directory.

Target directory Example of a target directory Storage location
Local target direc‐
tory

D:\folder On the MS server which is the master at the 
time export is initiated, in the configured path

Network target di‐
rectory

\\computer name\shared drive\fold‐
er

On the specified computer in the configured 
path

Note

We recommend that you configure the target directory as a network target directory for a plant 
configuration with an MS server and a standby MS server. This will ensure that the export file 
is always stored in the same "location", regardless of which MS server is the master at the 
time the export is initiated.

Rules
● Maintenance targets are always valid for the entire multiproject/project.

● The name of the target object has a length of not more than 24 characters.

● The name of the target object is managed in one language.

● The maximum length of the target directory is 256 characters.
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Requirement
The Maintenance Station has been created.

Procedure
The following section describes how to configure, change and delete a target object.

To open the "Advanced Diagnostics Settings" dialog, follow the steps below.

1. Open the plant view in the SIMATIC Manager.

2. Select the object in the tree view:

– If you are using a multiproject, select the object "[name of the project] MP".

– If you are using a single project, select the object "[name of the project]".

3. Select the menu command Options > Plant Hierarchy > Advanced Diagnostics Settings... .
The "Advanced Diagnostics Settings" dialog box opens.

4. Select the "Functions for maintenance" tab

Configuring the maintenance target
1. Click "Add..." in the "Maintenance targets" area.

The "Add maintenance target" dialog box opens.

2. Enter the name for the target object in the "Name" entry field.

3. Click "Browse".

4. Select the required target directory.
The target directory is entered in the "Path:" entry field.

5. Click "OK".
The "Add maintenance targets" dialog box closes.

6. Click "OK".
The "Advanced Diagnostics Settings" dialog box closes.

Changing maintenance target properties
1. In the "Maintenance targets" area, select the target object whose properties you want to 

change.

2. Click "Properties...".
The "Properties maintenance target" dialog box opens.

3. Make the desired changes.

4. Click "OK".
The "Properties maintenance target" dialog box  closes.

5. Click "OK".
The "Advanced Diagnostics Settings" dialog box closes.
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Deleting maintenance targets
1. In the "Maintenance targets" area, select the maintenance target you want to delete.

2. Click "Delete".
The target object is deleted.

3. Click "OK".
The "Advanced Diagnostics Settings" dialog box closes.

Result
After OS compilation and subsequent download, the modified text is displayed in the process 
control.

Additional information
You can find additional information on selecting maintenance targets in the section 
""Maintenance" view (Page 146)".

5.11.1.3 Configuring maintenance actions

Introduction   
An action to be performed can be assigned to a requested maintenance action in the process 
control. The assignment is made in the "Maintenance" view of the faceplate.

Seven action objects are created automatically by the system.

Automatically created action objects are:

● Disassembly

● Device swap

● Calibration

● Zero adjustment

● Cleaning

● Service

● Other

Texts for the automatically created maintenance actions are available in multiple languages.
You can find information on this in the Process Control System PCS 7; Operator Station 
configuration manual, section "Setting languages".

An action object has the properties "Name:" and "Name for user:".

The name of the maintenance action is entered in the "Name:" entry field. 

The name that a maintenance engineer can select from the drop-down list is entered in the 
"Name for user:" entry field.

You can add, change and/or delete action objects.

The number of action objects is not limited.
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You can restore the diagnostic settings for all lists in the tab using the "Set Default Settings" 
button.

Note

This function is available if you configured the Maintenance Station in the MS Standard version.

Rules
● Maintenance actions are always valid for the entire multiproject/project.

● The name of an action object contains a maximum of 24 characters.

● The name of the action object is managed in one language.

● The text in the "Name for user:" field is managed in multiple languages. 
You can find information on this in the section "Configuring multilingual texts (Page 63)".

Requirements
The Maintenance Station has been created.

Procedure
The following section describes how to configure, change and delete an action object.

To open the "Advanced Diagnostics Settings" dialog, follow the steps below.

1. Open the plant view in the SIMATIC Manager.

2. Select the object in the tree view:

– If you are using a multiproject, select the object "[name of the project] MP".

– If you are using a single project, select the object "[name of the project]".

3. Select the menu command Options > Plant Hierarchy > Advanced Diagnostics Settings... .
The "Advanced Diagnostics Settings" dialog box opens.

4. Select the "Functions for maintenance" tab

Add maintenance action
1. Click "Add..." in the "Maintenance actions" group.

The "Add maintenance action" dialog box opens.

2. Enter the name for the action object in the "Name:" entry field.

3. Click inside the "Name for user:" entry field.
The text is applied in the "Name for user:" entry field.

4. If you want to change the text in the "Name for user:" entry field, enter the desired text.

5. Click "OK".
The "Add maintenance actions" dialog box closes.

6. Click "OK".
The "Advanced Diagnostics Settings" dialog box closes.
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Changing maintenance action properties
1. In the "Maintenance actions" group, select the action object whose properties you want to 

change.

2. Click "Properties...".
The "Properties maintenance action" dialog box opens.
The previous entries are displayed in the input dialog.

3. If you want to change the text in the "Name:" entry field, enter the desired text.
Proceed to step 5.

4. If you want to change the text in the "Name for user:" entry field, enter the desired text.
Click "OK".
The "Advanced Diagnostics Settings" dialog box opens.

– If the change does not affect the other languages, click "No".

– If the change affects the other languages, click "Yes".

The "Advanced Diagnostics Settings" dialog box closes.

5. Click "OK".
The "Maintenance action properties" dialog box closes.

6. Click "OK".
The "Advanced Diagnostics Settings" dialog box closes.

Deleting a maintenance action
1. In the "Maintenance actions" group, select the action object you want to delete.

2. Click "Delete".
The action object is deleted.

3. Click "OK".
The "Advanced Diagnostics Settings" dialog box closes.

Result
After OS compilation and subsequent download, the modified text is displayed in the process 
control.

Additional information
You can find additional information on multilingual configuration of maintenance actions in the 
section "Configuring multilingual texts (Page 63)".

You can find additional information on languages in the Process Control System PCS 7; 
Operator Station configuration manual, section "Setting languages".

You can find additional information on assigning a maintenance action in the section 
""Maintenance" view (Page 146)".
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5.11.1.4 Configuring maintenance information

Introduction     
In PCS 7 V8.2 and higher, user-specific maintenance information texts can be configured in 
the process control for displaying detailed diagnostic information in the faceplate.

Sixteen information objects are created automatically by the system.

Automatically created information objects are:

● External service request, no additional information

● Service interval reached

● Different operating state

● Different performance parameters

● Auxiliary energy problem

● Auxiliary material problem

● Mechanical problem

● Electrical problem

● Pneumatic problem

● Calibration request

● Measuring circuit check

● Process-related event

● Cleaning request

● Emptying request

● Wear reserve undershot

● Degree of pollution high

Texts for the automatically created maintenance information are available in multiple 
languages.
You can find information on this in the Process Control System PCS 7; Operator Station 
configuration manual, section "Setting languages"

An information object has the properties "Name:" and "Name for user:".

The name of the maintenance information is entered in the "Name:" entry field. 

The name that is displayed in the faceplate is entered in the "Name for user:" entry field.

You can change the properties of information objects.

You can restore the diagnostic settings for all lists in the tab using the "Set Default Settings" 
button.

Note

This function is available if you configured the Maintenance Station in the MS Standard version.
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Rule
● Maintenance information is always valid for the entire multiproject/project.

● The number of maintenance information objects is limited to 16.

● The name of the information object is managed in one language and cannot be changed.

● Maintenance information created by the system can be adapted on a user-specific basis.

● The text in the "Name for user:" field is managed in multiple languages. 
You can find information on this in the section "Configuring multilingual texts (Page 63)".

● The following applies to a project created in PCS 7 versions before V8.2.
The maintenance information in the faceplate pre-assigned by the system is only displayed 
if the "Advanced Diagnostics Settings" dialog has been opened and confirmed with "OK".

Requirements
The Maintenance Station has been created.

Procedure
1. Open the plant view in the SIMATIC Manager.

2. Select the object in the tree view:

– If you are using a multiproject, select the object "[name of the project] MP".

– If you are using a single project, select the object "[name of the project]".

3. Select the menu command Options > Plant Hierarchy > Advanced Diagnostics Settings... .
The "Advanced Diagnostics Settings" dialog box opens. 

4. Select the "Functions for maintenance" tab

5. In the "Maintenance information" group, select the information object whose properties you 
want to change.

6. Click "Properties...".
The "Properties maintenance information" dialog box opens.
The previous entries are displayed in the input dialog.

7. Enter the desired text.

8. Click "OK".
The "Advanced Diagnostics Settings" dialog box opens.

– If the change does not affect the other languages, click "No".

– If the change affects the other languages, click "Yes".

The "Advanced Diagnostics Settings" dialog box closes.

9. Click "OK".
The "Properties maintenance information" dialog box closes.

10.Click "OK".
The "Advanced Diagnostics Settings" dialog box closes.
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Result
After OS compilation and subsequent download, the modified text is displayed in the process 
control.

Additional information
You can find additional information on multilingual configuration of maintenance information 
in the section "Configuring multilingual texts (Page 63)".

You can find additional information on languages in the Process Control System PCS 7; 
Operator Station configuration manual, section "Setting languages".

You can find additional information on configuring in the section "Configuring the display of 
maintenance information (Page 68)".

You can find additional information on displaying maintenance information in the section 
""External diagnostics" view (Page 175)".

5.11.1.5 Configuring multilingual texts

Introduction
Default texts for maintenance actions and maintenance information are available for the 
languages installed in the project.

Languages that might typically be installed in the project are:

● German (Germany)

● English (United States)

● French (France)

● Italian (Italy)

● Spanish (Spain, International Sort)

● Chinese (Simplified, PRC)

● Japanese (Japan)

You can display the languages installed in the project. 

Select the menu command Options > Language for Display Devices... in SIMATIC Manager.

Requirement
The Maintenance Station has been created.

The desired languages have been installed in each project.

Procedure
1. Select the menu command Options > Language for display devices.

2. Select the desired language as the default language.
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3. Click "OK".

4. Select the menu command Options > Plant Hierarchy > Advanced Diagnostics Settings....

5. Select the appropriate text.

6. Click "Properties".

7. Enter the desired text in the "Name for user:" field.

8. Click "OK".

9. To change the text in the selected language only, click "No".

10.Click "OK".

11.Repeat steps 5 to 10 for all texts you want to change in the selected language.

12.Click "OK".

13.Repeat steps 1 to 12 for all texts and languages you want to change.

Result
After OS compilation and subsequent download, the modified text is displayed in the process 
control.

Additional information
You can find additional information on languages in the Process Control System PCS 7; 
Operator Station configuration manual, section "Setting languages".

5.11.2 "Other settings" tab

5.11.2.1 Automatic positioning of block icons in the areas

Introduction
You specify the scope for creating/updating diagnostics screens in the "Automatic positioning 
of the block icons in the areas" area of the "Other settings" dialog.

Automatic positioning can be selected for one of the following diagnostic areas.

● AS/system

● Field devices

● User objects

● Network objects

● PC stations

The selection applies to the selected diagnostic area including all subordinate levels.
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The system offers the following options: 

● Check box cleared
This is the default setting.
When you create/update a screen, all PCS 7 block icons are arranged automatically, 
starting in the top left corner.
Screens in which a rack structure (for example, ET 200 central rack) is displayed are 
exceptions to this. In this case, the block icons for objects are arranged in the order of their 
slots.
After you update/create the diagnostics screens, move the block icons to meet your 
requirements. Block icons that have been moved remain in their position after the screen 
is updated. New block icons are added in the top left corner of the screen. 
Note that adding new block icons may cause icons to overlap.
Block icons to be deleted are removed from the screen. Their position in the screen remains 
unoccupied.

● Check box selected
The block icons for the selected diagnostic area are repositioned automatically.
All block icons are repositioned.

Note

This function is available if you configured the Maintenance Station in the MS Standard version.

Requirement
The Maintenance Station has been created.

Procedure
1. Open the plant view in the SIMATIC Manager.

2. Select the object in the tree view:

– If you are using a multiproject, select the object "[name of the project] MP".

– If you are using a single project, select the object "[name of the project]".

3. Select the menu command Options > Plant Hierarchy > Advanced Diagnostics Settings....
The "Advanced Diagnostics Settings" dialog box opens.

4. Select the "Other settings" tab.

5. Select the desired diagnostic area.

6. Click "OK".
These settings are saved retentively.

Result
When the "Create/update diagnostic screens" function is executed, the block icons for the 
selected diagnostic area are repositioned automatically.
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After OS compilation and subsequent download, the changes are applied in the process 
control.

Additional information
You can find additional information in the section "Creating/updating the diagnostic screens 
(Page 80)"

5.11.2.2 Storage location for the files of the (filtered) total export

Introduction
In the "Storage location for the files of the (filtered) total export" area of the "Other settings" 
dialog, you specify the user-specific storage location for the files of the (filtered) total export.

The user-specific target directory can be configured as an absolute or relative path.

Path Example of a storage path Storage location
Absolute path D:\folder On the MS server(s) in the con‐

figured path 
Relative path \\computer name\shared drive

\folder
On the specified computer in the 
configured path

In a redundant system, the total export file is saved on the MS server and on the redundant 
partner when using an absolute path.

Requirement
The Maintenance Station has been created.

Procedure
1. Open the plant view in the SIMATIC Manager.

2. Select the object in the tree view:

– If you are using a multiproject, select the object "[name of the project] MP".

– If you are using a single project, select the object "[name of the project]".

3. Select the menu command Options > Plant Hierarchy > Advanced Diagnostics Settings....
The "Advanced Diagnostics Settings" dialog box opens.

4. Select the "Other settings" tab.

5. Specify the storage location for the files of the (filtered) total export.

6. Click "OK".
These settings are saved retentively.
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Result
After OS compilation and subsequent download, the setting is applied in the process control 
and saved in the "@ExportPath" tag.

Files of the (filtered) total export are additionally stored at the specified storage location.

5.11.2.3 Navigation information in the screen

Introduction
In the "Navigation information in the screen" area of the "Other settings" dialog, you specify 
whether and at which location the path will be displayed within the plant hierarchy in the 
diagnostic screen in the process control.

The path can be displayed at the following positions in the diagnostic screen:

● Top left

● Top center

● Top right

● Bottom left

● Bottom center

● Bottom right

The overview screen of the diagnostic screens is not affected by these settings.

Note

This function is available if you configured the Maintenance Station in the MS Standard version.

Requirement
The Maintenance Station has been created.

Procedure
1. Open the plant view in the SIMATIC Manager.

2. Select the object in the tree view:

– If you are using a multiproject, select the object "[name of the project] MP".

– If you are using a single project, select the object "[name of the project]".

3. Select the menu command Options > Plant Hierarchy > Advanced Diagnostics Settings....
The "Advanced Diagnostics Settings" dialog box opens.

4. Select the "Other settings" tab.

5. Select the "Display" check box.

6. Select the position for the display of the path in the diagnostics screen.
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7. If you want to have the block icons repositioned, select the "Re-position block icons" check 
box.

8. Click "OK".
These settings are saved retentively.

Result
When the "Create/update diagnostic screens" function is run, the associated path will be 
displayed in the diagnostic screens at the selected position.

After OS compilation and subsequent download, the changes are applied in the process 
control.

Note

If block icons and path information overlap in the diagnostic screens, use the "Re-position 
block icons" option.

5.12 Configuring the display of maintenance information

Introduction     
This section describes the configuration steps for displaying the maintenance information in 
the process control.

Requirement
● The maintenance information has been created.

You can find information on this in the section "Configuring maintenance information 
(Page 61)".

● Channel blocks of the Advanced Process Library are applied (in PCS 7 V8.2 or higher).

Procedure
1. Activate "Feature.Bit10" on the channel block.

2. Interconnect the "MS_Ext" input on the channel block with the signals of the external 
maintenance state of the user program.
You can use the "MSTOu" converter block for this.

3. Interconnect the "Text_Ref" input on the channel block with the signals you use for 
displaying the external diagnostic information.
You can use the "BO_W" converter block for this.
The individual bits of the "Text_Ref" input activate the state display in the faceplate in the 
"External diagnostics" view in process mode.
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Note
Maintenance demanded and maintenance required

Note that only the external maintenance statuses "Maintenance demanded" (corresponds to 
significance 6) and "Maintenance required" (corresponds to significance 5) are taken into 
account in the diagnostics block.

These maintenance statuses trigger the messages "Maintenance demanded (external)" and 
"Maintenance required (external)" in the process control.

Note
Multiple channel blocks for HART modules

When HART modules and secondary variables are used, you use multiple channel blocks for 
the same channel of the module.

The above-mentioned procedure must be performed for each channel block.

Result
After AS and OS compilation and subsequent download, the maintenance information is 
displayed in the process control.

Additional information
You can find additional information on displaying maintenance information in the section 
""External diagnostics" view (Page 175)".

5.13 Configuring the user diagnostics

5.13.1 Overview

Introduction
Passive or indirect components without self-diagnostics (for example,  pumps, motors, control 
loops) can be monitored with the help of the user diagnostics. A "user" area is created within 
the diagnostic structure for this purpose.   

You can perform the following tasks in the "user" area:

● Creating individual diagnostic structures

● Creating project-specific diagnostics rules

● Configuring condition monitoring functions
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Note

You can use the user diagnostics in the MS Standard version only.

User diagnostic structure
In the plant hierarchy, you can create one other hierarchy folder under the "Diagnostics" 
hierarchy folder and additional hierarchy subfolders under this hierarchy folder to build a user 
diagnostic structure based on technological aspects.

In the user diagnostic structure, you can insert one self-created diagnostic screen and CFC 
charts for each hierarchy folder. 

You can incorporate buttons into the diagnostic screens for switching between the user-created 
and automatically created diagnostic screens.

The diagnostics functions are performed with different blocks, for example AssetM, which are 
integrated in the CFC charts.

Diagnostic function with the AssetM block
The "AssetM" block has the function of a substitute object and is used for monitoring 
components without self-diagnostics.

You can use the "AssetM" block to monitor three analog values.

Each analog value can be monitored for limits. 

The maintenance status is defined on the basis this limit, demanded or alarm defined 
(implementation of traffic light function in accordance with NE 107 of NAMUR).

The following functions are also available to you here:

● 7 inputs for reporting a corresponding maintenance status

● 16 inputs for displaying detailed diagnostics information

● 1 input for the maintenance status

● 1 input for the signal status

Cascading the signal status of process values
By using the "MuxST" multiplex block, you can interconnect the signal status of different 
process values weighted to the "AssetM" block. The signal status with the highest priority is 
shown in the faceplate in process mode.

The signal status must correspond to the PA profile 3.x.

Cascading the maintenance status
By using the "MuxMST" multiplex block, you can interconnect the maintenance status of 
different "AssetM" blocks to a higher level "AssetM" block. The maintenance status with the 
highest priority is shown in the faceplate in process mode.
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5.13.2 How to create the user diagnostic structure

Introduction
You create the user diagnostic structure in the project with the AS and the project with the 
maintenance station. If the AS and the maintenance station are in different projects of a 
multiproject, configure the CFC charts in the project with the AS for the user diagnostic area 
and, in the project with the maintenance station, configure the OS pictures for the user 
diagnostic area. The user diagnostic area must be created in both projects.

Requirement   
The diagnostic structure has been created.

Procedure
1. Open the plant view in the SIMATIC Manager.

2. In the plant hierarchy, select a project for which you wish to create a user diagnostic 
structure.

3. In the tree view, select the diagnostic hierarchy folder directly below which the "AS objects" 
hierarchy folder is located.

4. Select the menu command Insert > Technological Objects > Hierarchy Folder.

Note

There may only be one hierarchy folder created for the user diagnostic structure under the 
"Diagnostics" hierarchy folder.

5. Mark the hierarchy folder in the detail view and select the menu command Edit > Rename.

6. Enter a unique name that is as short as possible and confirm with the Enter key.
The name is applied.
You can create additional hierarchy subfolders below this hierarchy folder.

Note

Note that a maximum of 128 characters are allowed for the length of tag names.

You can find additional information about this in the manual Process Control System PCS 7; 
Operator Station.

7. If you have not created the user diagnostic structure in the project of the MS server, you 
must update the plant hierarchy.
You can find additional information about this in the section "How to update the user 
diagnostic structure (Page 74)".
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5.13.3 How to create a CFC chart and insert an AssetM block

Introduction
The "AssetM" block is used to monitor user-specific sections of the plant. This block is 
integrated into a CFC chart. Multiple blocks can be integrated into a CFC chart.

Requirement   
The user diagnostic structure has been created.   

Procedure
1. In the tree view, select the hierarchy folder in which you are creating a CFC chart.

2. Select the menu command Insert > Technological Objects > CFC.
A new CFC chart is created.

3. Select the CFC chart in the detail view.

4. Select the menu command Edit > Rename.
Enter a unique name that is as short as possible and confirm with the Enter key. The name 
is applied.

Note

Note that a maximum of 128 characters are available for tag names.

For more information on this, refer to the Process Control System PCS 7; Operator 
Station manual.

5. Mark the CFC in the detail view and select the menu command Edit > Open Object.

6. Select the "AssetM" block from the PCS 7 Advanced Process Library and drag it into the 
CFC.

7. Interconnect the signals, which are to be displayed via the PCS 7 maintenance station, 
using the "AssetM" block.
You will find additional information on the "AssetM" block in the Online Help for the block.

8. Execute steps 1 to 7 if you want to create additional CFCs.

Additional information
Additional information on this is available in the Process Control System PCS 7; 
Engineering System manual.
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5.13.4 Assigning parameters for the AssetM block

Overview     
After the AssetM block has been placed in the CFC, interconnect the parameters that are to 
be used. 

In order to display information in the faceplate from SIMATIC PDM for the monitored 
component during process control, a SIMATIC PDM object must be created for each AssetM 
block in the process device plant view. 

This SIMATIC PDM object saves the rating plate (identification data) and the diagnostic texts. 
The "AssetMon" device is assigned to the SIMATIC PDM object.

The PLT ID is a connection parameter between a SIMATIC PDM object (parameter data EDD) 
and the faceplates in the Maintenance Station. 

The PLT-ID is linked to the SIMATIC PDM object.

Procedure
The PDM object is created in SIMATIC Manager as follows:

1. Select View > Process Device Plant View in SIMATIC Manager.

2. Select a project in SIMATIC PDM in which you want to insert the SIMATIC PDM object.

3. Select File > New object.

4. Select the inserted object with the right mouse button.

5. Select Device selection (Reassign)... in the shortcut menu.

6. In the tree structure, select Devices > DATA_OBJECTS > CFC > Siemens AG > 
AssetMon.

7. Click OK.

8. Select the object with the right mouse button.

9. Select Open object in the shortcut menu.

10.Enter all required data in the parameter assignment mask.

11.Select File > Save and close the parameter assignment mask.

12.Enter the generated PLT ID for the associated "PLT ID" block parameter.

Note

The PLT ID cannot be changed or deleted.

Additional information
You can find additional information on the AssetM block in the manual Process Control System 
PCS 7; Advanced Process Library.
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5.13.5 How to update the user diagnostic structure

Introduction
The following steps are only required if you have created a user diagnostic structure in a 
location other than the MS server project.   

You have to update the plant hierarchy in the multiproject.

Procedure
1. In the "plant hierarchy", select the project for which you have created a user diagnostic 

structure.

2. In the shortcut menu, select the menu command Plant Hierarchy > Update in Multiproject.
The "Plant Hierarchy - Update in Multiproject" dialog box opens.

3. Click "OK".
The "Plant Hierarchy - Update in Multiproject (target projects)" dialog box opens.

4. Enable the check box for the MS server's current project.

5. Click "OK".

6. Perform steps 1 to 6 for all the projects in a multiproject for which you have created a user 
diagnostic structure.

Result
The user diagnostic hierarchy of the other projects is added to the plant hierarchy in the project 
of the MS server.

5.13.6 How to Create User Diagnostic Screens

Introduction   
You create the user diagnostic screens in the hierarchy folders of the user-specific diagnostic 
structure in the project. In an MS single station system, this is the MS project. In an MS multiple 
station system, it is the MS server project.

You can create one user diagnostic screen per hierarchy folder.

Requirements
● The user diagnostic structure has been created.

● The CFCs for the user diagnostic structure have been created.

● A multiproject update is performed for multiprojects.
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Procedure
1. Open the plant view in the SIMATIC Manager.

2. In the tree view, select the hierarchy folder for which you want to create the user diagnostic 
screen.

3. Select the menu command Insert > Technological Objects > Picture.

4. Enter a unique name that is as short as possible and confirm with the Enter key.
The name is applied.

5. Click "OK".

6. Select the picture in the detail view and select the menu command Edit > Object 
properties... .

7. Select the "Block icons" tab.

8. Select the "Derive icons from the plant hierarchy" check box.

9. Repeat steps 2 through 9 for all hierarchy folders into which you wish to insert user 
diagnostic screens.

5.13.7 How to create the group display hierarchy for the user diagnostics

Introduction   
You will need to refer to the information in this section if you have added a user-specific 
diagnostic structure to the diagnostic structure.

Requirement
The WinCC project is opened:

● In an MS single station system, this is the WinCC project of the MS.

● In an MS multiple station system, it is the WinCC project of the MS server.

Procedure
1. In the WinCC Explorer tree view select the "Project Editor".

2. Open the shortcut menu and select the menu command Open.
The "OS Project Editor" dialog box opens.

3. Select the "Message Representation" tab.

4. Enable the "Create/Update Group Displays" check box in the "Group display hierarchy" 
group.

5. Click "OK".
The group displays for the hierarchy calculation are automatically inserted into the screens 
when the hierarchy is saved, the OS is compiled or the OS is downloaded. 
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5.14 Setting up SIMATIC PDM

Overview      
If you have configured devices with SIMATIC PDM, the following requirements must be met 
on the engineering station for visualization in the process control.

● Installation
The SIMATIC Process Device Manager (SIMATIC PDM) add-on package (requires a 
license) is installed.

● In the Windows Control Panel

– The Microsoft Internet Information Server (IIS) with ASP.NET support is installed.

– The rule in the firewall is enabled.

– The SIMATIC PDM users are added to the Logon_Administrator Windows group.

● In the Windows Start menu

– The SIMATIC PDM Web server is configured.

● In SIMATIC Manager:

– A PDM application is inserted in the PC station of the engineering station.

– In the SIMATIC PDM "Settings..."
The path to the maintenance project is entered on the "Maintenance Station" tab.
For multi-user engineering with several engineering stations, the path must be entered 
for each engineering station.

– In the SIMATIC PDM "Role management..."
All Windows users who use SIMATIC PDM Web are assigned the "Service user" role.

Additional information
You can find information about this in the following documents:

● Online Help for SIMATIC PDM
● Manual Process Control System PCS 7; Help for SIMATIC PDM

5.15 Overview of complete export

Overview

Note

You use this function in process control if you are using the MS Standard or SIMATIC PDM MS 
version of the maintenance station.

Identification data from all diagnostics-capable components (such as field devices, PCs, AS 
components, network components) can be exported.     
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With complete export, the data from all the components with diagnostics functionality is 
exported to the export file "@XML_Export.sml".

The complete export file is stored in the default target directory on the MS in the "AssetExport" 
folder of the OS project directory.

The complete export file is stored on both partners in a redundant system.

The complete export file can also be stored in a configured target directory (e.g., for reuse of 
the data in external systems). 

You can find information on this in the section "Storage location for the files of the (filtered) 
total export (Page 66)".

In the process control, the system allows you to display the data of the last complete export 
in filtered form and to export this data.

Additional information
You can find additional information about displaying and exporting the data in process control 
in the section "Functions in the overview screen (Page 97)".

5.16 Overview of individual export

Overview  

Note

You use this function if you are using the MS Standard or SIMATIC PDM MS version of the 
maintenance station.

Data of a diagnostics-capable component (such as field devices, PCs, AS components, 
network components) can be exported.     

During an individual export, the data of a diagnostics-capable component is written to an export 
file.

The file name is automatically generated by the system.

The individual export file is stored in the default target directory on the MS in the "AssetExport
\Out" folder in the OS project directory.

The individual export file is stored in the standard target directory on the connected OS server 
(current preferred server) in a redundant system.

The individual export file can also be stored in a configured target directory (e.g. for reuse of 
the data in external systems). 

You can find information on this in the section "Configuring maintenance targets for individual 
export (Page 56)".
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Structure of the file name
The name of the export file is structured as follows:

"<Tagname>_<AssetID>_YYYY_MM_DD_HH_MM_SS_SSS.XML"

Structure of the file name Description
<Tagname> Configured name of the component (see rating plate)
<AssetID> Unique, system-assigned identification number of the component
YYYY_MM_DD_HH_MM_SS_SSS Date and time of the export
xml File type 

Additional information
You can find additional information about displaying and exporting the data in the process 
control in the section ""Maintenance" view (Page 146)".

5.17 Engineering for maintenance

5.17.1 Engineering for release request

Introduction
You must make interconnections on the blocks in the CFC chart for the release request.

We recommend that the configuration steps be taken into consideration when the typicals are 
created.

Requirement
● The CFC typicals have been created.

● The PCS 7 Advanced Process Library V8.2 or higher is used.

Procedure
1. Open the CFC typical.

2. Interconnect the output parameter MS_Req of the channel block with a free input parameter 
ExtMsg of the technological block.

3. Change the message class of the utilized external message on the technological block to 
the message class not requiring acknowledgment "Request for operator input - General".

4. Adapt the event text as desired.

You can connect the release request signals of multiple channel blocks to the technological 
block with an OR operation.
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Result
The release request "Sequence for maintenance (Page 191)" can be used.

After AS and OS compilation and subsequent download, the changes are applied in the 
process control.

Compile and download the OS in which the technological block will be displayed.

Additional information
You can find additional information on maintenance in the section "Overview of maintenance 
(Page 189)" and in the manual Process Control System PCS 7; Advanced Process Library.

5.17.2 Engineering for maintenance release

Introduction
You must make interconnections on the blocks in the CFC chart for the maintenance release.

We recommend that the configuration steps be taken into consideration when the typicals are 
created.

Requirement
● The CFC typicals have been created.

● The PCS 7 Advanced Process Library is used.

Procedure
1. Open the CFC typical.

2. Interconnect the output parameter MS_Release of the technological block with the input 
parameter MS_Release of the channel block.
You can interconnect the maintenance release of a technological block to multiple channel 
blocks.

3. Interconnect the output parameter OosAct of the channel block with the input parameter 
OosLi of the technological block.
You can connect the "In Service" information (OosAct) of multiple channel blocks to the 
technological block with an OR operation.

4. Use the feature bit "Reaction to the out of service mode" to define the desired behavior of 
the technological block.

Result
The maintenance release "Sequence for maintenance (Page 191)" can be used.

After AS and OS compilation and subsequent download, the changes are applied in the 
process control.
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Compile and download the OS in which the technological block will be displayed.

Additional information
You can find additional information on maintenance in the section "Overview of maintenance 
(Page 189)" and in the manual Process Control System PCS 7; Advanced Process Library.

5.18 Creating/updating the diagnostic screens

Introduction
The diagnostic screens in the diagnostics area with their block icons are created or updated 
with this function.

The "@@maintenancetypicals.pdl" file contains all the templates for block icons which are 
used to display the diagnostic information.     

If you execute the "Create/update diagnostic screens", PCS 7 automatically uses block icons 
from this file. This file is installed as standard during the installation of PCS 7.

You can customize block icons to your specific requirements. 

Note

If you want to customize the standard block icons included in the @@maintenancetypicals.pdl 
file, do not change this file. All changes in this file are overwritten by an update.

Always create a new file. The name of the file starts with the fixed name component 
"@maintenancetypicals". You can specify the rest of the file name yourself. Insert the required 
block icons there and customize them.

The process is exactly the same as for adapting the standard block icons.

You can find additional information about this in the section "Example: Creating object 
templates" in the WinCC Information System online help.

You can find additional information on positioning block icons in the section "Automatic 
positioning of block icons in the areas (Page 64)".

Requirements     
The configuration must have the following status:

● The settings relating to the diagnostic structure have been made.
You can find information on this in the section "How to make the settings in the plant 
hierarchy (Page 50)".

● The "Language for display devices" is set as the default language in the SIMATIC Manager. 
Texts displayed during process control are generated in this language.

● When you use SIMATIC PDM, the maintenance project is configured in the settings for the 
SIMATIC PDM project.
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Procedure
1. Open the SIMATIC Manager and activate the plant view.

2. Select the required hierarchy folder in the tree view.

– If you want to create diagnostics screens for the multiproject/project, select the 
multiproject/project.

– If you wish to create diagnostic screens for certain hierarchy folders, select the required 
hierarchy folder in the maintenance station.

3. Select the Options > Plant Hierarchy > Create/Update Diagnostics Screens menu 
command.

4. If you have already compiled the AS charts, no other dialog box is opened, and the 
diagnostic screens are created/updated directly.
Proceed to step 6.

5. If you haven't compiled the AS charts yet, the "Create module drivers" dialog box is opened 
one after another for every CPU for which this function has not been executed yet. 
Click "OK" in all dialog boxes to create the required diagnostic blocks.

Note

If you click "Cancel" in this dialog box, no module drivers are created for this CPU, and the 
diagnostic screens are not updated!

6. The "Create/update diagnostic screens" dialog box opens after the completion of the 
generation process.
Click "Yes".
The function log is displayed in the "WordPad" editor. If error messages appear, rectify the 
errors and run the function again.

7. Close the "WordPad" editor.

Result
The diagnostic screens are created or updated.

After OS compilation and subsequent download, the diagnostic screens are displayed in the 
process control.

Displaying a log of the diagnostic screens   
In the SIMATIC Manager select Options > Plant Hierarchy > Diagnostics Screen Log.

The diagnostic screen log contains information about the creation of the diagnostic screens.
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5.19 Compiling and downloading

5.19.1 Compilation and downloading of the Maintenance Station

Compiling and downloading an MS single station system or multiple station system
● Compile    

The diagnostic screens you generated or updated must be compiled and downloaded to 
the maintenance station.
Before you compile the maintenance station, the diagnostic screens have to be created at 
least once or updated after configuration changes.
"Area-oriented" must be set as OS compilation mode.
In an MS single station system, compile the MS.
In an MS multiple station system, compile the MS server.

Note

Clear the "Picture Tree" check box in the dialog for OS compilation if you do not want to 
derive the hierarchy from the plant areas.

The hierarchy for the diagnostic area is created even if the check box is cleared.

● Downloading    
Perform the download after the compilation.
If you are using an MS multiple station system, load the MS server.
If you are using a redundant MS multiple station system, download the MS server and the 
redundant partner.
You must not download an MS single station system.

5.19.2 Compiling and downloading SIMATIC PDM MS

Requirements
● Configuration in the process device network view has been completed.

● The parameter view for all field devices has been opened once.

● The "Create/update diagnostics screens" function has been executed.

● The project is open in SIMATIC Manager.
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Procedure 

Compiling and downloading charts
1. Select the "Charts" hierarchy folder in the component view of SIMATIC Manager.

2. Select the Edit > Compile menu command.

3. Select the following check boxes:

– Entire program

– Generate module drivers

Download WinLC RTX
1. Select the PC station in the component view of the SIMATIC Manager.

2. Select the menu command PLC > Download.

Compiling OS
1. Select the OS hierarchy folder in the component view of SIMATIC Manager.

2. Select the Edit > Compile menu command.

3. Select the following check boxes:

– Entire OS

– With memory reset

Download OS
The OS for SIMATIC PDM MS does not have to be downloaded.

5.20 Server data and downloading of a client

Server data
Before an MS or OS/MS client is downloaded,  it must be assigned the relevant OS server. 
This loads the server data to the MS or MS/OS client project.

Client Server data (server package)
MS server OS servers

whose automation systems are being 
monitored

OS server
whose OS area is dis‐
played

MS client on an engi‐
neering station

X X -

MS client on a sepa‐
rate PC station
OS/MS client X X X
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Downloading
The MS client or OS/MS client is downloaded in exactly the same way as an OS client. The 
MS client in the engineering station does not have to be downloaded.

Additional information
Additional information is available in the manual Process Control System PCS 7; Operator 
Station in the sections "Downloading the server data" and "How to compile and download 
several operator stations".

5.21 Changes in the project

Change in the version
You change the version in the SIMATIC Manager in the plant hierarchy settings. You can find 
additional information about this in the section "How to make the settings in the plant 
hierarchy (Page 50)"

If you change the version of the maintenance station, you must observe the following:   

● MS Standard to MS Basic

– The diagnostic structure below the AS objects, the diagnostic structure of the field 
devices and the user diagnostic structure including the contained pictures are deleted.

● MS Basic to MS Standard

– The diagnostic structure of the AS objects is regenerated.

– The diagnostic structure of the field devices is created.

● MS Standard to SIMATIC PDM MS

– The diagnostic structure of the AS objects including the contained pictures is deleted.

– The diagnostic structure of the field devices is regenerated.

● SIMATIC PDM MS to MS Standard

– The diagnostic structure of the field devices including the contained screens is 
regenerated.

– The diagnostic structure of the AS objects is generated.

● MS Basic to SIMATIC PDM MS

– The diagnostic structure of the AS objects including the contained pictures is deleted.

– The diagnostic structure of the field devices is created.

● SIMATIC PDM MS to MS Basic

– The diagnostic structure of the field devices and the user diagnostic structure including 
the accompanying screens are deleted.

– The diagnostic structure of the AS objects is generated.
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After changes, you may have to perform the following tasks:

● Creating/updating the diagnostic screens (Page 80)

● Compilation and downloading of the Maintenance Station (Page 82)

● Server data and downloading of a client (Page 83)

Changes in HW Config
Changes in the hardware configuration of the engineering system affect the displays in the 
diagnostic screens.

After changes, perform the following tasks:

● Creating/updating the diagnostic screens (Page 80)

● Compilation and downloading of the Maintenance Station (Page 82)

Add OS server
Perform the following tasks if an OS server is added after creation of the diagnostic structure 
in the multiproject/project:

● Assign OS server server data to the MS server
You can find more information on this topic in the Process Control 
System PCS 7; Operator Station manual in the section "How to load server data".

● Load MS server
You can find additional information about this in the section "Compilation and downloading 
of the Maintenance Station (Page 82)". 

Subsequently defining OS server as MS server
If an OS server is defined at a later point in time as MS server in a plant in operation, you need 
to perform not only the configuration tasks described for the MS server but also a download 
for the OS client, which assumes the role of the OS/MS client.

For additional information on downloading, refer to the section "Server data and downloading 
of a client (Page 83)".
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Changes in the software   
● Change the standard message server for the "Alarms" component

If the assigned standard message server for the "Alarms" component is changed in a plant 
configuration in a multiple-station system with an OS client, the MS server then has to be 
compiled and downloaded.
You can find additional information about this in the manual Process Control System PCS 
7; Operator Station in the section "How to assign the standard server".

● Change the screen resolution
If the screen resolution is changed in the "Available Layouts:" group on the "Layout" tab of 
the OS project editor, the next time "Create/Update Diagnostic Screens" is called, the 
available overview screen is renamed and a new overview screen that corresponds to the 
new screen resolution is created. A respective message is included in the log of the function 
"Create/Update Diagnostics Screens". This also provides the new name of the former 
overview screen.
If you have manually changed the overview screen, you can manually carry out the changes 
in the current overview picture by copying from the former overview screen.
All other existing diagnostic screens retain their screen resolution. If the images are created 
in a new screen resolution, you must manually delete the screens. User-specific changes 
will be lost.

Changing the storage location of a subproject
If you change the storage location of a subproject with the "Save As" function, you must stop 
the SIMATIC PDM Asset Service before performing the "Save As" operation.

When the "Save As" operation is finished, you must restart SIMATIC PDM Asset Service.

5.22 Deleting the diagnostics area

Introduction
During deletion of the diagnostic structure, the following is deleted:

● Diagnostics hierarchy folder with all subfolders

● Target objects

● Action objects

● Link objects

Requirement   
● The diagnostic structure and/or user diagnostic structure has been created.

Note

If you have manually changed diagnostic screens, make sure that you make a backup copy 
before deleting, because all changes will be lost after deleting and recreating the diagnostic 
structure.
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Procedure
1. Open the plant view in the SIMATIC Manager.

2. Select the object in the tree view:

– If you are using a multiproject, select the object "[name of the project] MP".

– If you are using a single project, select the object "[name of the project]".

3. Select the menu command Options > Plant Hierarchy > Settings... .
The "Plant Hierarchy - Settings" dialog box opens.

4. Proceed as follows if you have selected a multiproject:

– Click "OK". 
The "Plant Hierarchy - Settings" dialog box opens.

– Proceed to step 6.

5. If you have selected an individual project or a project within a multiproject, the "Plant 
Hierarchy - Settings" dialog box opens.

6. Disable the "Derive diagnostic screens from the plant hierarchy" check box.

7. Click "OK".

Note

The complete diagnostic structure and all the diagnostic screens are deleted, including the 
user diagnostic structure.

The charts with the diagnostic blocks and the charts of the user diagnostics are not deleted 
during this process; they remain in the chart folders for the S7 programs.

8. Compile the OS.

9. In an OS multiple station system, download the OS server.
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Operator control and monitoring 6
6.1 Starting the process control

MS Standard and MS Basic     
The start of the process control of a maintenance station is the same as the start of the process 
control of an Operator Station.

When an MS multiple station system and SIMATIC PDM are used, the engineering station 
must be switched on and the SIMATIC PDM Asset Service started for the SIMATIC PDM device 
data to be provided.

SIMATIC PDM MS
Before activating process control, check the setting for the WinCC project type in WinCC 
Explorer. A single station project must be set as the project type.

Activate process control in WinCC Explorer using the "Activate" icon.

OS simulation
You can only use the OS simulation function in the MS Standard or MS Basic version.

OS simulation for a PCS7 maintenance station in MS Standard and MS Basic is possible only 
to a limited extent (for example, no identification or diagnostics data).
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6.2 Layout of the user interface

User interface in the process control   
The user interface is structured in the same way as the Operator System interface. It is divided 
into 3 areas: 

● Overview area (Page 91)
The overview area is displayed permanently. Its group displays for the various plant areas 
and the message line provide an overview of the entire plant.
Display and operator control in the overview area is the same as display and operator 
control in an OS.
If deviations exist, the document points this out.

● Working area (Page 94)
In the working area, the overview screen, the area overview screens and the diagnostic 
screens of the individual components are displayed for the diagnostics area.

● Button area (Page 94)
The button area is displayed permanently. It comprises several button sets between which 
the maintenance engineer (operator of the "Diagnostics" area) can switch. 
The keys in the button sets are operated in the same way as the keys in an OS. 
If deviations exist, the document points this out.

The following figure shows an example of the user interface:
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Additional information
You can find additional information on this in the manual Process Control System PCS 
7, OS Process Control.

6.2.1 Overview area

Display in the overview area
The following figure shows an example of the overview area:     

This section describes only the icons that are specific to the maintenance station.

"Highest priority messages" icon list
If at least one message with Priority 16 is active (incoming or incoming acknowledged state), 
the icon is displayed. This priority is predefined by the system for emergency operation of an 
AS. 

To display the "Highest priority messages" list, click the icon.

Icon Function Permission
"Highest priority messag‐
es" list is called

Enable for the diagnostics area

In addition to the display of the icon, an AS process control message without area information 
is generated. The message comes in as soon as at least one highest priority message in the 
"Diagnostics" area has come in.

As soon as all highest priority messages in the "Diagnostics" area have gone out, the message 
without area information is assigned the status "outgoing".

For more information on configuration of the message priority see the manual Process Control 
System PCS 7; Operator Station.

Sum status of the plant
The plant operator obtains an overview of the statuses of the individual areas from the 
"Diagnostics" area.

The icons are displayed on each operator station regardless of whether the "Diagnostic" area 
is assigned to this operator station.

The following cases are exceptions to this:

● OS single-station projects

● All operator stations of a project if the maintenance station is an OS single-station project.
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The following table shows an example of the assignment of the icons to their area and 
describes the possible statuses that each icon can have.

Display Area State
PC stations ● Gray:

There is no problem in the area.
● Yellow:

There is at least one maintenance 
demand in the area.

● Red:
There is at least one maintenance alarm 
in the area.

● Yellow/red:
There is at least one maintenance 
demand and one maintenance alarm in 
the area.

● Blue:
There is no connection to the MS server.

 

Network objects

AS/system

Note

If no maintenance group display is created for an area in the overview screen of the 
"Diagnostics" area, the corresponding icon is also not created. 

Messages without area information regarding maintenance state
The system generates AS process control messages without area information regarding the 
maintenance state of components.

These messages are displayed on every OS station:

● In the single message line of the overview area

● In the message lists

It does not matter whether the "Diagnostics" area is shown on the operator station or not.

If at least one component has the state "maintenance alarm/demand" in one of the diagnostics 
areas (PC stations, network objects, AS/system), a message without area information of the 
same message type is also generated for this area.

When no more components have the state "maintenance alarm/demand", the message without 
area information is assigned the status "outgoing".
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The following table shows the messages without area information:

Message 
type

Priority Message text

Fault  0 ● Maintenance alarm in the PC stations area of MS
● Maintenance alarm in the network components area of MS
● Maintenance alarm in the AS system area of MS

Error  0 ● Maintenance demanded in the PC stations area of MS
● Maintenance demanded in the network components area of MS
● Maintenance demanded in the AS system area of MS

Area key for the diagnostics area
The following figure shows an example of the area key for the diagnostics area:

The area key is used to open the overview screen for the diagnostics area.

Navigation through the picture hierarchy is similar to navigation through the picture hierarchy 
of the OS areas.

Group display for the diagnostics area
In addition to the area key, the current message state is displayed on the third button of the 
group display of the entire diagnostics area.

The lower-level area overview screen is called via the group display.

The following table shows default system settings for the possible states:

Display Message type/state Priority Message state
Message is locked (1) 1 -

AS process control fault 2 ● "S" display
● Flashing

Incoming message
● Static

Message acknowledged
AS process control error 3 "F" display

● Flashing
Incoming message

● Static
Message acknowledged
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Display Message type/state Priority Message state
Maintenance demanded 4 "M" display

● Flashing
Incoming message

● Static
Message acknowledged

No message is pending 5 -

The number in the priority column indicates the priority of the display. The lowest number has 
the highest priority. 

Note that unacknowledged messages have a higher priority than acknowledged messages.

(1) At least one message is locked. Messages can only be locked for components from the 
AS/system, user objects, and field devices areas.

6.2.2 Button area

Representation of the button area
The figure below shows an example of a button set from the button area.     

This section describes only the icons that are specific to the maintenance station.

Locking/unlocking messages       
If a screen is open within an AS in the AS/System and Field devices area, messages can be 
locked or unlocked for the components shown in this screen and their subordinate components.

If a screen is open below the overview screen in the User objects area, messages can be 
locked or unlocked for the components shown in this screen and their subordinate components.

This function is not available in the PC stations and Network objects areas. 

You can find additional information about locking/unlocking messages in the section: "How to 
lock and unlock messages (Page 137)".

6.2.3 Working area

Display in the working area
The diagnostic screens are displayed hierarchically in the working area.     

You usually get from the overview to the detail via the hierarchy.

You can also change the screen via the hierarchy buttons in the button set.
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The overview screen is the highest hierarchy level. You get to the respective area overview 
screen via the maintenance group displays of an area.

The components are displayed as block icons in the area overview screen. 

The working area also displays faceplates, operator control windows, message lists and dialog 
windows.

Navigation information can be displayed in the diagnostic screens. You can find information 
on configuring in the section "Navigation information in the screen (Page 67)".

Additional information
You can find additional information in the following sections:

● Overview screen (Page 95)

● Area overview screens (Page 117)

● Block icon (Page 119)

● Faceplate (Page 131)

6.3 Overview screen

Introduction
The maintenance engineer gets an overview of the plant status of the entire plant in the 
overview screen. 

A maintenance group display is displayed in each area if there is at least one screen for this 
area. The areas are shown in color as shown below: 

● PC stations (on a yellow background)

● Network objects (on a green background)

● AS/system (cyan background)

● Field devices (cyan background)

● User objects (on a light blue background)

The following figure shows an example of the overview screen for the diagnostics area:   
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Calling the overview screen
You call the overview screen as follows:

● Area button

● Group display in the overview

● Picture Tree Navigator

● Navigation buttons in the button set

Maintenance group display in the overview screen
The maintenance group display gives maintenance engineers an overview of the plant status 
of the individual area.

You can change to the area screen from the maintenance group display.

The following table shows the possible states:

Display Message class/status Message status
Message is locked (1) -

AS process control fault/
maintenance alarm

"S" display
● Flashing

Incoming message
● Static

Message acknowledged
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Display Message class/status Message status
AS process control error/
maintenance demanded

"F" display
● Flashing

Incoming message
● Static

Message acknowledged
Preventive maintenance/
maintenance required

"M" display
● Flashing

Incoming message
● Static

Message acknowledged
No message is pending -

(1) At least one message is locked. Messages can only be locked for components of the areas 
AS/system, user objects and field devices.

6.4 Functions in the overview screen

6.4.1 Overview

Functions in the overview screen 
The following functions can be executed in the overview screen:

● Calling web pages via maintenance links

● Complete export

● Filter function

● Message correction for components with SNMP functionality

● Parameter data export of EDD-based devices

You can find additional information about this in the following sections.

6.4.2 Calling web pages via maintenance links

Introduction
Up to 10 Web pages that are used to provide support for diagnostics measures can be called. 
The icons are displayed when the calls are configured.   

The first 3 icons are also displayed in the header of the faceplate.
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Requirements
● The maintenance station is available in the MS Standard version.

● The maintenance target (web address) has been configured.

● The maintenance target can be accessed via the network.

Icon in the user interface

Icon Function Permissions

to

Display of the Web page
Tooltip text: Name of the 
maintenance link

"Higher process controlling" for diagnostics area

Procedure
1. Click on the icon.

Result
The web page is displayed in a screen window.

Additional information
You can find information on configuring in the section "Configuring maintenance links 
(Page 54)".

6.4.3 Complete export

Introduction     
The complete export is used to export data of all the objects with diagnostics functionality (for 
example, field devices, PCs, and network components). 

This file forms the basis for the filtered complete export.

Icon in the user interface

Icon Function Authorizations
Trigger complete export "Process controlling" for the diagnostics area
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Procedure
1. Click on the icon.

Result
The complete export is executed. 

The information is saved to the file "@XML_Export.sml".

Additional information
You can find information on configuring in the section "Overview of complete export 
(Page 76)".

6.4.4 Filtering the data of the complete export

Introduction     
The system allows you to display the data of the last complete export filtered and to export 
this data.

The filter function is available if it your plant is not operated via a PCS 7 Web client.  

A complete export is performed automatically when this function is used.

Various filter criteria are available for filtering data.

Icon in the user interface

Icon Function Permissions
Filter device status
● Call filter view
● Filtering data

"Process controlling" for the diagnostics 
area

Procedure
1. Click on the icon.

Result
The filter view is called.

The following figure shows an example of a filter view:
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Additional information
For more information on filtering, refer to the section "How to filter and export the data of the 
complete export".

6.4.5 How to filter and export the data of the complete export

Requirements     
The overview screen is open.
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Procedure
1. Define the desired filter criteria.

– Select the desired filter criteria check boxes in the "Maintenance status", "Maintenance 
job", "Service status" and "Priority" groups.
You can select all check boxes with the "Select all" button.
Click "Deselect all" to clear all check boxes.

– In the "Type information" group, you can select an area from the drop-down lists and 
enter the text you are looking for in the input boxes.
The characters "*" and "?" can be used as wildcards.
Link the fields.

2. Click the "Display data" button.
The "Result" view is displayed.

3. Click "Save" if you want to save the exported data.
You can adjust the filter criteria with the back button.

4. You can adjust filter criteria by clicking "Back".

Additional information
You can find additional information on the name and storage location in the section "Overview 
of complete export (Page 76)".

6.4.6 Message correction for components with SNMP functionality

Introduction       
The "Message correction" function deletes messages of SNMP-compatible components in the 
configuration data of the maintenance station (server data) for which the relationship with the 
project has been deleted, for example, if you have removed PC hardware from the system.

The "Message correction" function is available if your plant is not operated via a 
PCS 7 Web client.   

Icon in the user interface

Icon Function Authorizations
Execute message correction "Area authorization" and "Higher-order process 

controls" for the diagnostics area

Procedure
1. Click on the icon.
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Result
Relevant messages are deleted.

An operator message is triggered.

6.4.7 Parameter data export of EDD-based devices

Export of parameter data
Parameter data of devices that are integrated in SIMATIC PDM via EDDs can be exported:

● Export of the "offline parameter data (project)"
The parameter data stored in the project are exported to the specified destination.
The selected filter criteria are taken into consideration for the device selection.

● Export of the "Online parameter data (field device)"
The complete parameter data are first read from the devices and saved in the project. These 
parameter data are then exported to the specified destination.
The selected filter criteria are taken into consideration for the device selection.

● Automatic update and "Automatic synchronization (field device --> project)" export
If a difference in the parameter data between the device and project is detected or if a 
device signals a configuration change independently, the complete parameter data are first 
read from the device and saved in the project automatically.
The parameter data saved in the project are then exported to the specified destination.
The selected filter criteria are not taken into consideration for the device selection.

The export of parameter data can be controlled by operator input in the faceplate or remotely 
via the OPC interface of the MS.

Note

When exporting online parameter data, ensure that the device parameter assignment is not 
open elsewhere. Otherwise, only an export of offline parameter data is performed. 

This is relevant for the following export types:
● Export of the "Online parameter data (field device)"
● Automatic update and "Automatic synchronization (field device --> project)" export
● Online parameter data export for a selected device

Refer to the export file to find out whether online or offline parameter data were exported.

Export file
The parameter data are stored in an individual export file for each created device. 

The export format and the content of these export files conform to the export format of SIMATIC 
PDM.

To specify the storage location, select the menu command Options > SIMATIC PDM > 
Settings... in SIMATIC Manager and then go to the "General" tab, "Path for 'Assetexport' files".
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Log file
For each export job, a log file is created in which the successful or unsuccessful export of the 
parameter data of the devices is documented.

The storage location of the log file is specified using the WinCC variable 
@AssetControl.ExportPath. The log file is also saved in the project of the MS server.

Additional information
For additional information, refer to the following sections:

6.4.8 Parameter data export via operator input in the faceplate

6.4.8.1 Opening the faceplate

Introduction
You open the faceplate for parameter data export using the icon in the overview screen. 

Note

This function is available only for the maintenance station in the MS Standard and SIMATIC 
PDM MS versions.

Requirement
SIMATIC PCS 7 MS Standard with use of SIMATIC PDM V8.2

Icons in the overview screen

Icon Function Permissions
No offline/online export job is 
running, or an offline/online 
export job is complete

"Higher process controlling" for diagnostics area

Offline/online export job is 
running

"Higher process controlling" for diagnostics area

Note

An active automatic synchronization is not displayed in the icon.

Procedure
1. Click on the icon.
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Result
The faceplate for parameter data export is opened.

Additional information
For additional information, refer to the following sections:

6.4.8.2 Faceplate

Introduction
The faceplate includes various filter criteria and export settings for exporting parameter data. 

The export can be started, or an active export operation can be canceled. 

When you open the faceplate, you will see an overview of the last executed or active export 
job.

If an export job is active, you cannot change any filter settings. You can only cancel the export 
job.

Automatic synchronization can always be enabled or disabled.

The following figure shows an example of the faceplate for the parameter data export.
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Display
● In the Maintenance status, Maintenance job, Service status and Priority areas

Selected filter criteria

● In the Export settings area
Last export setting enabled

● In the "Export jobs for SIMATIC PDM" area
Result of the last executed export job or current data of the active export job:

– Total
Number of parameter data records to be exported

– Open
Number of parameter data records still to be exported

– Successful
Number of parameter data records already exported

– Not successful
Number of parameter data records that were not exported
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Operator controls

Icon Explanation Operator permission
The option is selected by clicking on the check box.
● Maintenance status, Maintenance job, Status Service 

area 
The filter criteria are selected.

● Export settings area
– Offline - Parameter data (project)

The parameter data are read from the project 
during the export.

– Online - Parameter data (field device)
The parameter data in the project are updated and 
then exported.

– Automatic synchronization between the 
parameter data in the field device and in the project
The parameter data in the project are 
automatically updated and then exported.
The activated filter criteria are ignored during the 
update.
The automatic synchronization is executed for 
field devices for which a change in the 
configuration was detected.

None

Applies to the following export settings:
● Offline - Parameter data (project)
● Online - Parameter data (field device)
By clicking the button, the operator panel for starting the 
update is shown.
Observe the following when exporting online and offline 
parameter data:
An active export job must be completed before you can 
start a new export job.

None

Applies to the following export settings:
● Offline - Parameter data (project)
● Online - Parameter data (field device)
By clicking the button, the operator panel for canceling 
the active export job is shown.

None

Operator panel for updating/canceling
The following figure shows an example of the operator panel:
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The export job is started with the activated export and filter settings.

6.4.8.3 How to start the offline/online parameter data export

Requirement
The faceplate for the parameter data export is open.

Procedure
1. Select which parameter data will be exported.

– If you want to export parameter data stored in the project, select the "Offline parameter 
data (project)" check box.

– If you want to export parameter data stored in the field device, select the "Online 
parameter data (field device)" check box.

2. Select the filter criteria you require.

3. Click the "Refresh" button.
The view is expanded to include the operator panel.

4. Click "OK".

Result
An export file is created for each individual device.

The values displayed in the "Export jobs for SIMATIC PDM" area are updated.

The icon in the overview screen is updated.

A log file is created for the export job.

6.4.8.4 How to cancel the offline/online parameter data export

Requirement
The "Parameter data export" faceplate is open.

Procedure
1. Click the "Cancel" button.

The view is expanded to include the operator panel.

2. Click "OK".

Result
The parameter data export is canceled.

Operator control and monitoring
6.4 Functions in the overview screen

Maintenance Station
108 Function Manual, 03/2016, A5E36187641-AA



The values displayed in the "Export jobs for SIMATIC PDM" area are updated.

The icon in the overview screen is updated.

6.4.8.5 How to start the automatic synchronization

Requirement
The faceplate for the parameter data export is open.

Procedure
1. Select the "Automatic synchronization field device --> project" check box.

Result
If a difference in the parameter data between the device and project is detected or if a device 
signals a configuration change independently, the complete parameter data are first read from 
the device and saved in the project automatically.

The parameter data saved in the project are then exported to the specified destination.

The selected filter criteria are not taken into consideration for the device selection.

The values displayed in the "Export jobs for SIMATIC PDM" are not updated.

An active export job is not indicated in the icon.

A log file is not created on the maintenance station. 

6.4.8.6 How to end the automatic synchronization

Requirement
The "Parameter data export" faceplate is open.

Procedure
1. Deselect the "Automatic synchronization field device --> project" check box.

Result
Automatic synchronization in the case of a configuration change has been ended.
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6.4.9 Parameter data export via OPC access

6.4.9.1 Tags for OPC access

Introduction
The information for the parameter data export is stored in a structure tag.

This tag structure can be directly accessed by another computer via the OPC DA interface.

You can find information on establishing an OPC connection in the WinCC Information 
System online help.

Tags for OPC access 
The required information is stored in the following tags:

Name of the tag Width
In bits

Synchroni‐
zation

Ini‐
tial 
value

Explanation Access
Via OPC

@AssetControl.ActionType 8 X 0 Required action Read/write
@AssetControl.MSFilter 32 X 0 Filter for the SIMATIC PDM 

devices
Read/write

@AssetControl.Start 8 - 0 "Start" command Read/write
@AssetControl.AdditionalTrigger 8 - 0 Other trigger conditions Read/write
@AssetControl.AdditionalTriggerRun 8 X 0 Other trigger conditions for 

synchronization
Read/write

@AssetControl.State 32 X 0 Status or group error entry Read
@AssetControl.Cancel 8 X 0 "Cancel" command Read/write
@AssetControl.DeviceCount 32 X 0 Total number of export jobs 

according to the filter criteria
Read

@AssetControl.DeviceCountOK 32 X 0 Number of successful export 
jobs

Read

@AssetControl.DeviceCountFailed 32 X 0 Number of unsuccessful ex‐
port jobs

Read

@AssetControl.TagExportStart 8 - 0 Start for export via tag name 
(one device)

Read/write

@AssetControl.TagExportState 32 X 0 State of tag export Read
@AssetControl.TagExportName 256 X " " Tag name of the device to be 

exported
Read/write

@AssetControl.ExportPath 256 X " " Path to the export destination 
in SIMATIC PDM

Read/write
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Values for @AssetControl.ActionType
The table shows the permitted values.

Value Explanation
0x01 Export of the offline parameter data (project)
0x02 Export of the online parameter data (field device)

Values for @AssetControl.MSFilter
The table shows the permitted values.

If multiple bits are set, the statuses are ORed 

Bit 31 ... 20 19 18 17 16 15 14 13 12 11 10
 

9 8 7 6 5 4 3 2 1 0

Maintenance status
Good - - - - - - - - - - - - - - - - - - - - - - 1
Passivated - - - - - - - - - - - - - - - - - - - - - 1 -
Out of service - - - - - - - - - - - - - - - - - - - - 1 - -
Simulation - - - - - - - - - - - - - - - - - - - 1 - - -
Local opera‐
tor control

- - - - - - - - - - - - - - - - - - 1 - - - -

Maintenance 
required

- - - - - - - - - - - - - - - - - 1 - - - - -

Maintenance 
demanded

- - - - - - - - - - - - - - - - 1 - - - - - -

Maintenance 
alarm

- - - - - - - - - - - - - - - 1 - - - - - - -

Device sta‐
tus unknown

- - - - -  - - - - - - - - 1 - - - - - - - -

Configura‐
tion change

- - - - - - - - - - - - - 1 - - - - - - - - -

Maintenance job
Mainten. re‐
quired re‐
quested

- - - - - - - - - - - - 1 - - - - - - - - - -

Mainten. de‐
manded re‐
quested

- - - - - - - - - - - 1 - - - - - - - - - - -

Mainten. 
alarm re‐
quested

- - - - - - - - - - 1 - - - - - - - - - - - -

Status Service
Completed - - - - - - - - - 1 - - - - - - - - - - - - -
Canceled - - - - - - - - 1 - - - - - - - - - - - - - -
In service - - - - - - - 1 - - - - - - - - - - - - - - -
Maintenance 
not started

- - - - - - 1 - - - - - - - - - - - - - - - -
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Bit 31 ... 20 19 18 17 16 15 14 13 12 11 10
 

9 8 7 6 5 4 3 2 1 0

Planned 
servicing

- - - - - 1 - - - - - - - - - - - - - - - - -

Release re‐
quest

- - 1 - - - - - - - - - - - - - - - - - - - -

Priority
Important ob‐
ject

- - - - 1 - - - - - - - - - - - - - - - - - -

Safety-rela‐
ted object

- - - 1 - - - - - - - - - - - - - - - - - - -

Values for @AssetControl.Start
The table shows the permitted values.

Value Explanation
0 Initial value
1 "Start" command

The command is reset after completion of the offline/online export job (ActionType).

Value for @AssetControl.AdditionalTrigger
The table shows the permitted values.

Value Explanation
0 "Automatic synchronization field device --> project" not enabled
1 "Automatic synchronization field device --> project" enabled

Command for enabling the automatic synchronization field device -> project

Value for @AssetControl.AdditionalTriggerRun
The table shows the permitted values.

Value Explanation
0 "Automatic synchronization field device --> project" not enabled

Command for disabling the automatic synchronization field device -> project
1 "Automatic synchronization field device --> project" enabled

Values for @AssetControl.State
The table shows the permitted values.

Value Explanation
0x0 Initial value
0xFFFF Offline/online export job is running
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Value Explanation
0x01 Export completed

All offline/online export jobs have been completed.
0x02 Export completed

The offline/online export job was canceled by the operator.
0x03 Export completed

Not all offline/online export jobs have been completed.
0x04 Processing completed

No device status corresponded to the filter criteria.

Refer to the log file for your export job to find out which export jobs were completed successfully 
and which were not completed successfully.

Values for @AssetControl.Cancel
The following table shows the permitted values.

Value Explanation
0 Initial value
1 "Cancel" command

Values for @AssetControl.DeviceCount
The following table shows the permitted values.

Value Explanation
0 Initial value
... Total number of offline/online export jobs according to filter criteria

Values for @AssetControl.DeviceCountOK
The following table shows the permitted values.

Value Explanation
0 Initial value
... Number of successful offline/online export jobs

Values for @AssetControl.DeviceCountFailed
The following table shows the permitted values.

Value Explanation
0 Initial value
... Number of unsuccessful offline/online export jobs
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Values for @AssetControl.TagExportStart
The following table shows the permitted values.

Value Explanation
0x0 Initial value
0x01 "Start online export job" command (field device)

The command is reset after executing the export job (TagExportName).
0x02 "Start offline export job" command (project)

The command is reset after executing the export job (TagExportName).

Values for @AssetControl.TagExportState
The following table shows the permitted values.

Value Explanation
0x0 Initial value
0xFFFF Export job is running
0x01 Export has ended.

Export job has been completed.
0x03 Export has ended.

Export job has not been completed.
0x04 Processing has ended.

No match found for TagExportName.

Values for @AssetControl.TagExportName
The tag is "empty" in the initial state. 

Specify the tag name of the device to be exported. You can find this name in the Component 
List Editor.

Values for @AssetControl.ExportPath
The tag is "empty" in the initial state. The log file for your export job is only stored in the 
"AssetExport" directory in the OS project of the MS server.

Specify the path for AssetExport files that you have specified in the settings for SIMATIC PDM. 
The log file for your export job is stored in the specified path and in the "AssetExport" directory 
in the OS project of the MS server.
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6.4.9.2 How to start the offline/online parameter data export (OPC)

Procedure
1. Select which parameter data will be exported.

– If you are exporting offline parameter data, write the @AssetControl.ActionType tag with 
the value 0x01.

– If you are exporting online parameter data, write the @AssetControl.ActionType tag with 
the value 0x02.

2. Write the @AssetControl.MSFilter tag according to the desired filter criteria.

3. Write the @AssetControl.ExportPath tag.

4. Set the start tag @AssetControl.Start.

Result
An export file is created for each individual device.

The values of the @AssetControl.DeviceCount, @AssetControl.DeviceCountOK, and 
@AssetControl.DeviceCountFailed tags contain the current execution status.

The values displayed in the "Export jobs for SIMATIC PDM" area are updated.

The icon in the overview screen is updated.

A log file is created for each export job.

6.4.9.3 How to cancel the offline/online parameter data export (OPC)

Procedure
1. Set the @AssetControl.AdditionalTrigger tag.

Result
The parameter data export is canceled.

The @AssetControl.Start tag is automatically set to "0".

The values of the @AssetControl.DeviceCount, @AssetControl.DeviceCountOK, and 
@AssetControl.DeviceCountFailed tags are updated.

The icon in the overview screen is updated.

Note

It is not necessary to end the offline/online parameter data export.

The @AssetControl.Start tag is automatically set to "0" after completion of the export job.
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6.4.9.4 How to start the automatic synchronization (OPC)

Procedure
1. Set the @AssetControl.AdditionalTrigger tag to "1".

Result
When a device configuration change is detected, an automatic synchronization is performed 
and an export file is created.

The selected filter criteria are ignored during automatic synchronization.

The automatic synchronization has no effects on the tags @AssetControl.DeviceCount, 
@AssetControl.DeviceCountOK and @AssetControl.DeviceCountFailed.

The icon in the overview screen is not updated.

A log file is not created.

6.4.9.5 How to end the automatic synchronization (OPC)

Procedure
1. Set the @AssetControl.AdditionalTriggerRun tag to "0".

Result
Automatic synchronization in the case of a configuration change has been ended.

The @AssetControl.AdditionalTrigger tag is automatically set to "0".

6.4.9.6 How to start the parameter data export for a selected device (OPC)

Procedure
1. Write the @AssetControl.TagExportName tag with the tag name of the device to be 

exported.

2. Write the @AssetControl.ExportPath tag.

3. Select which parameter data are exported.

– If you are exporting online parameter data, write the @AssetControl.ActionType tag with 
the value 0x01.

– If you are exporting offline parameter data, write the @AssetControl.ActionType tag with 
the value 0x02.
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Result
An export file is created for the device to be exported.

If the online parameter data export cannot be executed, the offline parameter data are 
automatically exported.

The selected filter criteria are ignored during automatic synchronization.

The export via tag name has no effects on the @AssetControl.DeviceCount, 
@AssetControl.DeviceCountOK and @AssetControl.DeviceCountFailed tags.

The values of the @AssetControl.DeviceCount, @AssetControl.DeviceCountOK, and 
@AssetControl.DeviceCountFailed tags contain the current execution status.

The icon in the overview screen is not updated.

A log file is not created.

The @AssetControl.Start tag is automatically set to "0x0" after completion of the export job.

Note

It is not possible to end or cancel the offline/online parameter data export.

6.5 Area overview screens

Possible area overview screens
The following area overview screens can be subordinate to the overview screen of the 
diagnostics area:

● PC stations

– IPC stations created as PC stations in the SIMATIC Manager and to which the profile 
IPC_V** or MIB-II_V1.0 is assigned in the SNMP configuration of the OPC server are 
shown here

– PC stations created as PC stations in the SIMATIC Manager

– No subordinate structures

● Network objects

– All network objects created in the OPC/SNMP server configuration

– All PCs that are configured in the SNMP configuration of the OPC server but have not 
been created as PC stations in the SIMATIC Manager

– No subordinate structures

● AS/system

– Hierarchically structured display of all configured objects of the automation system level, 
including the interface modules (IMs) of the ET 200 families (ET 200M, ET 200S, ET 
200 SP, ET 200iSP, ET 200pro) and the link modules (DP/PA-Link, DP/FF-Link, Y-Link)
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● Field devices

– Hierarchically structured display of all configured field devices and remote I/O stations

● User objects

– User-created hierarchically structured representation of user objects

The selected area overview screen is displayed in the working area. The individual components 
are displayed as block icons in the area overview screen.

Calling an area overview screen
You call the area screen as follows:

● Maintenance group display

● Hierarchy buttons in the button set

Function in area overview screen
The diagnostic screens of individual components from the area are called via the block icons 
in the area overview screen.

6.6 Representation of the components

Introduction   
The components to be monitored are displayed in the diagnostics screens as block icons in 
the process control.

To get more information about a component, you can call the corresponding faceplate with a 
mouse click.

Block icon       
The block icons supported by the system which can be displayed in the diagnostic screens 
are contained in the file "@@maintenancetypicals.pdl". 

The file is located in the project directory under " ... \wincproj\<os-name>\GraCS".

You can find a description of block icons in the section "Block icon (Page 119)" and in the 
section "Block icon for redundant components (Page 122)".

Faceplate   
Faceplates display all information on a component with diagnostics capability in process mode. 
This includes information that can be obtained by the component itself or from the project data. 
When information is unavailable, the corresponding field is empty.

The faceplate is made up of the title of the screen window, the header and the different views. 
You can change the view.
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The number of views in the faceplates depends on the type of component. The three views 
"Ident", "Messages" and "Maintenance" are always available for selection in the faceplates. 
Intelligent components, e.g., components described by an EDD (Electronic Device Description) 
and integrated in SIMATIC PDM, have additional views depending on the component.

Note

The faceplate is displayed if the maintenance station MS Standard or SIMATIC PDM MS 
version is being used.

You can find additional information about this in the section "Faceplate display (Page 131)" 
and in the section "Display of faceplate for redundant components (Page 182)".

6.7 Block icon

Block icon display   
The following figure shows an example of a block icon for a compact device:
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Elements and functions in the block icon
The following elements are displayed in the block icon:

● Label of the block icon

– The following figure shows an example of a label:

The label matches the local ID (LID) from the identification data of the device.
You can find information about the LID in the section "Origin of the identification data 
(Page 183)".

– The following figure shows an example of the label of a device classified as important:

The setting is made in the SIMATIC PDM object properties of the device.

– The following figure shows an example of the label of a device in a safety-related 
application:

The setting is made in the SIMATIC PDM object properties of the device.

● Bitmap
The figure below shows an ET200:

A bit map displaying the device icon is entered automatically in the "DeviceIcon" property, 
provided the bit map is available in HW Config.

● Maintenance group display of the custom component
The following figure shows the maintenance group display as AS process control fault.

You open the associated faceplate with the maintenance group display.
The following states are displayed depending on the maintenance state of the component.
You can find information on the display in the section "Maintenance status and maintenance 
group display (Page 123)".

● Maintenance state of the custom component
The following figure shows the diagnostic icon with the maintenance state "Maintenance 
alarm".

You can use the diagnostic icon to open the associated faceplate.
You can find information about the display in the section "Maintenance status and 
maintenance group display (Page 123)".
The redundancy state is displayed for redundant components.
You can find information on this in the section "Maintenance status of redundant 
components (Page 126)".
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● Active memo
The following figure shows the display if a note is active.

You can find information on this in the section ""Note" view (Page 150)".

● Maintenance group display of the lower-level hierarchy
The following figure shows the display of the maintenance group display as AS process 
control fault.

Various statuses are displayed in the maintenance group display, depending on the 
maintenance group displays of the components of the lower-level hierarchy.
You can find information on this in the section "Maintenance status and maintenance group 
display (Page 123)".
If you click on the maintenance group display in the process control, the lower-level process 
picture in the hierarchy is displayed.

Display of input/output modules
The following figure shows a section from a block icon for an I/O module:

The signal state of the individual channels is shown as follows:

Display Explanation
No display Channel not interconnected/deactivated

No diagnostics can be acquired for the channel

"Good" channel state

"Bad" channel state

Operator control and monitoring
6.7 Block icon

Maintenance Station
Function Manual, 03/2016, A5E36187641-AA 121



6.8 Block icon for redundant components

Introduction
Information for a redundant component is displayed in different ways:

● In one block icon

● In several block icons

You can use the block icon to open the associated faceplate.

Block icons
The following table shows the possible types of display:

Redundant 
component

Display Explanation

IM 153-2 The redundancy state is displayed for the component and 
its partner in a diagnostic icon.

I/O
module

The maintenance state of each component is indicated in 
the assigned diagnostic icon (top diagnostic icon).
A redundancy object is also displayed for the component 
with the lower address.
The redundancy state is displayed in the diagnostic icon 
of the redundancy object.

PC objects The role of master is indicated by an orange square.

The maintenance state of its partner is indicated in the 
diagnostic icon.

The redundancy state is indicated in the diagnostic icon 
in the redundancy object.

Additional information 
You can find additional information in the sections "Block icon (Page 119)" and "Maintenance 
status of redundant components (Page 126)".
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6.9 Maintenance status and maintenance group display

Introduction       
The diagnostic icon represents the maintenance state of the component.

The maintenance group display represents the message state of the component and the lower-
level components.

Note

If the maintenance state is "Unchecked/unknown" in the faceplate, all other dynamic displays 
are irrelevant.

Correlation maintenance state and maintenance group display
The following table provides an overview:

Maintenance state Maintenance group display
Display Remark Val‐

ue
Prior‐
ity

Display Message class/
state

Message state

Unknown/
untested

8 1 No message is pending -

Maintenance 
alarm

7 2 AS process control fault "S" display
● Flashing

Message not 
acknowledged

● Not flashing
Message 
acknowledged

Maintenance
demanded

6 3 AS process control error "F" display
● Flashing

Message not 
acknowledged

● Not flashing
Message 
acknowledged

Maintenance re‐
quired

5 4 Preventive maintenance "M" display
● Flashing

Message not 
acknowledged

● Not flashing
Message 
acknowledged
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Maintenance state Maintenance group display
Display Remark Val‐

ue
Prior‐
ity

Display Message class/
state

Message state

Local
operator control

4 5 Status AS ● No display in the 
group display

● Message does not 
require 
acknowledgement 
and does not have the 
state "outgoing"

● Message is only 
entered in the history 
list

At least
one process value
is being simulated

3 6

Out of service 2 7 AS process control fault "S" display
● Flashing

Incoming message
● Static

Message 
acknowledged

Device
passivated

1 8 Status AS ● No display in the 
group display

● Message does not 
require 
acknowledgement 
and does not have the 
state "outgoing"

● Message is only 
entered in the history 
list

Configuration
change
detected

9 9

Good 0 10 No message -

Applies to all displays Message is locked "X" display
At least one message is 
locked;
applies only to objects 
from the areas AS, user 
and field devices

The number in the priority column indicates the priority of the display. The lowest number has 
the highest priority.

Note that unacknowledged messages have a higher priority than acknowledged messages.

Correlation maintenance state and maintenance job
The following table provides an overview:
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Meaning Maintenance
job

State maintenance
job

Maintenance required has been requested, 
maintenance engineer has not yet created a mainte‐
nance job
Maintenance demanded has been requested, 
maintenance engineer has not yet created a mainte‐
nance job
Maintenance alarm has been requested, 
maintenance engineer has not yet created a mainte‐
nance job
Maintenance required requested,
the maintenance job was changed to the "Planned serv‐
icing" state
Maintenance demanded requested,
the maintenance job was changed to the "Planned serv‐
icing" state
Maintenance alarm requested,
the maintenance job was changed to the "Planned serv‐
icing" state
Maintenance required requested,
maintenance job was changed to the "Release request" 
state
Maintenance demanded requested,
maintenance job was changed to the "Release request" 
state
Maintenance alarm requested,
maintenance job was changed to the "Release request" 
state
Maintenance required requested,
maintenance job was set to the state "In service"
Maintenance demand requested,
maintenance job was set to the state "In service"
Maintenance alarm requested,
the maintenance job was changed to the "In service" 
state
Maintenance job canceled
Maintenance engineer has canceled the maintenance 
job

Maintenance
state see table 
above

Maintenance job completed Maintenance
state see table 
above

Structure of the variable for the maintenance state
The value of the variable *.MS or *.MaintenanceState represents the maintenance state.

The variable is a DWORD type.
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The table shows the basic structure of the variable.

Bit Explanation
0 to 7 Display of the maintenance state
8 to 15 Display of the maintenance state of the redundant partner
16 "1"= Redundant partner available
17 "0" = Primary partner is master

"1" = Redundant partner is master
18 SIMATIC PDM maintenance state worse than device status
19 to 21 Reserve
22 SIMATIC PDM has detected a state change
23 Block takes part in the cyclical updating of SIMATIC PDM
24 to 27 OS operation
28 to 31 SIMATIC PDM maintenance state

6.10 Maintenance status of redundant components

Introduction
In the faceplate header and in the block icon, the maintenance status of both components is 
displayed in one diagnostic icon for the redundant pair.

The maintenance status for this diagnostic icon is formed from the maintenance states of both 
components.

Forming the maintenance status with redundant components 
The table below lists the maintenance states that are formed because of this rule.   

Maintenance status 
Redundant component Component A Component B

Good Good Good

Good Unknown/untested Good

Good Component passivated Good

Maintenance demanded Out of service Good

Good At least one process value is 
being simulated

Good

Local operation Local operation Good

Maintenance required Maintenance required Good
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Maintenance status 
Redundant component Component A Component B

Maintenance demanded Maintenance demanded Good

Maintenance demanded Maintenance alarm Good

Configuration change Configuration change Good

Good Good Component passivated

Component passivated Unknown/untested Component passivated

Component passivated Component passivated Component passivated

Out of service Out of service Component passivated

At least one process value is being simulated At least one process value is 
being simulated

Component passivated

Local operation Local operation Component passivated

Maintenance required Maintenance required Component passivated

Maintenance demanded Maintenance demanded Component passivated

Maintenance alarm Maintenance alarm Component passivated

Component passivated Configuration change Component passivated

Maintenance demanded Good Out of service

Out of service Unknown/untested Out of service

Out of service Component passivated Out of service

Out of service Out of service Out of service

At least one process value is being simulated At least one process value is 
being simulated

Out of service

Local operation Local operation Out of service

Maintenance required Maintenance required Out of service

Maintenance demanded Maintenance demanded Out of service

Maintenance alarm Maintenance alarm Out of service

Out of service Configuration change Out of service
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Maintenance status 
Redundant component Component A Component B

Good Good At least one process value is 
being simulated.

At least one process value is being simulated Unknown/untested At least one process value is 
being simulated.

At least one process value is being simulated Component passivated At least one process value is 
being simulated.

At least one process value is being simulated Out of service At least one process value is 
being simulated.

At least one process value is being simulated At least one process value is 
being simulated

At least one process value is 
being simulated.

Local operation Local operation At least one process value is 
being simulated.

Maintenance required Maintenance required At least one process value is 
being simulated.

Maintenance demanded Maintenance demanded At least one process value is 
being simulated.

Maintenance alarm Maintenance alarm At least one process value is 
being simulated.

At least one process value is being simulated. Configuration change At least one process value is 
being simulated.

Local operation Good Local operation

Local operation Unknown/untested Local operation

Local operation Component passivated Local operation

Local operation Out of service Local operation

Local operation At least one process value is 
being simulated

Local operation

Local operation Local operation Local operation

Maintenance required Maintenance required Local operation

Maintenance demanded Maintenance demanded Local operation

Maintenance alarm Maintenance alarm Local operation

Local operation Configuration change Local operation

Maintenance required Good Maintenance required

Maintenance required Unknown/untested Maintenance required

Maintenance required Component passivated Maintenance required

Operator control and monitoring
6.10 Maintenance status of redundant components

Maintenance Station
128 Function Manual, 03/2016, A5E36187641-AA



Maintenance status 
Redundant component Component A Component B

Maintenance required Out of service Maintenance required

Maintenance required At least one process value is 
being simulated

Maintenance required

Maintenance required Local operation Maintenance required

Maintenance required Maintenance required Maintenance required

Maintenance demanded Maintenance demanded Maintenance required

Maintenance alarm Maintenance alarm Maintenance required

Maintenance required Configuration change Maintenance required

Maintenance demanded Good Maintenance demanded

Maintenance demanded Unknown/untested Maintenance demanded

Maintenance demanded Component passivated Maintenance demanded

Maintenance demanded Out of service Maintenance demanded

Maintenance demanded At least one process value is 
being simulated

Maintenance demanded

Maintenance demanded Local operation Maintenance demanded

Maintenance demanded Maintenance required Maintenance demanded

Maintenance demanded Maintenance demanded Maintenance demanded

Maintenance alarm Maintenance alarm Maintenance demanded

Maintenance demanded Configuration change Maintenance demanded

Maintenance demanded Good Maintenance alarm

Maintenance alarm Unknown/untested Maintenance alarm

Maintenance alarm Component passivated Maintenance alarm

Maintenance alarm Out of service Maintenance alarm

Maintenance alarm At least one process value is 
being simulated

Maintenance alarm

Maintenance alarm Local operation Maintenance alarm
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Maintenance status 
Redundant component Component A Component B

Maintenance alarm Maintenance required Maintenance alarm

Maintenance alarm Maintenance demanded Maintenance alarm

Maintenance alarm Maintenance alarm Maintenance alarm

Maintenance alarm Configuration change Maintenance alarm

Good Good Unknown/untested

Unknown/untested Unknown/untested Unknown/untested

Component passivated Component passivated Unknown/untested

Out of service Out of service Unknown/untested

At least one process value is being simulated At least one process value is 
being simulated

Unknown/untested

Local operation Local operation Unknown/untested

Maintenance required Maintenance required Unknown/untested

Maintenance demanded Maintenance demanded Unknown/untested

Maintenance alarm Maintenance alarm Unknown/untested

Unknown/untested Configuration change Unknown/untested

Configuration change Good Configuration change

Unknown/untested Unknown/untested Configuration change

Component passivated Component passivated Configuration change

Out of service Out of service Configuration change

At least one process value is being simulated At least one process value is 
being simulated

Configuration change

Local operation Local operation Configuration change

Maintenance required Maintenance required Configuration change

Maintenance demanded Maintenance demanded Configuration change
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Maintenance status 
Redundant component Component A Component B

Maintenance alarm Maintenance alarm Configuration change

Configuration change Configuration change Configuration change

6.11 Faceplate

6.11.1 Faceplate display

Introduction   
Starting from a block icon in a diagnostics screen, the maintenance engineer can open the 
corresponding faceplate while the process is in operation; this faceplate provides him with 
access to more detailed information and facilitates operator control of the block. 

Displaying the faceplate view "Ident"
The figure below shows an example of a faceplate:

You can find information about this in the following sections.
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6.11.2 Screen window title and header

6.11.2.1 Displays and operator controls

Introduction       
The control bar always has the same structure. The appropriate icons are displayed depending 
on the component type and on the configuration.

The following figure shows an example of the display: 

Display
The following table provides an overview:

Icon Name Display for components 
from the area

Function/remark

Screen window title ● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Display of the local ID
You can find additional information about 
the local ID in the section "Origin of the iden‐
tification data (Page 183)".

Block comment ● AS/system
● Field devices
● User objects

Display of the block comment
The local ID is displayed in the tooltip.

Pin faceplate ● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Pins the faceplate on the user interface
This allows you to change to another picture 
or area without closing the faceplate.

Return ● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Calls the process picture
After a picture change you see the process 
picture in which the faceplate was called and 
pinned.
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Icon Name Display for components 
from the area

Function/remark

Maintenance
group display (custom 
component)

● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Is displayed if a message relating to the 
component is pending
You can find additional information about 
the maintenance group display in the sec‐
tion "Maintenance status and maintenance 
group display (Page 123)".

Maintenance state/
maintenance job (custom 
component) 

● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Current maintenance state/
maintenance job is displayed
You can find more information on this in the 
sections "Maintenance status and mainte‐
nance group display (Page 123)" and "Main‐
tenance status of redundant components 
(Page 126)".

Maintenance job state ● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Current state of the maintenance job
For additional information about the state of 
the maintenance job, see the section "Main‐
tenance status and maintenance group dis‐
play (Page 123)".

Archive synchronization in‐
complete

● PC stations,
applies to redundant 
OS servers

Is displayed until the archive synchroniza‐
tion is complete

Flutter suppression ● AS/system,
applies 
to input/output 
modules

● Field devices

Is displayed when flutter suppression is ac‐
tivated

Lock messages, unlock 
messages

● AS/system
● Field devices
● User objects

Locks or unlocks all messages for the block
You can find additional information about 
this in the section "How to lock and unlock 
messages (Page 137)".

Acknowledge messages ● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Acknowledges a message for the block

Depassivation ● Field devices,
applies to redundant 
input/output
modules

Is displayed if a module or a channel is pas‐
sivated
You can find additional information about 
this in the section "How to depassivate mod‐
ules or channels (Page 138)".
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Icon Name Display for components 
from the area

Function/remark

Link object 1 to 
link object 3

● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Calls a Web page
Is displayed if the call for a Web page is con‐
figured
You can find more information on this in the 
sections "Configuring maintenance links 
(Page 54)" and "How to open websites via 
maintenance links (Page 139)".

Call hardware project ● AS/system
● Field devices

Calls HW Config
You can find additional information about 
this in the section "How to open the online 
view of HW Config (Page 139)".

Call SIMATIC PDM ● Field devices
● User objects

Calls the configuration interface for the con‐
figured component
You can find additional information about 
this in the section "How to open the configu‐
ration interface of SIMATIC PDM 
(Page 140)".

Call configuration data ● Network objects Calls the SCALANCE Web server
You can find additional information about 
this in the section "How to call up the Web 
interface of a network component 
(Page 141)".

Diagnostics Monitor ● PC stations,
applies to SIEMENS 
IPCs

Calls the Diagnostics Monitor diagnostics 
tool
You can find additional information about 
this in the section "How to call the Diagnos‐
tics Monitor diagnostic tool (Page 142)".

Active memo ● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Is displayed when a message is activated
You can find additional information about 
this in the section ""Note" view (Page 150)". 

"Ident" view ● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Calls the corresponding view
● When you left-click, the view appears in 

the same window
● When you right-click, the view opens in 

a new window.

"Message" view ● PC stations
● Network objects
● AS/system
● Field devices
● User objects

Calls the corresponding view
● When you left-click, the view appears in 

the same window
● When you right-click, the view opens in 

a new window.
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Icon Name Display for components 
from the area

Function/remark

"Performance" view ● AS/system,
applies to CPU

Calls the corresponding view
● When you left-click, the view appears in 

the same window
● When you right-click, the view opens in 

a new window.
"Notes" view ● PC stations

● Network objects
● AS/system
● Field devices
● User objects

Calls the corresponding view
● When you left-click, the view appears in 

the same window
● When you right-click, the view opens in 

a new window.

"Diagnostics" view ● Field devices,
applies to SIMATIC 
PDM devices, 
switch and drive

● PC stations,
applies to SIEMENS 
IPC

● AS/system,
applies to devices with 
a SIMATIC PDM 
configuration 

Calls the corresponding view
● When you left-click, the view appears in 

the same window
● When you right-click, the view opens in 

a new window.

"External diagnostics" view ● Field devices Calls the corresponding view
● When you left-click, the view appears in 

the same window
● When you right-click, the view opens in 

a new window.
"Maintenance" view ● PC stations

● Network objects
● AS/system
● Field devices
● User objects

Calls the corresponding view
● When you left-click, the view appears in 

the same window
● When you right-click, the view opens in 

a new window.

"LED display" view ● AS/system,
applies to CPU

Calls the corresponding view
● When you left-click, the view appears in 

the same window
● When you right-click, the view opens in 

a new window.
"Diagnostic buffer" view ● AS/system,

applies to CPU or CP in 
the central rack and 
expansion rack

Calls the corresponding view
● When you left-click, the view appears in 

the same window
● When you right-click, the view opens in 

a new window.
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Icon Name Display for components 
from the area

Function/remark

"Connections" view ● PC stations,
applies to MS client, 
OS/MS client and OS 
client

Calls the corresponding view
● When you left-click, the view appears in 

the same window
● When you right-click, the view opens in 

a new window.
"Client connections" view ● PC stations,

Applies to MS server, 
OS server

Calls the corresponding view
● When you left-click, the view appears in 

the same window
● When you right-click, the view opens in 

a new window.
"Connection load display" 
view for CPU connections

● AS system,
applies to CPU

Calls the corresponding view
● When you left-click, the view appears in 

the same window
● When you right-click, the view opens in 

a new window.
"Monitoring" view ● User objects Calls the corresponding view

● When you left-click, the view appears in 
the same window

● When you right-click, the view opens in 
a new window.

"Parameter" view ● AS/system,
applies to CPU

● Field devices,
applies to SIMATIC 
PDM devices

Calls the corresponding view
● When you left-click, the view appears in 

the same window
● When you right-click, the view opens in 

a new window.
"OB3x" view ● AS/system,

applies to CPU
Calls the corresponding view
● When you left-click, the view appears in 

the same window
● When you right-click, the view opens in 

a new window.
"OB8xOB1" view ● AS/system,

applies to CPU
Calls the corresponding view
● When you left-click, the view appears in 

the same window
● When you right-click, the view opens in 

a new window.
Calling additional views ● PC stations

● Network objects
● AS/system
● Field devices
● User objects

Calls additional view selection keys
Can only be operated if additional views can 
be called
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6.11.2.2 How to lock and unlock messages

Introduction   
Messages are locked or unlocked for components from the areas AS/system, field devices 
and user objects.

Messages can be locked or unlocked in the button set or in the faceplate.

Locked messages are indicated by an X:

● In the group display in the overview area
You can find additional information about this in the section "Overview area (Page 91)".

● In the maintenance group displays in the overview screen, area overview screen, block 
icon, and faceplate
You can find additional information about this in the section "Maintenance status and 
maintenance group display (Page 123)".

Icon in the user interface

Icon Function Explanation Permission
Lock mes‐
sages

● Faceplate
Messages for component are locked

● Button set
Messages of all displayed components 
are locked

Process controlling (1)

Unlock 
messages

● Faceplate
Messages for component are unlocked

● Button set
Messages of all displayed components 
are unlocked

(1) The operator authorization level can be adjusted.

The operator authorization level is saved in the internal tag @LockMessageAuthLevel in 
WinCC tag management. This tag is created by the OS project editor.

The operator authorization level depends on the number saved as the initial value in the tag 
properties. The initial value is pre-assigned the value 5 by the system.

The number for the required authorization is provided in the User Administrator.

Note

Note that any change in the operator authorization level must be implemented in the project 
of each operator station in an MS multiple-station system.
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Procedure for locking messages
1. Click the required icon.

2. Enter a text in the input box as a comment.

3. Click OK/Lock messages. 

Procedure for releasing messages
1. Click the required icon.

Additional information
For more information on this, refer to the Process Control System PCS 7; Operator Station 
manual.

6.11.2.3 How to depassivate modules or channels

Introduction
The passivation symbol is displayed in the faceplate in order to ensure that the discrepancy 
of a redundant module or its failed channels can be detected by the maintenance engineer. 

As long as the discrepancy time is active, maintenance required and a message are displayed 
in the message system in the faceplate of the module.

If, moreover, a long-term discrepancy is detected, the module/channel is passivated. This 
results in a loss of redundancy. The module or the channel is indicated as "Faulty" in the block 
icon. The maintenance demanded, the symbol for depassivation and a message are displayed 
in the message system in the faceplate.       

If the cause of the discrepancy has been remedied, the depassivation can be carried out with 
the icon in the faceplate.

Icon in the user interface

Icon Function Explanation Authorization
Depassivation The module or channels are passivated. "Higher process control‐

ling" for diagnostics area

Procedure
1. Click the "Depassivation" icon.

2. Click the "Execute" button.

Result
The depassivation is executed. The icon is hidden.
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6.11.2.4 How to open websites via maintenance links

Introduction
Up to 3 Web pages which are used to provide support for diagnostics measures can be called. 
The icons are displayed when the calls are configured.

Requirements
● The Maintenance Station is available in the MS Standard version.

● The maintenance target (web address) has been configured.

● The maintenance target can be accessed via the network.

Icon in the user interface

Icon Function Explanation Permission
Open maintenance link 
1

Open of the config‐
ured web address

"Higher process controlling" for diagnostics 
area 

Open maintenance link 
2
Open maintenance link 
3

Procedure
1. Click on the icon.

Result
The web page is displayed in a screen window.

6.11.2.5 How to open the online view of HW Config

Introduction   
The "Call hardware project" icon is used to call the online view of the hardware configuration 
(HW Config).

Note

This function is available for the maintenance station in the MS Standard version.

The hardware project can be called if the MS client is operated on the ES.
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Icon in the user interface

Icon Function Explanation Permission
Call hardware 
project

Calls the online view of the hard‐
ware configuration (HW Config)

"Higher process controlling" for di‐
agnostics area

Displaying the "Call hardware project" icon
The icon is displayed in the faceplate header for field devices (EDD) and AS objects.

Requirement
The component is part of the hardware configuration.

Procedure
1. Click the "Call hardware project" icon.

Note

Do not proceed until the online view of the hardware configuration (HW Config) is 
completely open, because HW Config online may otherwise be put in the background and 
can no longer be reached if key combinations are locked. In this case, press the button 
once again.

Result
The online view of the hardware configuration (HW Config) opens.

6.11.2.6 How to open the configuration interface of SIMATIC PDM

Introduction   
You use the "Call SIMATIC PDM" icon to call the configuration interface for the device shown 
in the faceplate.

Icon in the user interface

Icon Function Explanation Permission
Call SIMATIC PDM Calls the parameter assign‐

ment interface for the device
"Higher process controlling" for di‐
agnostics area 

Displaying the "Call SIMATIC PDM" icon
The icon is displayed in all views in the faceplate for field devices and user objects that are 
integrated using a device description (EDD).
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Requirements
SIMATIC PDM >= V8.2 is installed.

The SIMATIC PDM Server is installed and set up.

The component can be programmed with SIMATIC PDM.

Procedure
1. Click the "Call SIMATIC PDM" icon.

2. Enter your logon data in the input boxes of the logon dialog box.

Result
The configuration interface for the component displayed in the faceplate is opened.

Additional information
You can find information about the opened display in the manual Process Control System 
PCS 7; Help on SIMATIC PDM.

6.11.2.7 How to call up the Web interface of a network component

Introduction   
You use the "Call configuration data" icon to open the Web Interface for the component.

First, an attempt is made to establish a secure connection (HTTPS) to the device. If the secure 
connection is successfully established, the "Call configuration data" icon is displayed for 
operator selection.

If the secure connection cannot be established, an attempt is made to establish a non-secure 
connection (HTTP). If the non-secure connection is successfully established, the "Call 
configuration data" icon is displayed for operator selection.

If no connection can be established, the "Call configuration data" icon is not available for 
selection.

Note

This function is not available for SIMATIC PDM MS.
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Requirements
● The network objects must be accessible via the network.

● The "Trusted sites" security setting is in effect.
For additional information on this topic, refer to the SIMATIC NET; "Industrial Ethernet OSM/
ESM Network Management" Manual.

● The network component device profile corresponds to the OSM or SCALANCE device 
profile.

Icon in the user interface

Icon Function Explanation Permission
Call configuration da‐
ta

Call of the Web Interface of the 
component

"Higher process controlling" for di‐
agnostics area 

Displaying the "Call configuration data" icon
The icon is displayed in the faceplate in all views for network components.

The icon is also displayed when the network component is not accessible.

Procedure
1. Click the "Call configuration data" icon.

Result
The Web Interface of the component opens.

6.11.2.8 How to call the Diagnostics Monitor diagnostic tool

Introduction   
You can open the "Diagnostics Monitor" diagnostic tool of the component with the 
"Diagnostics Monitor" icon.

First, an attempt is made to establish a secure connection (HTTPS) to the device. If the secure 
connection is successfully established, the "Diagnostics Monitor" icon is displayed for operator 
selection.

If the secure connection cannot be established, an attempt is made to establish a non-secure 
connection (HTTP). If the non-secure connection is successfully established, the "Diagnostics 
Monitor" icon is displayed for operator selection.

If no connection can be established, the "Diagnostics Monitor" icon is not available for selection.
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Requirements
● The Diagnostics Monitor diagnostic tool is installed and configured.

● The web server is started and enabled in the Windows firewall.

● The PC stations can be accessed via the network.

Icon in the user interface

Icon Function Explanation Permission
Call Diagnos‐
tics Monitor

Calling the Diagnostics Monitor 
diagnostic tool

"Higher process controlling" for di‐
agnostics area 

Displaying the "Call configuration data" icon
The icon is displayed in the faceplate for IPCs.

Procedure
1. Click the "Diagnostics Monitor" icon.

Result
The diagnostic tool is called.

6.11.3 Views

6.11.3.1 "Ident" view

Available
This view is displayed for all components.

This view is not available in the faceplate for the redundant server pair.

Note

This view is available for the maintenance station in the MS Standard and SIMATIC PDM MS 
versions.

Overview     
This view displays the configuration data or device data in the information box. The composition 
of the identification data depends on the component selected.
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The structure of the view is identical for all faceplates; only the origin of the identification data 
is different.

The following figure shows an example of the view:

Display
● Maintenance status

You can find more information on the maintenance status in the sections "Maintenance 
status and maintenance group display (Page 123)" and "Maintenance status of redundant 
components (Page 126)".

● Identification data
The identification data represents the electronic rating plate of a device. The identification 
data is refreshed manually in the faceplate using the operator control.
There is an automatic update following the change in status from "Maintenance alarm" to 
another maintenance status. The exception to this is the status "unknown/unchecked". 
You can find information about the sources of the identification data in the section "Origin 
of the identification data (Page 183)".

Note

Not every asset provides all identification data.

If certain identification fields in the "Ident" view are empty even though the time stamp in 
the "Last update" field has been updated, these data are not provided by the component. 
The causes may be as follows:
● There is no data stored in the component.
● The component does not recognize the data.

If, however, no time stamp is displayed in the "Last update" field, then either the 
identification data have not been updated or there are no online data available for these 
components.
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● Comment
The comment is read from HW Config.

● Last update
The timestamp of the last update of the identification data is displayed.

● Status
The following table shows the symbolic identification of the origin of the data:

Icon identification Meaning
No icon No information on the data source

Device data
The data source is the device.
Project data
The data source is the project. 
No data were read from the device.

Operator control

Icon Explanation Permission
You update the display of identification data by 
clicking the icon.

"Process controlling" for the diagnos‐
tics area

Additional information
You can find information on displaying redundant components in the faceplate in the section 
"Display of faceplate for redundant components (Page 182)".

6.11.3.2 "Messages" view

Available
This view is displayed for all components.

Note

This view is available for the maintenance station in the MS Standard and SIMATIC PDM MS 
versions.

Overview     
This view contains all messages that are present for a component.

The following messages are displayed:

● Diagnostic/error messages

● Operating messages after selection of the long-term archive list in the toolbar
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The following figure shows an example of the view:

Display
Messages

● Currently pending messages, independent of acknowledgment status

● Unacknowledged messages went out

● In addition to the filter for the "Origin", only messages that belong to the "Diagnostics" area 
are displayed.

Operator controls
Operation takes place the same way as operation on an operator station.

You can find additional information on this in the manual Process Control System PCS 
7, OS Process Control.
The following icon is also displayed for switching between the "Chronology" view and the 
"Operator message" view if the short-term archive list is selected.

Icon Explanation Permission
By clicking the icon, the short-term archive list is called 
and the following icon for switching between the "Chro‐
nology" view and the "Operator message" view is dis‐
played.

No access protection

You change the view by clicking the icon.

6.11.3.3 "Maintenance" view

Available
This view is displayed for all components.

This view is not available in the faceplate for the redundant server pair.

Note

This view is available for the maintenance station in the MS Standard and SIMATIC PDM MS 
versions.
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Overview
This view allows the maintenance engineer to demand and manage a maintenance job for the 
specific component. The maintenance state of the demanded maintenance measure is 
displayed in the diagnostic screens in the maintenance group display. The maintenance state, 
the maintenance job and the state of the maintenance job are displayed in the header of the 
faceplate.       

In this view you can execute a single export, consisting of identification data, the maintenance 
state and the maintenance information of the respective component.

The following figure shows an example of the view for an input and output module:

The following figure shows an example of the view for a PC object:
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Display
● Sum status of the release for maintenance

The display is formed from the state of the maintenance release of the lower-level 
components and their own components.

Display Meaning
Release granted for all components/channels involved

Release not granted for at least one component/channel involved

Note

The Advanced Process Library must be used in order to display the maintenance release.

● Maintenance release for lower-level components/channels

Display Meaning
Not interconnected/used
Interconnected/used and release by the operator in the plant area not granted
Interconnected/used and release by the operator in the plant area granted

Note

The Advanced Process Library must be used in order to display the maintenance release.
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Operator control

Icon/
Name

Explanation Operator permis‐
sion

"Maintenance job" 
area
● Alarm
● Prompt
● Request

A maintenance job is requested by clicking an option button. "Process control‐
ling" for the diag‐
nostics area

"Requested action" 
area

You select an action from the drop-down box.
An action, for example, can be "Disassembly".
You can find information on configuring an action in the 
section "Configuring maintenance actions (Page 58)".

"Time requested" 
area

The time of the request of the maintenance job is specified 
in the input box. The time is entered in the following format: 
YYYY.MM.DD - hh:mm.

"Status Service" area
● In service
● Release request
● Planned 

servicing
● Completed
● Cancel

By selecting an option button, the maintenance job is given 
a processing state.

"Passivate" check 
box

Available for PC and IPC objects
The PC object is passivated by clicking on the check box.
You can find information on passivation in the section "Pas‐
sivating PC objects (Page 194)". 

"Memo" area The maintenance engineer can enter a note for the service 
job in the memo field or change a saved note.
The text is applied to the individual export file. 
In order for the note text to be saved as a comment for the 
operator message and permanently displayed in the memo 
field, one of the following operator actions is required in 
addition to entering the note text:
● Change the type of maintenance job in the maintenance 

job area
● Switch between the service types 'In Service' and 

'Planned servicing' (bilateral) in the Status Service area
The note text is deleted when you complete or cancel the 
maintenance job. 

"Targets" area ● Check boxes
By selecting this check box, the single export file is 
stored in the selected target.

● Drop-down box
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Icon/
Name

Explanation Operator permis‐
sion

Select the storage path for the single export file from the 
drop-down box. A maximum of two targets can be 
selected at the same time.

You can find information on configuration of a target in the 
section "Configuring maintenance targets for individual ex‐
port (Page 56)".
When the icon is clicked, a maintenance job is created as 
a single export file or displayed as a print job.
The Print function is available if your plant is not operated 
via a PCS 7 Web client.   

Additional information
You can find information on single export in the section "Overview of individual export 
(Page 77)".

6.11.3.4 "Note" view

Available   
This view is displayed for all components.

This view is not available in the faceplate for the redundant server pair.

Note

This view is available for the maintenance station in the MS Standard and SIMATIC PDM MS 
versions.

Overview   
You can leave temporary messages for other maintenance engineers in this view. 

The following figure shows an example of the "Notes" view.
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Operator control

Icon Explanation Permission
Free area Text box for the note "Process controlling" for the di‐

agnostics areaThe note is enabled or disabled by selecting the check 
box.
● Enabling

The note is enabled when the check box is 
selected.
The next time the faceplate is opened or there is a 
process picture change, you can see in the status 
bar of the block icon and the faceplate that there 
is a new message for you.

● Disabling
The display in the status bar of the faceplate and 
in the block icon is hidden.
The message is not deleted automatically.

Note

Keep in mind that a complete compilation of the MS (that is the MS for single-station systems 
and the MS server for multiple-station systems) and subsequent downloading of the MS server 
deletes the contents of the note view.
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6.11.3.5 "Diagnostics" view for PC objects

Available
The view is displayed for the IPC component from the PC objects area.

Note

This view is available for the maintenance station in the MS Standard and SIMATIC PDM MS 
versions.
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Overview     
Up to 18 binary states of an IPC are displayed in this view.

● The following figure shows an example of the view for a component IPC with the profile 
V1.3:

● The following figure shows an example of the view for a component IPC with the profile 
V1.4 or higher:

The redundancy loss of channel A/B is only indicated in the case of a redundant connection 
to the terminal bus with Softnet IE/RNA in combination with the IPC Profile 1.5.
As soon as one of the two terminal bus cables is removed, this is visualized with a "red" 
state display.
These displays are not controlled with Intel Teaming.
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Display
● Status of the component

The following table shows the icon representation of the statuses:

Icon identification Meaning
No icon No state

No detail information pending or available

Pending fault

There was a fault for a time

Operator control

Icon Explanation Permission
You open the legend by clicking the icon.
The legend shows the icons designating the possible 
statuses and their meaning.

No access protection

With Profile V1.4 and higher, the stored statuses are 
reset when you click the icon.

"Process controlling" for the di‐
agnostics area

6.11.3.6 "Connection display" view for client components

Available
The view is displayed for all OS clients, MS clients and OS/MS clients from the area of the PC 
objects.

Note

This view is available for the maintenance station in the MS Standard version.

Overview
This view shows all servers, the server data of which are downloaded to the client.

Servers are OS servers, MS servers and OS/MS servers.

The following figure shows an example of the view:
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Display
● The symbolic computer name of all servers

● The computer name of all servers

● The computer name of the redundant partner

● Configured and currently connected preferred servers
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● Current connection

● Status
The following table shows the icon representation of the statuses:

Display Meaning
Configured preferred servers

Currently connected server is preferred server and connection is 
available
Connection available

Connection not available

Connection has failed in the meantime

Currently connected server is preferred server and connection has 
failed in the meantime
The server does not assume the "Error" state and waits until its part‐
ner can take over again. Only then does the server assume the 
"Fault" state.
The currently connected server is the preferred server. The server 
does not assume the "Error" state and waits until its partner can take 
over again. Only then does the server assume the "Fault" state.

Operator control

Icon Explanation Permission
You open the legend by clicking the icon. 
The legend shows the icons designating the possible 
statuses and their meaning.

No access protection

When you click on the icon, the marking for server con‐
nections that have failed in the meantime is reset.

"Process controlling" for the di‐
agnostics area

6.11.3.7 "Connection display" view for server components

Available 
The view is displayed for all OS servers, MS servers and OS/MS servers from the area of the 
PC objects.

Note

This view is available for the maintenance station in the MS Standard version.

Overview
This view displays all clients connected to the server.

Clients are OS clients, MS clients and OS/MS clients.

Operator control and monitoring
6.11 Faceplate

Maintenance Station
156 Function Manual, 03/2016, A5E36187641-AA



The server data of the server must be assigned to the clients.

The partner is displayed for a redundant server.

The following figure shows an example of the view:

Display
● The computer name of all clients assigned to the server

● The computer name of the redundant partner

● Configured and currently connected preferred servers

● Current connection

● Status
The following table shows the icon representation of the statuses:

Display Meaning
Configured preferred servers

Currently connected server is preferred server and connec‐
tion is available
Connection available

Connection not available

Connection has failed in the meantime

Currently connected server is preferred server and connec‐
tion has failed in the meantime
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Operator control

Icon Explanation Permission
You open the legend by clicking the icon. 
The legend shows the icons designating the possi‐
ble statuses and their meaning.

No access protection

By clicking on the icon, the marking for client con‐
nections that have failed in the meantime is reset.

"Process controlling" for the di‐
agnostics area

6.11.3.8 "Diagnostics" view for AS objects

Available     
The following views are shown for devices of the type Switch, Drive and EnergyMeter from the 
field devices area.

Note

This view is available for the maintenance station in the MS Standard version.

Overview
Information on Switch, Drive and EnergyMeter type devices is displayed in these views. 
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● The following figure shows an example of the view for Switch:

● The following figure shows an example of the view for Drive:
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● The following figure shows an example of the view for Drive in accordance with the NAMUR 
standard:

● The following figure shows an example of the view for EnergyMeter:

Display
● Statuses for the device

The following table shows the icon representation of the statuses:

Icon identification Meaning
No icon No status

No detail information pending or available

Problem exists

There was a fault for a time

There is a warning

There was a warning for a time
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Operator control

Icon Explanation Permission
You open the legend by clicking the icon. 
The legend shows the icons designating the possible 
statuses and their meaning.

No access protection

By clicking the icon, the stored statuses are reset. "Process controlling" for the di‐
agnostics area

6.11.3.9 "Performance" view for AS objects

Available   
This view is displayed for the AS station in the AS/system area for CPU types that support the 
SFC78 and have the following firmware versions:

● Standard CPU 41x >= firmware version V5.0

● H-CPU 4xx >= firmware version V4.5

Note

This view is available for the maintenance station in the MS Standard version.

Overview
This view graphically displays the overall situation of the CPU utilization. All values in the bar 
chart are given as percentages. The reference value is the assigned maximum cycle 
monitoring time of the CPU.

All of the displays of the overall situation are mean values. because displaying actual values 
of the most recent cycle in each instance would result in a widely fluctuating reduction ratio 
display in the screen refreshing cycle.

The following figure shows an example of the view:
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Display
● Total runtime

The values in the bar diagram are specified in %, relative to the set maximum cycle 
monitoring time.
Its numeric magnitude is displayed under the bar.

– Mean value
Mean value of the actual value in % (TOTALPER block parameter)

– Actual value
Mean value of all net run times in % OB3x/OB8x + OB1 (TOTALCUR block parameter)

– Max. value
Formed from the net run times in % of all the OB3x/OB8x + OB1 net run times from the 
most recent cycle (TOTALMAX block parameter)

– Min. value
Formed from the net run times in % of all the OB3x/OB8x + OB1 net run times from the 
most recent cycle (TOTALMIN block parameter)

● Horizontal bar diagrams for OB3x
The values refer to the respective OB cycle time.
The graphic display of the OB3x times is expanded by an indicator that signals buffered 
and lost start events.

– Net value

– Gross value

– Start event lost

● Horizontal bar diagrams for OB8x and OB1
The values refer to the configured maximum cycle monitoring time.

– Net value

● Scan rate:
Display of the scan rate for all cyclical OBs of the user program

Operator control

Icon Explanation Permission
You open the legend by clicking the icon. 
The legend shows the icons designating the possible 
statuses and their meaning.

No access protection

You reset the values by clicking the icon. "Process controlling" for the di‐
agnostics area
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Avoiding a CPU stop
Functions have been integrated into the CPU to ensure that the user programs can continue 
running even when the CPU becomes overloaded and to prevent the CPU from switching to 
"STOP" mode. The "Emergency mode" parameters are assigned in the "CPU function block" 
faceplate, "Parameters view".

NOTICE

Utilization limit

When the CPU gets close to full capacity, the user programs will become sluggish. If this 
starts to affect process mode, the user program will need to be reconfigured.

You can find additional information about this in the section ""Parameters" view for AS 
objects (Page 165)".

6.11.3.10 "OBx..." view for AS objects

Available     
This view is displayed for the AS station in the AS/system area for CPU types that support the 
SFC78 and have the following firmware versions:

● Standard CPU 41x >= firmware version V5.0

● H-CPU 4xx >= firmware version V4.5

Note

This view is available for the maintenance station in the MS Standard version.

Overview
This view displays the utilization of the OBs in a CPU with diagnostics functionality.

The following figure shows an example of the "OB3x" view .
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The figure shows an example of the "OB8x/OB1" view.

Display
● The utilization of the OB3x organization blocks is shown in the "OB3x" view:

– The absolute gross and net value, and the average value over a number of cycles of 
the OB 3x, related to the configured maximum cycle monitoring time of the OB in each 
case.

– The minimum and maximum values reached since the last reset of the OBs

● The utilization level of the OB8x organization blocks is shown in the "OB8x/OB1" view:

– The absolute net value and the average value over a number of cycles of the OB8x and 
OB1, related to the configured maximum cycle monitoring time of the OB in each case.

– The minimum and maximum values reached since the last reset of the OBs.

Operator control

Icon Explanation Operator permission
You reset the counter values by clicking the icon. "Process controlling" for the diagnos‐

tics area
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6.11.3.11 "Parameters" view for AS objects

Available
This view is displayed for the AS station in the AS/system area for CPU types that have the 
following firmware versions:

● Standard CPU 41x >= firmware version V5.0

● H-CPU 4xx >= firmware version V4.5

Note

This view is available for the maintenance station in the MS Standard version.

Overview     
In this view, parameters can be assigned for the overload behavior.

The default cycle monitoring time for the CPU is 6 s. 

Failure to process all the OBs within this time will result in a cycle overload. 
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To prevent the CPU from switching to "Stop" mode, you can parameterize "Emergency mode".

● The following figure shows an example of the "Parameter" view of the CPU with SFC78.

● The following figure shows an example of the "Parameter" view of the CPU without SFC78.

Emergency mode
"Emergency mode" automatically reduces the speed of the configured cyclic tasks. The user 
programs then run more slowly.

"Emergency mode" should not be used on a continuous basis. The "Emergency mode" is 
signaled as a maintenance alarm with maximum priority setting.
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Display/Operation

Identifier Explanation Operator permission
OB3x reduction with overload In the event of an overload the OB is processed more 

slowly.
Reduction is enabled or disabled by selecting the check 
box.
In this display, reduction is enabled.

"Higher process control‐
ling" for diagnostics area

Max. number suppr. STOP demanded X (X is a number between 1 and 9999)
The number 50 is preset at the block for X by the sys‐
tem.
After the cycle monitoring time is exceeded for X+2 
times, the CPU switches to "STOP"

Alarm limit capacity If the total utilization, which equates to the sum of the 
mean values for all the net run times (in % for OB3x, 
OB8x + OB1), exceeds the alarm limit capacity, then 
the message "Net time consumption of all OBs exceeds 
max. limit" is output and the maintenance status is set 
to "Maintenance demanded".

Cancel reduction for Emergency mode is terminated automatically when the 
maximum total utilization of the controller as configured 
in the "Cancel reduction for x%" or "MAX_VAL 
(CPU_RT)" parameter is reduced accordingly and 
there is no longer any long-term violation of the cycle 
time.

Hysteresis alarm limit Hysteresis prevents the message "Net time required by 
all OBs exceeds max. limit" from "wavering".

Calculating the CPU load (Display) The CPU load for the display is calculated for the speci‐
fied number of cycles.

Calculating the CPU load (internally) The (internal) CPU load is calculated for the specified 
number of cycles.

Message as of request errors If the value is exceeded, an "OB3x request error" mes‐
sage is output.

CPU load increase to Once the slowest running OB has resumed "normal" 
running speed for 5 consecutive cycles, the reduction 
is canceled.

6.11.3.12 "Connection load display" for CPU connections

Available 
This view is displayed for the AS station in the AS/system area for the following CPU types:

● H-CPU 4xx >= firmware V6

Note

This view is available for the maintenance station in the MS Standard version.
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Overview
This view shows the 5 most heavily loaded connections of the CPU.

The connection types are displayed according to the maximum value of the load from the top 
down. 

The following figure shows an example of the view:

Note

The displayed actual values correspond to the values that are displayed on the "Connection 
statistics" tab in the "Module status" dialog of the CPU.
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Display
● Connection type:

The connection type corresponds to the configuration in NetPro.

– Invalid connection type

– S7 connection

– S7 connection (fault-tolerant)

– T connection (TCP native)

– T connection (UDP)

– T connection (ISO-on-TCP)

– Routed connection

– PG connection

– OP connection

– OMS connection

– Free connection

– Free connection (TCP)

– System connection

– RPC7 connection

– Connection for basic communication

● Partner / identification
Shows the partner ID from NetPro

● Load
Shows the utilization of the connection as a percentage

● Actual value

● Maximum value

Operator control

Icon Explanation Permission
You open the legend by clicking the icon. 
The legend shows the icons designating the possible statuses 
and their meaning.

No access protection

You reset the displayed values by clicking the icon. "Process controlling" for 
the diagnostics area
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6.11.3.13 "Diagnostic buffer" view for CPU and CP

Available     
The view is displayed for all CPUs and CPs in the central rack and expansion rack.

Note

This view is available for the maintenance station in the MS Standard version.

"Diagnostic buffer of the CPU/CP" overview
This view shows the last 20 events that occurred in the diagnostic buffer of a CPU or CP. 

The following figure shows an example of the information from the diagnostic buffer of a CPU:

Display
● Sequential number

● Time
Time when the event occurred

● Short text
Brief information about the event
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● Error code
Error code for the event

● Detailed description
Detailed information on the event

● Last update
Time stamp of the last update of the data

Operator control

Icon Explanation Permission
No icon Additional information about the event is displayed in 

the "Detailed description:" area when you click on a 
line.

No permission

When you click the icon, the events are read out from 
the diagnostic buffer again and the table is updated.

"Process controlling" for the di‐
agnostics area

6.11.3.14 "LED display" view for CPU

Available     
The view is displayed for all CPUs.

Note

This view is available for the maintenance station in the MS Standard version.

Overview 
This view displays the LEDs of the CPU.

The following figure shows an example of the display for a redundant CPU:
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Display
● Frequency

The following table shows an example of the frequency at which the state flashes:

Icon Meaning
0.5 The LED flashes at a frequency of 0.5 Hz.

● State
The following table shows the icon representation of the statuses:

Icon Meaning
"Active" state

"Active" state

"Fault is present" state

No state pending / not relevant for this hardware 
configuration

6.11.3.15 "Diagnostics" view for field devices

Available
This view is displayed for all components from the field devices area.

Note

This view is available for the maintenance station in the MS Standard and SIMATIC PDM MS 
versions.

Overview     
This view displays data of field devices that are integrated using a device description (EDD).

The data are read in SIMATIC PDM and transferred to the maintenance station.

The following figure shows an example of the view:
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Display
● Communication via SIMATIC PDM

Displays the state of the communication connection between SIMATIC PDM and the device 
the last time communication was established

Icon Meaning
Communication with SIMATIC PDM established

Communication with SIMATIC PDM not established

● Device state
Indicates the possible state of the relevant device (standard diagnostics based on the PA 
Profile of the "PROFIBUS & PROFINET International" organization)

Icon Meaning
The state "Good" is indicated by a green symbol before the cor‐
responding text.
The individual error states are indicated by a red symbol before 
the corresponding text.

No icon No state pending

● Detailed diagnostics:
The information and texts are read directly from the device and are interpreted and 
displayed via the EDD supplied by the device manufacturer.
The texts are manufacturer-specific and are only displayed in one language. Switching 
languages is not possible.

Operator control and monitoring
6.11 Faceplate

Maintenance Station
Function Manual, 03/2016, A5E36187641-AA 173



● Cyclical update

Icon Meaning
The update interval is displayed.
The value "1 day" is pre-assigned by default.
If you wish to change the update interval, you will have to adjust 
the value of the internal variable "@PDMDiagCycleTime" in the 
WinCC project of the OS server of which the measuring point is 
part.

● Last check
Time stamp of the last update of the data

Note

Texts and languages are manufacturer- and device-specific. The language displayed 
corresponds to the language that has been set for SIMATIC PDM or the manufacturer's 
default language. The information displayed in this area indicates messages for the relevant 
field device.

Operator control

Icon Explanation Permission
Cyclical update is enabled or disabled by selecting the 
check box.
Update is disabled in this display.

"Process controlling" for the 
diagnostics area

Click the icon to update the displayed information.

Additional information
You can find information on error texts in the section "Error texts for field devices/user 
objects (Page 180)".

6.11.3.16 "Parameters" view for field devices

Available
This view is displayed for all components from the field devices area.

Note

This view is available for the maintenance station in the MS Standard and SIMATIC PDM MS 
versions.
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Overview
This view displays the device parameters saved in the project for field devices that are 
integrated using a device description (EDD).

The following figure shows an example of the view:

Additional information
You can find information on error texts in the section "Error texts for field devices/user 
objects (Page 180)".

6.11.3.17 "External diagnostics" view

Available
This view is displayed for components from the field devices area.

The view is only displayed for the diagnostic block that is interconnected directly with the 
channel block.

If you are operating a module redundantly, the signals are transmitted to the upstream 
diagnostic block via the "OR block".

Note

This view is available for the Maintenance Station in the MS Standard version.

Overview
External diagnostic information for the component is displayed in this view.

The following figure shows an example of the view:
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Display
● State

The following table shows the icon representation of the statuses:

Icon identification Meaning
No external detail information pending or available

No external detail information pending or available

No icon No state pending

● Display text
You configure the texts in the "Advanced Diagnostic Settings".

Additional information
You can find information on configuring the texts in the section "Configuring maintenance 
information (Page 61)".

You can find information on configuring maintenance information in the section "Configuring 
the display of maintenance information (Page 68)".

6.11.3.18 "Diagnostics" view for user objects

Available     
The following views are displayed for components from the user objects area.

Note

This view is available for the maintenance station in the MS Standard version.
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Overview 
In this view, information on the user object are displayed. 

The following figure shows an example of the view:

Display
● State

The following table shows the icon representation of the statuses:

Icon identification Meaning
No external detail information pending or available

Detail information pending

Detail information existed for a time

No icon No state pending

● Display text
The texts are configured by the user in the SIMATIC PDM object of the AssetM block in the 
EDD.

Operator control

Icon Explanation Permission
You open the legend by clicking the icon. The legend 
shows the icons designating the possible statuses and 
their meaning.

No access protection

By clicking the icon, the stored statuses are reset. "Process controlling" for the di‐
agnostics area

Additional information
You can find information on error texts in the section "Error texts for field devices/user 
objects (Page 180)".
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6.11.3.19 "Monitoring" view for user objects

Available
This view is displayed for all components from the user objects area.

Note

This view is available for the maintenance station in the MS Standard version.

If a designation for at least one process value is entered in the EDD, the view can be selected.

Overview     
PCS 7 offers the option of setting up, in a user diagnostics structure, monitoring functions for 
objects that are not automatically integrated in the diagnostic screens of the maintenance 
station. These objects include, for example:

● Values defined by rules or calculations

● Objects that do not support diagnostics (e.g., field devices not recognized in PCS 7)

● Technical areas

● Groups of components

You can show the following monitoring functions in a diagnostics screen:

● Operating hours meter

● Service interval

● Calibration interval

The following figure shows an example of the view:
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Display
If a designation for the process value is entered in the EDD, the corresponding area is displayed 
in the view.

● Label for the process value e.g. PV1
The text is configured by the user in the SIMATIC PDM object of the AssetM block in the 
EDD.

● Signal status
The number in the priority column indicates the priority of the display. The lowest number 
has the highest priority.

Display Priority Remark
1 Bad, device-related

2 Bad, process-related

3 Local functional check, simulation

4 Uncertain, device-related

5 Uncertain, process-related

6 Maintenance demanded

None 7 Good
None - Input not connected

● Actual value
The value is read from the AssetM block.

● Remaining value
The difference between the actual value and the next limit value is formed in the AssetM 
block.

● Units of measure
The unit of measurement is configured in the AssetM block.

● Alarm limits
The alarm limits are configured in the AssetM block.

Operator controls

Icon Explanation Permission
The alarm limits are enabled or disabled by selecting the check 
box.
In this display, the alarm limits are disabled.

"Process controlling" for 
the diagnostics area

A pulse is output at the block by clicking this icon. This pulse 
can be processed further, for example, to reset the counter 
value at the following technological block (counter).
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Additional information
You can find information on error texts in the section "Error texts for field devices/user 
objects (Page 180)".

6.11.3.20 Error texts for field devices/user objects
The following table shows possible error texts in the views:

● "Diagnostics" view for field devices (Page 172)

● "Parameters" view for field devices (Page 174)

● "Diagnostics" view for user objects (Page 176)

● "Monitoring" view for user objects (Page 178)

Error code Output In the faceplate Possible measures
A0040110
80010108

Connection to SIMATIC PDM could 
not be established. 
Possible causes:
- Archiving is active on the ES
- Communication error
- Access to the project is blocked

Check:
● Whether the ES is accessible via the terminal bus
● Whether an archiving job is running on the ES

Wait until the end of the archiving job.
● Whether the SIMATIC PDM Asset Service is stopped and the 

"automatic start/stop" is not activated
Allow the "automatic start/stop".
Start the SIMATIC PDM Asset Service.

A0040001 General error has occurred. A general SIMATIC PDM error is indicated.
Contact Technical Support.

A0040006 Internal error - Incorrect call parame‐
ter

The transferred XML string is incorrectly structured.
Contact Technical Support.

A0040101 Command cannot be run because 
PDM Asset Service is being stopped.

Check whether the SIMATIC PDM Asset Service is currently being stop‐
ped and "automatic start/stop" is not activated.
Allow the "automatic start/stop" and start the SIMATIC PDM Asset Serv‐
ice.

A0040102 Command cannot be run because 
PDM Asset Service is stopped.

A0040103 Internal error - Error when parsing the 
XML transfer parameters

The transferred XML string is incorrectly structured.
Contact Technical Support.

A0040002 Not enough memory. Check whether the error is still indicated after a restart of the ES.
A0040104 Maintenance path not found or emp‐

ty.
● Check whether the maintenance project is entered correctly in the 

settings for SIMATIC PDM.
● Stop and start the SIMATIC PDM Asset Service.

A0040105 Timeout for current command. Error in the SIMATIC PDM Asset Service when executing the jobs.
Check whether the error is still indicated after a restart of the ES.A0040106 Internal error - Command could not 

be executed
A0040107 Internal error - Timeout for current 

command
The SIMATIC PDM Asset Service should be stopped, but this is not 
possible because jobs are still queued or are still being processed.
● Wait a little longer.
● Then reboot the computer.

A0040108 PCS 7 project cannot be opened. ● Close SIMATIC Manager on the ES and open the project again.
● Stop and start the SIMATIC PDM Asset Service.
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Error code Output In the faceplate Possible measures
A0040109 Internal error - Command could not 

be executed
● Stop and start the SIMATIC PDM Asset Service.
● Restart the ES if necessary.

A004010A PCS 7 project could not be opened. ● Close SIMATIC Manager on the ES and open the project again.
● Stop and start the SIMATIC PDM Asset Service.A004010B PCS 7 project could not be opened.

A004010C Incorrect project PLT ID ● Re-enter the maintenance project in the settings for SIMATIC PDM.
● Stop and start the SIMATIC PDM Asset Service.A004010D Object (PLT ID) not found

A004010E ASSET export path incorrect ● Check whether the export path entered in the SIMATIC PDM settings 
can be accessed via the terminal bus.

● Re-enter the export path in the SIMATIC PDM settings.
A004010F ASSET export could not be written - 

Access error
Check:
● Whether the export path entered in the SIMATIC PDM settings can 

be accessed via the terminal bus.
● The necessary access authorizations

A004000B License error Check the required SIMATIC PDM licensing on the ES.
A004000A Access denied. Check the access authorizations.
A004000D Object locked. Check whether the device is already open on another computer or by 

another application.
A0040008 Object not found. A general SIMATIC PDM error is indicated.

Contact Technical Support.80000003
A0040201
80004001
80070057
80600009
8000FFFF
80004003

Functional error, SIMATIC PDM 
Server not accessible

A0040111 Command cannot be run
because PDM Asset Service is stop‐
ped and not in automatic mode

Check:
● Whether SIMATIC PDM Asset Service is already stopped
● That the "Allow automatic start/stop" option is set

A0040112 Internal error - Object not found Check the SIMATIC PDM Web configuration.

Note

If the suggested measures are not successful or an error code is output that is not further 
specified in the table, contact Technical Support.
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6.11.4 Display of faceplate for redundant components

Introduction
Various displays are available for redundant components:

● The information is displayed in one faceplate.

● The information is displayed in several faceplates.

Display
The possible displays are explaining in the following table:

Redundant components Explanation
Displayed in one block icon The associated faceplate is opened by the block icon.

The redundancy state is displayed in the header in one diagnostic icon.
"Ident" view:
● In this view, if the component is redundant, one diagnostics icon is 

displayed for the active component and one for the passive 
component. The respective diagnostic icon displays the custom 
maintenance state.

● An orange square is displayed between a diagnostic icons. The 
square identifies the active component. The active component is 
the component with the master role.

● When the faceplate is opened, the information box always shows 
the data of the active component. 

● By clicking on a diagnostics icon, the diagnostics icon is given a 
colored border and the corresponding data is displayed in the 
information box.

● Refreshing data with the "Refresh" button only affects the active 
component. This may have the result that only project data is 
displayed for the passive component. 

● If the passive component was active and the data was refreshed 
with the "Refresh" button, device data is also displayed for the 
passive component.

● If the passive component is selected in the faceplate, when the 
"Refresh" button is clicked, the diagnostics icon of the active 
component is given a colored border and the data of the active 
component is displayed in the information box.

Displayed in several block 
icons

The associated faceplate is opened by each block icon.
In all views:
The custom maintenance state is displayed in the faceplate for the 
component and for the partner in the respective diagnostic icon.
The redundancy state is displayed in the faceplate for the redundancy 
object.
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Additional information
You can find information on the redundancy state in the section "Maintenance status of 
redundant components (Page 126)".

6.12 Origin of the identification data

6.12.1 Identification data for IPCs

Where does the identification data for IPCs come from?
In the case of the faceplate for IPC objects, the identification data is read from the device via 
an SNMP connection. 

The device must be configured in the SNMP OPC Server of the maintenance station for this. 

These data are prepared for display on the maintenance station with the "Export tags for 
WinCC" function.

The following table shows the assignment of the identification data displayed on the MS to the 
origin. 

Identification data Origin
SNMP Profile V1.5 for IPC PC with support of the SNMP 

Profile MIB-II
TAG / HID SNMP tag ".sysName" Not available
LID Object properties of the PC station "Name"
Address HW Config/OPC server "IP address" / 

SNMP tag "&ipAddress()"
IP address terminal bus 
CCAgent

Description Not available
 Message

Device type SNMP tag ".ProductName" Not available
Manufacturer SNMP tag ".Manufacturer" Not available
Article number 1) SNMP tag ".StationMLFB" Not available
Serial number SNMP tag ".StationSerialNumber" Not available
Installation date Not available
HW revision SNMP tag ".HwVersion" Not available
SW revision SNMP tag ".SwVersion" Not available
Last update Time stamp of the updating of the identification data
Comment Object properties of the PC station "Comment"

1) Article number = also order number or MLFB
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6.12.2 Identification data for PCs

Where does the identification data for PCs come from?
In the case of the faceplate for PC objects, the identification data is determined directly in the 
PC if the PC does not support an SNMP connection.

The following table shows the assignment of the identification data displayed on the MS to the 
origin.

Identification data Origin
TAG / HID Object properties of the PC station objects "Computer name"
LID Object properties of the PC station "Name"
Address IP address terminal bus CCAgent
Description Not available
Message
Device type IWbemService (Win32_ComputerSystem_Model)
Manufacturer IWbemService (Win32_ComputerSystem_Manufacturer)
Article number 1) IWbemService (Win32_ComputerSystemproduct_IdentifyingNumber)
Serial number IWbemService (Win32_BaseBoard_SerialNumber)
Installation date IWbemService (Win32_OperatingSystem_InstallDate)
HW revision IWbemService (Win32_BaseBoard_Version)
SW revision IWbemService (Win32_BIOS_SMBIOSVersion)
Last update Time stamp of the updating of the identification data
Comment Object properties of the PC station "Comment"

1) Article number = also order number or MLFB

6.12.3 Identification data for network objects

Where does the identification data for a network object come from?
In the case of the faceplate for network objects, the identification data is read from the device 
via an SNMP connection. 

The device must be configured in the SNMP OPC Server of the maintenance station for this. 

This data is prepared for display on the maintenance station with the "Export variables for 
WinCC" function.

The following table shows the assignment of the identification data displayed on the MS to the 
origin.

Identification data Origin
For example, Profil_OSM_V10.txt Profile MIB-II

TAG / HID WBM1) "automationFunctionTag" Not available
LID HW Config/OPC server "Name"
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Identification data Origin
For example, Profil_OSM_V10.txt Profile MIB-II

Address HW Config/OPC server "IP address" / 
SNMP variable ".&ipAddress()"

Description Not available
Message
Device type2) WBM1) "Device Type" / 

SNMP variable ".sysDescr"
Manufacturer WBM1) "automationManufacturerId" Not available
Article number3) SNMP variable ".snInfoOrderNr"
Serial number SNMP variable ".snInfoSerialNr"
Installation date Not available
HW revision SNMP variable ".snHWVersion" Not available
SW revision SNMP variable ".snSWVersion" Not available
Last update Time stamp of the updating of the identification data
Comment HW Config/OPC server "Comment"

1) WBM = Web based management (Web interface of the network object)
2) If the SNMP variable ".sysDescr" contains identification information in addition to the device 
type, this will be displayed in the corresponding field. The "Device type" field only displays 
information about the device type.
3) Article number = Also order number or MLFB

6.12.4 Identification data for AS objects

Where does the identification data for an AS object come from?
In the case of the faceplate for AS objects, the identification data is read from the properties 
of the module or dynamically from the CPU.

The following table shows the assignment of the identification data displayed on the MS to the 
origin.

Identification data Origin
HID / TAG

static
dynamic

 
HW Config "Higher level designation" (HID)
I&M data (SZL), (I&M1 Tag_Function)

LID
static

 
HW Config "Designation" or "Name"

Address HW Config
"Slot/address information"

Description
static

dynamic

 
HW Config "additional information"
I&M data (SZL), (I&M3 Descriptor)

Message Not available
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Identification data Origin
Device type HW Config "type" or "short description"
Manufacturer

static
dynamic

 
HW Config - Not accessible 1)

I&M data (SZL), (I&M0 Manufacturer_ID)
Article number 2)

static
dynamic

 
HW Config "Article number" 2)

I&M data (SZL), (I&M0 Order_ID)
Serial number

static
dynamic

 
Not available
I&M data (SZL) (I&M0 Serial_number)

Installation date
static

dynamic

 
HW Config "installation date"
I&M data (SZL), (I&M2 Installation_date)

HW revision
static

dynamic

 
Not available
I&M data (SZL) (I&M0 Hardware_revision)

SW revision
static

dynamic

 
HW Config - Not accessible*
I&M data (SZL) (I&M0 Software_revision)

Last update Time stamp of the updating of the identification 
data

Comment HW Config "Comment"

1) Not accessible means that the user cannot make an entry or modification here.
2) Article number = also order number or MLFB

6.12.5 Identification data for devices that are integrated using a device description (EDD)

Where does the identification data for devices that are integrated using a device description (EDD) 
come from?

In the case of the faceplate for devices that are integrated using a device description (EDD), 
the identification data is provided via SIMATIC PDM.

The data are provided if the device description is created in conformance with the specifications 
of the PROFIBUS & PROFINET International organization, the Hart Communication 
Foundation, or the Fieldbus Foundation.

The information is largely based on the tag names used in the EDDs. These tag names can 
be optionally displayed in the configuration interface of PDM. The display is activated in the 
settings of SIMATIC PDM.

PA profile according to PNO
The data are displayed if they can be determined explicitly using the EDD of the device.
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The following table shows the assignment of the identification data displayed on the MS to the 
origin.

Identification data Origin
TAG / HID Profile tag "TAG_DESC"
LID HW Config "Designation"
Address HW Config "Slot/address information"
Description Profile tag "DESCRIPTOR"
Message Profile tag "DEVICE_MESSAGE"
Device type Profile tag "DEVICE_ID"
Manufacturer Profile tag "DEVICE_MAN_ID"
Article number 1) Not available
Serial number Profile tag "DEVICE_SER_Num"
Installation date Profile tag "DEVICE_INSTAL_DATE"
HW revision Profile tag "HARDWARE_REVISION"
SW revision Profile tag "SOFTWARE_REVISION"
Last update Time stamp of the updating of the PDM database
Comment HW Config/Object properties "Comment"

1) Article number = also order number or MLFB

I&M profile according to PNO
The data are displayed if they can be read from the device.

The following table shows the assignment of the identification data displayed on the MS to the 
origin.

Identification data Origin
TAG / HID Profile tag "TAG_FUNCTION"
LID HW Config "Designation"
Address HW Config "Slot/address information"
Description Profile tag "DESCRIPTOR"
Message Not available
Device type Profile tag "PROFILE_ID"
Manufacturer HW Config Type or Short description
Article number 1) Profile tag "ORDER_ID"
Serial number Profile tag "SERIAL_NUMBER"
Installation date Profile tag "INSTALLATION_DATE"
HW revision Profile tag "HARDWARE_REVISION"
SW revision Profile tag "SOFTWARE_REVISION"
Last update Time stamp of the updating of the PDM database
Comment HW Config/Object properties "Comment"

1) Article number = also order number or MLFB
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HART information according to HCF
The following table shows the assignment of the identification data displayed on the MS to the 
origin.

Identification data Origin
TAG / HID Profile tag "TAG"
LID HW Config "Designation"
Address HW Config "Slot/address information"
Description Profile tag "Description"
Message Profile tag "Notification"
Device type Profile tag "Device Type"
Manufacturer Profile tag "Manufacturer ID"
Article number 1) Not available
Serial number Not available
Installation date Not available
HW revision Profile tag "HW Revision"
SW revision Profile tag "SW Revision"
Last update Time stamp of the updating of the PDM database
Comment HW Config/Object properties "Comment"

1) Article number = also order number or MLFB

FF profile according to Fieldbus Foundation
The following table shows the assignment of the identification data displayed on the MS to the 
origin.

Identification data Origin
TAG / HID Tag "TAG_DESC"
LID HW Config "Designation"
Address HW Config "Slot/address information"
Description Not available
Message Not available
Device type Tag "DEV_TYPE" 
Manufacturer Tag "MANUFAC_ID"
Article number 1) Not available
Serial number Not available
Installation date Not available
HW revision Not available
SW revision Not available
Last update Time stamp of the updating of the PDM database
Comment HW Config/Object properties "Comment"

1) Article number = also order number or MLFB
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6.12.6 Identification data for objects in the user area

Where does the identification data for objects in the user area come from?
In the case of the faceplate for objects in the user area that are integrated using a device 
description (EDD), the identification data is provided via SIMATIC PDM.

The following table shows the assignment of the identification data displayed on the MS to the 
origin.

Identification 
data

Origin

TAG / HID Parameter "TAG"
LID Parameter "Installation location"
Address Not available
Description Parameter "Description"
Message Parameter "Message"
Device type Parameter "Product name"
Manufacturer Parameter "Manufacturer"
Article number 
1)

"Article number" parameter 1)

Serial number Parameter "Device serial number"
Installation 
date

Parameter "Installation date"

HW revision Parameter "Hardware revision"
SW revision Parameter "Software revision"
Last update Time stamp of the updating of the PDM database
Comment CFC "Block comment"

1) Article number = also order number or MLFB

6.13 Overview of maintenance

6.13.1 Introduction and status diagram

Introduction 
The operators of the Maintenance Station and the Operator Station can be different individuals 
and can work in physically separate locations. 

As a result, the information flow between the Maintenance Station and Operator Station is not 
guaranteed.

Maintenance takes place in agreement with the plant operator.

Communication is supported by means of icons and messages.
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This enables a coordinated maintenance sequence.

The maintenance sequence is documented and can be tracked.

Maintenance is initiated and edited in the faceplate in the "Maintenance" view       

Status diagram
The possible status transitions are explained in the diagram below.

Actions of the maintenance engineer cause status changes. 

The next section provides detailed instructions for activating and deactivating a maintenance 
job.

Additional information
You can find additional information on the release for maintenance and on configuring the 
technological blocks in the online help Process Control System PCS 7; Advanced Process 
Library.
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6.13.2 Sequence for maintenance

Introduction   
This section provides an overview of the sequence for maintenance.

Maintenance can be initiated from the maintenance status "Good" of the component or after 
a message regarding the component.

Requirement
● The technological block has been interconnected in the CFC.

You can find information on interconnecting in the section "Engineering for maintenance 
(Page 78)".

● "Manual" or "On" mode is active for the technological block.

● The operator has the operator authorization "system operation".

Procedure for activating

Step 1
Maintenance engineer requests mainte‐
nance job

Result
Maintenance job requested

1. Open the diagnostic faceplate.
2. Select the "Maintenance" view.
3. Enter a text in the "Memo" area if 

required.
4. In the "Maintenance job" area, 

select, for example, the "Alarm" 
option button.

5. Click "On" in the operator panel for 
activating the maintenance job.

In the header of the faceplate and in the block icon, the status 
"Maintenance alarm requested" is displayed in the icon of the 
maintenance group display.

In addition, the maintenance job status "Maintenance engi‐
neer has not yet created a maintenance job" is displayed in 
the faceplate header.

An operator message is generated.
The text entered in the "Memo" area is displayed:
● In the Memo area of the "Maintenance" view of the 

faceplate
● As a comment for the message in the operator input list 

of the faceplate and message system 
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Step 2
Maintenance engineer schedules main‐
tenance job 

Result
Maintenance job scheduled

1. Open the diagnostic faceplate.
2. Select the "Maintenance" view.
3. Enter a text in the "Memo" area if 

required.
4. Select the "Planned servicing" 

option button in the "Status Service" 
area.

5. Click "On" in the operator panel.

In the block header, the display for the status of the mainte‐
nance job changes from "Maintenance engineer has not yet 
created a maintenance job" to the status "Planned servicing".

An operator message is generated.
The text entered in the "Memo" area is displayed:
● In the Memo area of the "Maintenance" view of the 

faceplate
● As a comment for the message in the operator input list 

of the faceplate and message system 

Step 3
Maintenance engineer requests mainte‐
nance release

Result 
Maintenance release requested

1. Open the diagnostic faceplate.
2. Select the "Maintenance" view.
3. Enter a text in the "Memo" area if 

required.
4. Select the "Release request" option 

button in the "Status Service" area.
5. Click "On" in the operator panel.

In the block header, the display for the status of the mainte‐
nance job changes from "Planned servicing" to the status 
"Release request".

An operator message is generated.
The text entered in the "Memo" area is displayed:
● In the Memo area of the "Maintenance" view of the 

faceplate
● As a comment for the message in the operator input list 

of the faceplate and message system 
The following is displayed on the technological faceplate:
● Icon for release request (request for operator input)
● Message of "Request for operator input - General" class

Step 4 - Plant operator
Plant operator issues the release for 
maintenance 

Result
Release for maintenance is issued

1. Open the technological faceplate.
2. Select the "Parameter" view.
3. Activate "Release for maintenance".
4. Click "Yes" in the operator panel.

An operator message is generated.
The release for maintenance is displayed in the diagnostic 
faceplate in the "Maintenance" view.
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Step 5
Maintenance engineer puts the compo‐
nent into "In service" status 

Result
Maintenance of the component can be performed

1. Open the diagnostic faceplate.
2. Select the "Maintenance" view.
3. Enter a text in the "Memo" area if 

required.
4. Select the "In service" option button 

in the "Status Service" area.
5. Click "On" in the operator panel.

In the block header, the display for the status of the mainte‐
nance job changes from "Release request" to the status "In 
service".

An operator message is generated.
The text entered in the "Memo" area is displayed:
● In the Memo area of the "Maintenance" view of the 

faceplate
● As a comment for the message in the operator input list 

of the faceplate and message system 
Depending on the configuration of the technological block, 
the following is displayed on the technological faceplate:
● "Maintenance demanded and Maintenance release" icon
● "Out of service" mode and the "Maintenance demanded 

and Maintenance release" icon
Maintenance can be performed. 

Procedure for deactivating

Step 1
Maintenance engineer completes main‐
tenance

Result
Maintenance complete

1. Open the diagnostic faceplate.
2. Select the "Maintenance" view.
3. Enter a text in the "Memo" area if 

required.
4. Select the "Completed" option 

button in the "Status Service" area.
5. Click "On" in the operator panel.

In the block header, the display for the status of the mainte‐
nance job changes from "In service" to the status "Good".
The text in the Memo area is deleted in the "Maintenance" 
view of the faceplate.
An operator message is generated.
The entered text in the "Memo" area is displayed as a com‐
ment for the message in the operator input list of the faceplate 
and message system.
The "Maintenance demanded and Maintenance release" 
icon is hidden in the technological faceplate.

Step 2
Plant operator ends the release for 
maintenance

Result
Release for maintenance is ended by the plant operator

1. Open the technological faceplate.
2. Select the "Parameter" view.
3. Deactivate the "Release for 

maintenance".
4. Click "No" in the operator panel.

An operator message is generated.
The technological block is set to "Manual" mode.

Operator control and monitoring
6.13 Overview of maintenance
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6.14 Passivating PC objects

Introduction
With the "Passivate" function, a PC object is temporarily excluded from the monitoring during 
process control.

Overview
A PC object is passivated by the following operator actions:

● Operator actions in the faceplate in the "Maintenance" view
The operator actions are stored retentively and are retained even if there is a complete 
download to the OS station.
You can find additional information on this in the section ""Maintenance" view (Page 146)".

● Disabling/enabling process control
If the process control of a monitored OS station is deactivated, its PC object is automatically 
set to passivated. 
As soon as this OS station is restarted, the passivation is canceled again.

Available
This function is available on all IPC/PC stations.

Display 
If a PC object is passivated, "Passivated" is displayed as the maintenance state in the block 
icon and faceplate.

No group alarm is displayed in the maintenance group display of the PC object.

Messages
If a PC object is passivated by an operator input in the faceplate, an operator message is 
generated.

All messages pending for this PC object are acknowledged automatically when the PC object 
is passivated.

As long as the PC object is passivated, no new messages are generated for this PC object.

Any pending events are signaled when the PC object is depassivated. 

Operator control and monitoring
6.14 Passivating PC objects
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Integration of options 7
7.1 Integration by the Alarm Control Center

7.1.1 Application of the "Alarm Control Center"

Alarm Control Center   
The Alarm Control Center (ACC) is a SIMATIC PCS 7 add-on. With the available options, it 
can be customized for everything from stand-alone solutions to company-wide communication 
solutions.

Messages of the monitored components of the maintenance station can be forwarded to the 
Alarm Control Center for further processing.

The Alarm Control Center offers the following functions:

● Forwarding of messages to specific recipients

● Integrated shift and personnel management for time-dependent delivery of messages to 
different persons

● Extensive escalation system for reliable delivery of messages even when individual 
recipients cannot be reached

● Network-wide operator control and configuration through web capability

Note

You can use the Alarm Control Center only in the MS Standard and SIMATIC PDM MS 
versions.

Forwarding of messages to specific recipients
The following messages from an individual component can be forwarded:

● Diagnostic messages

● Messages about operations

● Messages about maintenance demanded

Recipients of messages that can be sent automatically via the ACC include, for example:

● SMS to mobile telephone

● Pager

● Voice output to a telephone

● E-mail

● LAN message to PC
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Integrating data into the Alarm Control Center
You can find information about the integration of the ACC in the MS as follows:

● In the documentation of the ACC

● Using the contact information in the catalog "Add-ons for the SIMATIC Process Control 
System PCS 7"

● From SIMATIC PCS 7 support

Exporting data for the Alarm Control Center
The export of component data to the Alarm Control Center takes place in the "Maintenance" 
view of the component in process control.

Select the relevant target in the "Target" area.

Integration of options
7.1 Integration by the Alarm Control Center
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